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Chapter 1
About This TechNote

There are many reasons to migrate your NetWare 3 server to intraNetWare.
intraNetWare is an operating system that continues the evolution of NetWare
into a full-service Intranet/Internet access platform, with scalability for
businesses of all sizes. intraNetWare is a true 32-bit operating system that uses
NetWare Loadable Modules (NLMs) to add functionality, which provides a
dynamic and modular environment. You can design your system to meet your
current needs and easily add services, users, and enhancements as required.
intraNetWare can support a specific number of users for your existing system,
while allowing you to purchase upgrades to add more users as needed. The new
Novell Distributed Print Services (NDPS) architecture based on Document
Printing Application (DPA) makes it easier for you to connect printers.  It also
provides centralized print management that is integrated with intraNetWare
administration utilities.

intraNetWare offers a comprehensive set of Internet and Intranet services so
that you can access the Internet and establish a corporate intranet using open
standards. Intranets combine Internet technology and corporate networks to
provide universal access to information. Organizations are using Intranets to
strengthen and streamline their business processes. intraNetWare creates a
powerful Intranet platform on your existing NetWare network infrastructure,
allowing you to preserve your investment in training and network resources,
while leveraging the existing skills of your users and administrators. The
bottom line is that you save money and make your organization more
productive.

With intraNetWare, you’ll enjoy all the benefits and business advantages of a
full-service Intranet:

■ Closer interaction with your customers, employees, and business
partners.

■ Complete set of Internet and Intranet services; including Novell Web
Server, Netscape Navigator web browser, IPX/IP gateway, CGI
(Common Gateway Interface) for scripting, JVM (Java Virtual
Machine) for Java applications, and FTP server for file transfer.
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■ Instant access to a wealth of information and services so your employees
can follow emerging business and technology trends, and keep close
watch on competitors.

■ More economical networking that could reduce telecommunications
costs by 20 to 50 percent.

❏ Gartner Group research indicates that a typical company will save
50% of operating expenses, and realize savings of between 33% and
83% of user account administration over 3.x, depending on the size
of the network. (“The Cost of Not Converting to NetWare 4.x”
(Gartner Group Top View, June 13, 1995))

❏ By upgrading to intraNetWare, the following companies cut annual
operating expenses more than 50%, consistent with Gartner Group’s
findings:

a. Nortel Communications – 57%

b. Automated Logic Corp. – 57%

c. City of Tucson – 59%

d. Sun Diamond Growers – 57%

■ Even greater ease of use and management by allowing users to see and
access all network resources with a single login. Administrators can
manage the network from a central location with simple point-and-click
operations. NetWare Application Launcher (NAL) allows distribution of
applications to a client from a central location. Automatic Client Update
streamlines the process of updating client software.

■ Additive Licensing permits multiple individual licenses to be added
together to form what is known as a license chain. As an example, a
server requiring a license count of 350 could have a license chain
consisting of one 250-user license plus one 100-user license. Additive
licensing reduces the cost of growing your network as your business
grows.

NOTE:    NetWare 4.0x and NetWare 3.x did not support additive licensing. For
example, if an upgrade from 100 users to 150 users was required on a given
server, the customer had to purchase a 250-user license for that server.
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This TechNote is for system integrators and network administrators with
knowledge of Compaq Server products, NetWare 3 and intraNetWare. It is a
supplement to the Compaq Hardware Reference documentation and the
intraNetWare Installation and Upgrade documentation.

This Compaq TechNote provides guidelines for the following:

■ Migrating data and user information using the MIGRATE.EXE
Across-the-Wire Migration utility.

■ Migrating printing environments using the MIGPRINT.EXE utility.

■ Using the DS Migrate and File Migration utilities to migrate modeled
bindery information to an existing intraNetWare Directory tree.

■ Installing and using Simware’s REXXWARE Migration Toolkit (RMT),
a server-based utility that is used in Across-the-Wire upgrades of large-
scale NetWare networks to intraNetWare.

■ Installing workstation software and management applications.

■ Installing Novell DynaText.

The chapters in this Compaq TechNote contain the following information:

■ Chapter 1 -- About This TechNote provides an overview, a list of other
resources to use, documentation conventions, and migration
requirements, including memory allocation.

■ Chapter 2 -- Different Migration Methods describes the three different
migration methods available to upgrade your NetWare 3 server to
intraNetWare.

■ Chapter 3 -- MIGRATE.EXE Across-the-Wire Migration Utility
describes the procedures for using the utility, including:

❏ How to create intraNetWare Migration utility diskettes

❏ How to migrate printing environments

■ Chapter 4 -- DS Migrate and File Migration Utilities describes how to
upgrade your NetWare 3 server by migrating modeled bindery
information to an existing intraNetWare Directory tree with the DS
Migrate utility. It also describes how to use the File Migration utility.
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■ Chapter 5 -- Simware’s REXXWARE Migration Toolkit (RMT)
describes the recommended procedures for the server-based RMT utility
that is used in Across-the-Wire upgrades of large-scale NetWare 3
networks to intraNetWare. After you have installed intraNetWare on the
destination servers using the Install utility, you use RMT to migrate
network information and data files from the NetWare 3 source servers.

■ Chapter 6 -- Workstation Software and Management describes the
procedures for installing workstation software and management
applications.

■ Chapter 7 -- DynaText describes DynaText installation procedures from
the Compaq SmartStart package or the intraNetWare package.

■ Appendix A -- Examples of Migration Reports provides examples of
the following:

❏ Migration report log file generated by the MIGRATE.EXE

❏ Print migration report log file generated by the MIGPRINT.EXE

❏ DS Migrate report

❏ File Migration report

❏ RMT report

■ Glossary defines server management and related networking terms.
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Other Resources to Use
For more information, other resources available are as follows:

■ Novell intraNetWare Upgrade Information

Everything that you want and need to know about upgrading to
intraNetWare can be found at the following Novell web site:

http://www.novell.com/intranetware/upgrade/

Novell announced the release of the Novell Upgrade Wizard in beta
version at the time of printing of this TechNote. Novell Upgrade Wizard
is a client-based utility that upgrades a NetWare 3 server to an
intraNetWare server across the wire. The utility features a split Project
Window that displays both source and destination servers. You can
easily move the NetWare bindery and file system to an intraNetWare
server by dragging and dropping the bindery or volumes to the desired
location in the NDS tree and new file system.

Key features include:

❏ Drag and drop modeling capability

❏ Ability to migrate both the NetWare 3 bindery and file system in a
single GUI utility

❏ Password and trustee assignment migration functionality

❏ Simple print component migration

❏ Ability to run on both Windows 95 and Windows NT clients on its
own or as a snap-in to NetWare Administrator

❏ Option to establish migrated users' rights based on existing user
template or create new user templates for migrating users

❏ Ability to create new containers in the existing Directory tree and
new subdirectories in the file system

❏ Notification of possible errors and ability to correct these errors
before migration

❏ Migration progress bar indicating percentage of completion
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Novell Upgrade Wizard runs on both Windows 95 and Windows NT
workstations. You can download the utility free of charge from the
following Novell web site:

http://www.novell.com/intranetware/upgrade/utilities.html

■ Compaq TechNote, intraNetWare Performance Management

This TechNote provides guidelines for using a variety of network
monitoring tools to analyze network server and network communication
subsystems and to manage network performance.

■ DynaText

DynaText allows you to read intraNetWare online documentation from
your workstation. You can install DynaText files on an intraNetWare
server, a local hard disk, or access the files directly from the CD. You
must set up a Windows workstation to view DynaText.
See Chapter 7, “DynaText,” for more information.

■ NetWire Novell support forum on CompuServe

NetWire is a fairly inexpensive way to get up-to-date advice and patches
from the CompuServe service. To open a CompuServe account, call one
of the following numbers:

❏ In the United States or Canada: 1-800-524-3388.

❏ In the United Kingdom: 0800-289-378.

❏ In Germany: 0130-37-32.

❏ In other European countries: 44-272-255-111.

❏ In locations other than the United States, Canada, or Europe, call
(614) 457-0802. Ask for "Representative 200," which identifies you
as a Novell customer.
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■ Novell and NetWare Application Notes and Research Reports

These notes and reports cover technical aspects of Novell- and
NetWare-based system design, implementation, management,
optimization, troubleshooting, and software development.

❏ “Consumer Gas Company, Ltd. Migration to intraNetWare from
NetWare 3.12: A Case Study ,” January 1998, Novell AppNotes,
P/N 464-000054-001

❏  “A Practical Guide to Using Novell Application Launcher (NAL)
2.01,” January 1998, Novell AppNotes,
P/N 464-000054-001

❏  “Using Novell Application Launcher 2.0 and snAppShot for
Application Delivery,” August 1997, Novell AppNotes,
P/N 464-000052-008

❏ Special Issue for intraNetWare Client for Windows NT, May 1997,
Novell AppNotes,
P/N 464-000052-005

❏ Special Issue for NetWare Client 32 for Windows 95, November
1996, Novell Application Notes,
P/N 164-000050-011

❏  “Migrating to NetWare 4.11 Using the Across-the-Wire Method,”
October 1996, Novell Application Notes,
P/N 164-000050-010

❏ “Lessons Learned While Upgrading to NetWare 4.1,” August 1996,
Novell Application Notes,
P/N 164-000050-008

❏ Special Issue for NetWare Client 32 for DOS/Windows, May 1996,
Novell Application Notes,
P/N 164-000050-005

❏  “Using DS Standard to Migrate Networks to NetWare 4.1,”
February 1996, Novell Application Notes,
P/N 164-000050-002
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■ Compaq Hardware Reference documentation

This documentation can help isolate a problem to a certain computer
component or cable segment. Some network problems occur because of
malfunctioning hardware. Check the documentation that came with the
hardware involved.

Migration Requirements
To migrate your NetWare 3 server to an intraNetWare server using one of the
Across-the-Wire Migration methods, you need the following:

■ The current NetWare 3 server

■ A backup of the data files on the NetWare 3 server

■ CD-ROM drive and supporting drivers

■ Compaq SmartStart (optional) and an intraNetWare license disk and
intraNetWare media from SmartStart or Novell

■ Unless you are using RMT, a client workstation with certain minimum
requirements that depend on the utility you plan to use:

MIGRATE.EXE:

To run MIGRATE.EXE, your client workstation must meet the
following system requirements:

❏ DOS, Windows 3.1x or Windows 95

❏ NETX 3.26 or later, VLM 1.20 or later, or NetWare Client 32
software

❏ At least 640KB of RAM (with 480KB of free memory)

❏ At least 5MB of free disk space to hold the bindery information
during the migration process

❏ At least 1.72MB of free disk space for the Migration utility files

❏ IPX Retry Count set to 60



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
1-9

Migration from NetWare 3 to intraNetWare

❏ The following line included in your CONFIG.SYS file:

FILES = 20 (OR GREATER)

DSMigrate:

To run DS Migrate, the NetWare File Migration utility, and NetWare
Administrator, your NetWare client workstation must meet the
following system requirements:

❏ Windows 3.1x or Windows 95

❏ VLM or NetWare Client 32 software

❏ At least 8MB of RAM

❏ 1.2MB of free disk space for NetWare Administrator if not running
from the network drive

❏ 10MB of free disk space for DS Migrate executables if not running
from the network drive (17MB if DS Migrate Assistant is also
installed)

❏ 3MB of free disk space for each NetWare server discovered

❏ The following line included in your CONFIG.SYS file:

FILES = 40 (OR GREATER)

NOTE:   RMT does not require a client workstation.

■ An intraNetWare server with a 386 (or greater) system processor with a
minimum of 15MB for the DOS partition, 75MB for the intraNetWare
partition, and 20MB system memory

Use the following intraNetWare Server Memory Calculation Worksheet
to estimate the recommended system memory requirements for your
intraNetWare server based on total intraNetWare volume space.

See the Compaq TechNote, intraNetWare Performance Management,
for more detailed information on system memory.
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General Update Preparations
■ Perform two file system backups on the NetWare 3 server and verify

them.  If possible, restore some files to a spare server as a test.

■ Verify that migration server requirements are met.

❏ The DOS partition must be a minimum of 15MB, but Compaq
recommends that you create a partition equal to the size of the
server system memory plus 20MB for server start files and DOS
utilities.  This extra DOS partition space will allow you to dump the
core memory to your hard drive in the event of a server abend.
Examining the core dump may aid you in diagnosing the cause of
the abend, if the abend log does not help determine the cause.

❏ Ensure that there is plenty of free space on the NetWare partition
that will contain the SYS volume.  A minimum installation requires
75MB, but it is safer to make the volume at least 100MB. If
DynaText will be installed on SYS, allow another 70MB for the
viewer and one language collection. If the SYS volume runs out of
disk space, the Transaction Tracking System (TTS) that protects
NDS from corruption is disabled. Because NDS is stored on the
SYS volume, you also need space to expand the database with
additional objects. Do not place print queues on SYS. Use another
volume to host the queues. This will avoid the possibility of filling
all the space if print jobs stack up in a queue.

■ Verify that workstation requirements (if needed) are met.

■ Verify that you have an account with sufficient rights on all servers
involved in the migration.

■ If migrating Across-the Wire:

❏ Load and add name spaces necessary to destination server volumes.

❏ Upgrade 3.x NLMs if required by the migration method.

❏ Disable any SAP filtering on your network.
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Notational Conventions
Table 1-1 lists the conventions used in this TechNote to distinguish elements of
text found within this document.

Table 1-1
Notational Conventions

Convention Use

KEYS Keys on your keyboard appear in boldface.

KEY+KEY When you see a plus sign (+) between two keys,

hold down the first key while you press the second

key. For example, “Press the Ctrl+Z keys” means

press and hold down the Ctrl key while you press

and release the Z key.

New terms, screen selections,
variables

These items always appear in italics

FILENAMES Names of files appear in uppercase italics in DOS

and in other environments

COMMANDS, DIRECTORY NAMES,

DRIVE NAMES, and PROGRAMS

These items always appear in uppercase in DOS

and in other environments.

USER INPUT Information you type exactly as it appears is shown

in upper cases.

! IMPORTANT Presents clarifying or specific points of information.

NOTE: Presents commentary, sidelights, or interesting

points of information.

Type When instructed to type information, do so without

pressing the Enter key.

Select item → item → item Items separated by arrows indicate items you select

in a sequence.
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Chapter 2
Different Migration Methods

There are three different migration methods available to upgrade your NetWare
3 server to intraNetWare. The upgrade process is necessary because the
NetWare 3 bindery must go through a conversion process to the new
intraNetWare environment. You cannot simply restore a complete NetWare 3
backup to an intraNetWare server or copy all of the NetWare 3 files to the
intraNetWare server. The bindery, accounting, and security information must
go through a translation process into the intraNetWare format.

The three different migration methods available to intraNetWare are:

1. Install Upgrade, using Install Utility (INSTALL.BAT)

NOTE:  Install Upgrade as used in this TechNote refers to the NetWare 4.11
Installation Program.

2. Same Server Migration

3. Across-The-Wire Migration

a. MIGRATE.EXE

b. DS Migrate and File Migration Utilities

c. Simware’s REXXWARE™ Migration Toolkit (RMT)

NOTE:  Through Novell’s partnership with Simware, RMT is provided free of
charge to registered NetWare 3 customers at http://www.simware.com or by
calling 1-800-267-9991.

Because of the increased capacity intraNetWare requires over NetWare 3, it is
likely that many upgrade plans will include new server hardware that offers
more disk space, more memory, more powerful processor, and/or more
powerful network interface controllers. If you decide to upgrade your operating
system with a new Compaq server to take advantage of advances in technology,
you will obtain increased performance, built-in fault tolerance, and security
features.
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In this TechNote, there is a general description of each upgrade method, with
more detail on the Across-The-Wire Migration methods using MIGRATE.EXE,
DS Migrate, and RMT. The RMT utility or DS Migrate used with the File
Migration Utility are the recommended methods of migrating a NetWare
server Across-the-Wire. The MIGRATE.EXE utility still ships with
intraNetWare, but is not recommended for future use because of its various
limitations. There are other resources available to provide more detail on the
Same Server Migration or the Install Upgrade if you need to use one of these
methods. See Chapter 1, “About This TechNote,” for more information on
other resources available. Figure 2-1 shows the selection process for the
appropriate upgrade method.

Select the Upgrade
Method.

Do you have
an installed

intraNetWare
server?

Do you want
to choose

which server
information
is migrated?

No Use the Install Upgrade.
(INSTALL.BAT)

Use the Same Server
Migration utility.

Use an Across-the-
Wire Migration method.

No

Yes Yes

Figure 2-1. Selecting the Appropriate Upgrade Method
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Table 2-1 compares the migration methods using several categories.

Table 2-1
Migration Method Comparison

Method Speed H/W
Needed

Passwords Login Scripts
and Printing

Files and
Trustees

Disaster
Risk

Volume Block Size,
Compression,
Suballocation

Choose
information
migrated?

Install Upgrade Faster Server Migrated Migrated Migrated Restore

server from

backup

No auto-change

block size,           

can turn ON after,

can turn ON after

(both will affect new

writes only)

No

Same-Server
Migration

Slowest Server,
WS

Not Migrated Not Migrated Backup
and
Restore

Restore
server from
backup

64K, ON, ON Yes

Across-the-Wire Migration using:

MIGRATE.EXE Slow 2 Servers,
WS

Not Migrated UIMPORT.EXE
MIGPRINT.EXE

Migrated Source
server intact

64K, ON, ON Yes

DS Migrate/File
Migration

Faster 2 Servers,
WS

Migrated Migrated Migrated Source

server intact

64K, ON, ON Yes

RMT Fastest 2 Servers Migrated Migrated Migrated Source
server intact

64K, ON, ON Yes
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Install Upgrade
The Install Upgrade method is a server-based approach to upgrading
intraNetWare. You can use the Install Upgrade if your current NetWare 3
server meets the following requirements for intraNetWare and you are not
planning to upgrade any hardware until after the migration:

■ A 15 MB DOS partition is present

■ DOS is installed on the DOS partition

■ The server boots from the DOS partition

■ Free hard disk space is allocated to NetWare

■ Each hard disk contains one NetWare volume

■ Randomly generated IPX addresses can be used

■ A default NDS tree with a single container can be used

After running INSTALL.BAT from the intraNetWare CD-ROM, select Upgrade
a 3.x or 4.x server to intraNetWare from the main menu on the console of the
server you are upgrading. This process requires no client workstation or any
other hardware other than the server itself. You perform the entire upgrade
from the server console as shown in Figure 2-2. In this case, the operating
system is upgraded in place and all the data files are automatically converted to
intraNetWare data files. All your passwords are maintained and migrated to
NDS. When upgrading a server, you are allowed to choose additional product
options, including "Upgrade 3.1x Print Services" to upgrade print services.
Selecting this option will launch PUPGRADE.NLM, which upgrades all print
databases, printers, print servers, and print queues in place. Use Install upgrade
when you want to use the same server hardware for your new network.
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Server Console

NetWare 3.12 Server converted to
an intraNetWare Server

intraNetWare CDs

Figure 2-2. Install Upgrade

The Install Upgrade method requires the transfer of the entire NetWare 3 server
environment. You cannot control which data and bindery information you want
to migrate.

Ensuring that you allot sufficient time to perform the Install Upgrade is
essential. It can be very time consuming, depending on the hardware
configuration and amount of data on the NetWare 3 server. The process
proceeds through four phases:

■ System Analysis (non-destructive)

■ Disk Analysis (non-destructive)

■ Disk Modification (destructive)

■ Bindery Conversion (destructive)

The system and disk analysis phases are non-destructive. They simply ensure
that the server has enough disk space and memory to complete the upgrade
successfully.
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The disk modification and bindery conversion phases are destructive. During
the modification and conversion phases, the NetWare 3 format is converted to
the intraNetWare format. If a failure should occur during either of these two
phases, you must restore the NetWare 3 system from a current and complete
backup before starting the upgrade process again.

Same Server Migration
If you are currently running a NetWare 3 server with a 286 processor,
intraNetWare will not run on your system. Therefore, the Install Upgrade and
Same Server Migration methods cannot be used to upgrade to intraNetWare.
The Across-The-Wire Migration method can move data from a 286 server to a
new server meeting the intraNetWare requirements.

The Same Server Migration method relies on the Migration utility to backup
and modify bindery information. It also relies on a current backup of the data
files. You must back up the data files to tape or to another location, and the
Migration utility translates and transfers the bindery information. This process
requires a NetWare 3 server that is overwritten to intraNetWare, a client
workstation, and intraNetWare CDs as shown in Figure 2-3.

NetWare 3.12 Server overwritten
to an intraNetWare Server

Client Workstation

Compaq SmartStart
or intraNetWare CDs

Figure 2-3. Same Server Migration
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The requirements for the client workstation are given in Chapter 1, under
“Migration Requirements.”

After you transfer the bindery information to the working directory on a client
workstation and you have a backup copy of the data files, intraNetWare uses
the existing NetWare 3 server as the hardware for the new intraNetWare server.
After the intraNetWare installation process, the client workstation connects to
the new server and migrates the bindery information back to the new
intraNetWare server. The Migration utility performs any necessary translation
of the bindery data to NDS. Finally, you copy the backup copy of the data files
to the new server.  This method relies completely on a current and complete
backup of the NetWare 3 server if the upgrade fails for any reason. If the data
backups become corrupted or you have some delays in completing the
intraNetWare installation, for example, you must create the original NetWare 3
system from backups and start the migration process again.

Across-The-Wire Migration
The Across-The-Wire Migration is the recommended upgrade method because
it is:

■ Safest

■ Fastest

■ Most flexible

■ Capable of migrating multiple servers into one server

Across-The-Wire Migration is the safest of the three methods discussed. If the
migration fails for any reason, simply repeat the procedure until it works
successfully. The original NetWare 3 server remains intact until you decide to
overwrite it.

This migration process is probably the fastest of the three methods discussed.
There is no restoration of a backup tape as in the Same Server Migration
process and there is no hardware and system analysis done as in the Install
Upgrade process.
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It is also the most flexible migration option. You can consolidate two or more
NetWare 3 servers into one intraNetWare server. You can choose which
volumes you want to migrate across to the intraNetWare server. You can direct
the data to a volume or directory on the intraNetWare server that differs from
the NetWare 3 source server.

The Across-The-Wire upgrades a NetWare 3 server to a newly installed or
existing intraNetWare server. You might not be able to simply upgrade your
existing hardware to intraNetWare requirements. If you are planning to use the
existing server hardware, you should use the Same Server Migration method or
the Install Upgrade method. See “Install Upgrade” or “Same Server Migration”
for more information.

Migration Utility (MIGRATE.EXE)

With the Migration utility (MIGRATE.EXE) method, bindery information and
data files pass from one server to another via a client with access to both
servers as a supervisor-equivalent user. The Migration reads the NetWare 3
bindery information (users, groups, trustee assignments, and accounting
information) from the source NetWare 3 server. It stores the NetWare 3 bindery
information in an intermediate file on the client workstation running the
Migration utility, then reads from this intermediate file and writes to the
destination intraNetWare server.

This Across-The-Wire Migration method then copies the data files (files,
directories, and their attributes) directly from the source server to the
destination server via the client workstation.

This process requires an existing NetWare 3 server, a newly installed or
existing intraNetWare server, and a client workstation that can attach to both
servers as shown in Figure 2-4.   Other requirements for the workstation are
given in Chapter 1, “Migration Requirements.”
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intraNetWare
Server

NetWare 3.12
Server

Client Workstation
Running the

MIGRATE.EXE

Figure 2-4. Across-The-Wire Migration

You should install the intraNetWare server and have it up and running before
the migration takes place. This gives time to test and tune the intraNetWare
server before making it available. You can validate and modify the connectivity
and configurations before you migrate the NetWare 3 server. See the Compaq
TechNote, intraNetWare Performance Management for more information on
management and tuning of intraNetWare environments. See Chapter 1, “About
This TechNote,” for more information on obtaining that document.

Compaq SmartStart is the intelligent way to quickly install and configure a
tested and proven server platform. If you use SmartStart to install
intraNetWare, the configuration is optimized by including the performance
recommendations discussed in the intraNetWare Performance Management
TechNote.
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Some advantages for using SmartStart are:

■ SmartStart restarts your server, runs the System Configuration Utility,
creates a system partition, and sets hardware parameters specific to the
selected software.

■ SmartStart has three installation paths: Assisted Integration, Replicated
Installation, and Manual Configuration.

❏ Assisted Integration provides for accepting the SmartStart default
installation options without going through the entire SmartStart
interview process. Assisted Integration gives you a fast option for
basic, default-based installation on a single-server LAN.

❏ Replicated Installation allows you to automatically create a server
with the same configuration as one previously SmartStarted, using a
Replication diskette created during a previous installation.

❏ Manual Configuration allows you to customize the install for your
particular network.

■ The installation of the appropriate Compaq Insight Management Agents
and the creation of the Compaq Insight Manager diskettes for
installation on the management PC are integral parts of the SmartStart
installation program. When you install the operating system, the
appropriate Compaq Insight Management Agents will install
automatically.

! IMPORTANT:  Compaq SmartStart is tested and supported only on Compaq
servers.

.

You must have the ability to login as a supervisor-equivalent user to both the
existing NetWare 3 server and the new intraNetWare server at the same time.
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DS Migrate and File Migration Utilities

DS Migrate is a workstation-based utility that is used only in Across-The-Wire
upgrades. It is used in conjunction with the File Migration Utility. DS Migrate
and the File Migration Utility run on any Windows 3.x, Windows 95 or
Windows NT client workstation on the network. Other requirements for the
workstation are given in Chapter 1, “Migration Requirements.”

Both DS Migrate and the File Migration Utility are plug-ins to NetWare
Administrator (NWADMIN.EXE) and are launched through the Tools menu.
They employ an easy-to-use Graphical User Interface (GUI) to provide a
simple way to migrate bindery information and data files.

After you have installed intraNetWare on the destination server using the Install
utility, you use DS Migrate and the NetWare File Migration Utility to migrate
network information and data files. You can consolidate multiple NetWare 3
servers onto a single intraNetWare server, but you must do it one NetWare
server at a time.

DS Migrate migrates network information, such as bindery information,
account restrictions, and login scripts, from a NetWare 3 server to an
intraNetWare server. The File Migration Utility migrates data files. DS Migrate
reads the necessary information from the source server, converts it
automatically, and writes it to the destination server.

DS Migrate/File Migration Upgrade Steps

1. DS Migrate creates an NDS tree model of a NetWare 3 bindery and
extracts bindery objects (users, groups, queues, printers, print servers,
account restrictions, and user and system login scripts) from a NetWare
3 source server. It then converts them into a Novell Directory Services
model on the destination server. DS Migrate does not migrate current
user passwords. You assign passwords globally or individually in the
NDS tree model.

2. Next, DS Migrate will migrate user, group, and print objects from the
model it created to the live NDS tree. You can view the NDS model
graphically and modify it to ensure it fits your planned NDS tree
structure before migrating it to the live NDS environment.
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3. Finally, when you have completed the migration of the NDS model
using DS Migrate, you use the File Migration Utility to migrate selected
data files from the source to the destination server. You can consolidate
multiple volumes from the source server into a single volume on the
destination sever.

Features of DS Migrate/File Migration

■ No server console access required—DS Migrate and File Migration run
on the client; you don't need to access the server console.

■ Windows utility—It runs on the client workstation with an easy to use
GUI. The GUI is similar to that of the NetWare Administrator utility,
which is the NDS-based equivalent of the SYSCON.EXE utility.

■ Easy modeling of the tree—You can create new NDS containers, and
drag and drop individual objects to these containers. Due to the
graphical display of the NDS tree, it is very easy to see what is going to
be migrated.

■ File Migration Wizard—The File Migration has a simple to use Wizard
to lead you through the migration of file system data.

■ System metrics—DS Migrate allows you to set up system metrics, such
as the number of maximum name length of new objects or the maximum
objects in a single container, which will be checked prior to doing the
migration. If violations of these metrics are discovered, you will receive
a warning.

Simware’s REXXWARE™ Migration Toolkit
(RMT)

RMT is a server-based utility that is used in Across-The-Wire upgrades of
large-scale NetWare networks to intraNetWare. Novell has licensed RMT from
Simware Incorporated and is offering it free of charge to customers who have
an existing NetWare 3 server.
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After you have installed intraNetWare on the destination servers using the
Install utility, you use RMT to migrate network information and data files from
the NetWare 3 source servers. With RMT, you can migrate multiple NetWare 3
servers at the same time. You can also consolidate multiple NetWare 3 servers
into a single intraNetWare server at the same time.

RMT Upgrade Steps

First, RMT creates an NDS model of a NetWare 3 bindery by extracting
bindery objects such as users, groups, queues, printers, and print servers from
the specified NetWare 3 source servers and converting them into NDS objects.
RMT then places these objects in an intraNetWare database on the destination
servers. You have complete control over every step of this process to ensure
that the resulting intraNetWare database accurately models the NDS tree
structure you have established.

RMT then migrates the NDS model (user, group, and print objects) into a live
NDS tree. You can edit the NDS model graphically to ensure it fits your
planned NDS tree structure before migrating it to the live NDS environment.

Finally, when you have completed the migration of the NDS model to the live
NDS tree, RMT migrates data files from the selected source NetWare 3 servers
to the destination intraNetWare servers. You can consolidate multiple volumes
from the source server into a single volume on the destination sever.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
2-14    Different Migration Methods

Features for Upgrading Large Networks

RMT provides the following capabilities that enhance the upgrading of large
networks:

■ RMT allows you to simultaneously upgrade multiple servers. DS
Migrate can only upgrade one server at a time.

■ RMT’s REXX scripting capability allows you to customize it to your
environment, maximizing its efficiency and effectiveness.

■ Unlike DS Migrate, RMT maintains all current passwords and migrates
them to the destination server.

■ You can interrupt the migration process at any time. RMT automatically
checkpoints your current status. When you resume the migration, RMT
starts up from exactly where you left off.

■ Using a simple command, you can undo the migration of the NDS
model to the live NDS environment and roll back to the NDS
environment prior to the migration. This allows you to recover quickly
in case of a problem.

■ RMT runs on the destination server and performs high-speed
server-to-server transfer of information. As a result, information transfer
is considerably faster than with DS Migrate, which transfers all
information through the client workstation on which it is installed.

■ RMT can detect and resolve duplicate objects automatically, whereas
DS Migrate requires you to resolve them manually.

Summary
There are three different methods available to upgrade from a NetWare 3 server
to an intraNetWare server. The method of choice is the Across-The-Wire
Migration using either the DS Migrate and File Migration Utilities method or
the RMT.

To use the Install Upgrade or Same Server method, refer to the resources listed
in Chapter 1, “About This TechNote,” for more information.
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Chapter 3
MIGRATE.EXE Across-The-Wire
Migration Utility

This chapter discusses two aspects of MIGRATE.EXE. First, an explanation of
how the information is migrated is presented. Next is the procedure for
performing an Across-the-Wire migration using MIGRATE.EXE.

Across-The-Wire Migration
Across-the-Wire Migration allows you to migrate your NetWare 3 server to
another physical server on the network that has intraNetWare installed.

Selected bindery information migrates to a working directory on the local hard
drive of a DOS workstation, translates to NDS format, and then migrates from
the working directory to the newly installed intraNetWare server. The data files
migrate directly to the intraNetWare server.

You can migrate several servers to one server and you can choose which
information you want to migrate. You can also direct data to a specific volume
or directory.

The Across-the-Wire Migration utility allows you to preserve your user
environment (users and their trustee assignments), as well as default account
restrictions, accounting methods, print queues, and print servers. With the
Across-the-Wire Migration utility, there is no risk of data loss, since you are
migrating to a previously installed intraNetWare server.

How Information is Migrated
When using MIGRATE.EXE, you can choose to migrate specific information to
the intraNetWare destination server. Be aware that certain information may or
may not overwrite the configuration of the intraNetWare server. Due to that
fact, the following sections go into more detail on how certain information
migrates from NetWare 3 to intraNetWare when using MIGRATE.EXE.
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Figure 3-1 shows the types of information that may be chosen for migration.

Figure 3-1.   Types of information that may be chosen for migration

Accounting Information

You can select the accounting information you want to migrate to the
intraNetWare destination server. Accounting information includes:

■ Accounting status (whether or not accounting is activated on the server)

■ Accounting charge rates for each accounting resource (blocks read,
blocks written, connect time, service requests, disk storage)

■ Accounting servers that are authorized to charge for services

When accounting information migrates from the source server to the
destination server, MIGRATE.EXE determines if accounting is active on the
NetWare 3 source server. If accounting is not active on the source server,
accounting is not active on the intraNetWare destination server. If accounting is
active on the source server, it is active on the destination server.
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Figure 3-2 shows how accounting information migrates from the source server
to the destination server.
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Figure 3-2.   How Accounting Information is Migrated
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Table 3-1 shows examples of accounting information before and after the
migration process.

Table 3-1
Examples of Accounting Information

Source Server
Before Migration

Destination Server
Before Migration

Destination Server
After Migration

Accounting ON

Charges for:

- Disk storage

- Service requests

Accounting OFF Accounting ON

Charges for:

- Disk storage

- Service requests

Accounting OFF Accounting ON

Charges for:

- Blocks read

- Blocks written

Accounting OFF

Accounting ON

Charges for:

- Service requests-X

- Connect time

Accounting ON

Charges for:

- Service requests-Y

-  Disk storage

Accounting ON

Charges for:

- Service requests-X

- Connect time

- Disk storage

Users

Any person that has access to use resources on the file server is a user. Each
person needs a user Identity (user name). Once a user identity exists as an
object in the bindery or NDS, the user can then log in to the server with that
user identity or account, and access the resources on the server.
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Bindery user account information migrates as follows:

■ Full user name

■ User print job configurations (PRINTCON.DAT from the user's mail
directory. intraNetWare stores this information in NDS.)

■ User login scripts for DOS (LOGIN from the user's mail directory.
intraNetWare stores this information in NDS.)

■ Whether or not the user has work group manager privileges (not valid in
intraNetWare)

■ File server console operator status (not valid in intraNetWare)

■ Managed users and groups (not valid in intraNetWare)

■ Managers (not valid in intraNetWare)

■ Security equivalencies, other than those to Supervisor

The exception to this is the user Supervisor on the source server. It will not
migrate. Any reference to Supervisor is replaced with the name of the server
object. The Admin user will be able to access and change the objects with a
Supervisor reference, such as a Print Queue Operator property value.

If the default account restrictions on the destination server specify that users
should have a home directory, MIGRATE.EXE creates one for each user. Figure
3-2 shows how user information migrates from NetWare 3 to intraNetWare.

Migrating users is best done in conjunction with groups. If you select users
without selecting groups, the utility displays a series of error messages while
attempting to set up security equivalencies. See the online documentation,
DynaText CD, in System Messages, for more information on error messages.
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User Login Scripts and Mail Directories

In NetWare 3, the user login script is stored in a file called LOGIN that resides
in the user’s mail directory. The MIGRATE utility creates a new mail directory
on the destination server for each user that is migrated. The name of the mail
directory will match that user’s new object ID (which will be different than it
was on the NetWare 3 server). The user is granted RWCEMF rights to the new
directory. MIGRATE will then copy the LOGIN file (if one exists) from the old
3.x mail directory into the new intraNetWare mail directory.

Later, during the file system copy phase, the old user mail directory and all files
in it will also be copied to the new server. However, users are not given rights
to the old mail directories on the destination server. If users had files other than
LOGIN stored in their original mail directories, they will no longer have access
to them.

If your users have files other than LOGIN in their mail directories, it is
recommended to move any desired files from the old mail directory, and then
delete the old mail directories on the NetWare 3 server before running the
MIGRATE utility. This will prevent any conflict in the event that newly created
users are given an ID that happens to match the name of an old mail directory.
You can run BINDFIX on the NetWare 3 server(s) prior to running MIGRATE
to delete mail directories of users that no longer exist. If you have already run
the MIGRATE utility, you can run DSREPAIR on the intraNetWare server to
delete mail directories of users that no longer exist.

Migrated users that had login scripts on the source NetWare 3 server will still
execute those migrated login scripts when logging into the new server as
bindery users. However, those same users will have no login script when
logging in as an NDS user. This is because user login scripts are not actually
converted into NDS by MIGRATE.EXE. You can use the UIMPORT utility to
complete the user login script migration by converting bindery login scripts to
NDS login scripts. Alternatively, you can use the NetAdmin or NetWare
Administrator utility to create the scripts manually.
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Using UIMPORT to Convert Login Scripts

The migration process automatically creates the files UIMPORT.DAT and
UIMPORT.CTL in the SYS:SYSTEM directory of the destination server. The
UIMPORT.EXE utility uses these files to convert users’ bindery login scripts to
NDS user login scripts. General guidelines for using UIMPORT.EXE are given
below:

■ Login as an NDS user such as Admin to run the UIMPORT utility.

■ Set your current context to the container where the users being updated
reside.

■ Ensure that the UIMPORT.DAT file includes a backslash after the
volume name in the path to the login script file.

■ Since there are no last name values in the UIMPORT.DAT file, -991
errors will occur, but the conversion will succeed. Last name values can
be added to the file with a text editor before using the utility, if desired.

■ Use the following syntax:

UIMPORT UIMPORT.CTL UIMPORT.DAT <Enter>

For full instructions in using UIMPORT.EXE, see the online documentation,
Dynatext CD, in Supervising the Network.

NOTE: User login scripts might need to be modified after the migration to remove
any references to the source server.

System Login Script

The NetWare 3 system login script is not converted into NDS, but the text file
NET$LOGIN.DAT is migrated into the SYS:PUBLIC directory if you migrate
the SYS volume. Users logging in to the new server under bindery emulation
will run this system login script. NDS users will not execute this file. Container
and Profile login scripts take the place of a system login script in the
intraNetWare environment. These must be created using the NetWare
Administrator or NetAdmin utilities. You may use COPY (Ctrl + C ) and
PASTE (Ctrl + V ) to copy this script into a container login script. You may
then modify it if needed.
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User Restrictions

Each user account can have restrictions different from the default account
restrictions. These include:

■ Whether or not the account is disabled

■ Account expiration date (if any)

■ Limit on the number of grace logins (if any)

■ Whether or not to require unique passwords

■ User's account balance

■ Lower limit on the account balance

■ Station restrictions

■ Login time restrictions

User account restrictions are all migrated to the destination server and will be in
effect whether the users login under NDS or bindery emulation. Existing user
restrictions take precedence over user restrictions coming from the source
server. When MIGRATE.EXE tries to create a user that already exists on the
destination server, the user account restrictions do not alter.

Account Restrictions

A user's account may be accessed according to settings made in the account
restrictions. When an account locks, you are no longer able to log into the file
server using that account. An account locks automatically when an account
expires, when the balance of the account depletes, or when the limit set in
intruder detection for incorrect password use is exceeded. The default account
restrictions include the following:

■ Account expiration date

■ Allowance of concurrent connections for each user

■ Creation of a home directory for each user

■ Minimum password length
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■ Number of days between password changes

■ Allowance number of grace logins

■ Necessity for unique passwords

■ Initial account balance

■ Lower limit on the account balance

■ Login time restrictions

If the NetWare 3 source server specifies creation of home directories for users,
MIGRATE.EXE determines if the home directories are available on the
intraNetWare destination server. If home directories are available,
MIGRATE.EXE uses the same path as on the NetWare 3 source server.

To ensure that the Across-the-Wire Migration utility uses a specific directory as
a home directory, use the NetWare Administrator utility to create a user on the
destination server. Also specify a directory where the migrated user's home
directory should reside. See the online documentation, DynaText CD, in
Utilities Reference, for more information on using the NetWare Administrator
utility.

Figure 3-3 shows how account restrictions migrate from NetWare 3 to
intraNetWare.
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Figure 3-3.   How Account Restrictions and User Information Are Migrated

Three types of user information can migrate from NetWare 3 to intraNetWare.
The order in which MIGRATE.EXE migrates this information to the destination
server is as follows:

1. Default account restrictions

2. Users

3. User restrictions
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Before creating users, MIGRATE.EXE sets up default account restrictions on
the destination server. Then, while creating user accounts, it applies those
default account restrictions to each user account it creates. This ensures that all
user accounts created by MIGRATE.EXE start out with the same restrictions.
Any individual user restrictions are applied last.

Passwords

User passwords are not migrated. When running MIGRATE.EXE, you must
choose between options to assign no passwords or to assign random passwords.
Users who do not have passwords on the source server will still have no
password on the destination server, regardless of the option you select. If you
choose random passwords, a text file named NEW.PWD will be created on the
destination server in the SYS:SYSTEM directory. This file lists the new
password generated for each user.

Users who had passwords on the source server will be prompted to change their
password on their first login attempt to the new server, regardless of whether
the migrate choice was for random or no passwords. When the password is
changed, it affects both NDS and bindery logins.

! IMPORTANT:  There is a work-around that will allow you to save passwords
during a migration. On the NetWare 3 server, run BINDFIX.EXE twice and
copy the NET$OBJ.OLD, NET$PROP.OLD, and NET$VAL.OLD files from the
SYS:SYSTEM directory to a diskette. Copy these files from the diskette into
the SYS:SYSTEM directory on the destination server. On the intraNetWare
server console, load INSTALL. Then choose Directory options → Upgrade
NetWare 3 bindery information to the Directory.

Groups and Security Equivalences

Group information that migrates from NetWare 3 to intraNetWare includes:

■ Full group name

■ Group members

■ Whether or not the group has work group manager privileges (not valid
in intraNetWare)
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■ File server console operator status (not valid in intraNetWare)

■ Managed users and groups (not valid in intraNetWare)

■ Managers (not valid in intraNetWare)

When MIGRATE.EXE tries to create a group that already exists on the
destination server, the information from the source server merges into the
existing group definition.

Migration of group information works best when done in conjunction with
users. If you select groups without selecting users, MIGRATE.EXE displays a
series of error messages while attempting to add users to the group. See the
online documentation, Dynatext CD, in System Messages, for more information
on error messages.

Security equivalences to other users are maintained after the migration. File
system trustee rights inherited through these equivalences will be in effect on
the destination server. Since the Supervisor user is not migrated, Supervisor
security equivalence is not migrated.

NOTE: User disk space restrictions are not migrated.

Data Files

Data file information includes:

■ Directory structure and data files

■ File and directory attributes

■ File and directory ownership

■ Name space information for file systems that support NetWare

MIGRATE.EXE copies data files one volume at a time in an "all or none"
manner. You can choose which volumes you want to migrate; but for each one
chosen, the entire volume migrates to the destination server.
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If you migrate data files with MIGRATE.EXE Across-the-Wire Migration
utility, you can retain extended attributes for name spaces other than DOS by
installing the appropriate name space on the destination server volume before
migrating. Subdirectories deeper than 25 levels are not migrated. Directories of
the same name will be merged, meaning that files from the directory on the
source server will be copied into the directory with the same name on the
destination server.

! IMPORTANT: MIGRATE.EXE does not overwrite any existing files on the
destination server when copying a file from the source server to the
destination server. Thus, if a file with the same name already exists in the
destination directory, the Across-the-Wire Migration utility writes a message
to the report log file stating that the utility could not copy a file.

Trustee Assignments

A trustee assignment consists of the rights assigned to a user or group. A user
or group that has been assigned rights to work in a directory or file is known as
a trustee of that directory or file.

Trustee rights to directories and files migrate to the destination server using
MIGRATE.EXE. When migrating from NetWare 3 to intraNetWare, source
server trustee rights translate to their corresponding destination server trustee
rights.

The migration process preserves file system trustee assignments, even if you
are migrating data from different volume names on the source and destination
servers. For example, if the source server has volumes SYS, VOL1, and VOL2,
while the destination server has only SYS and VOL1, all data and trustees from
any of the three source volumes can be migrated to either of the two destination
volumes. The Directory Entry Tables are rebuilt with the correct object IDs of
the migrated users.

Migrating trustee assignments works best when done in conjunction with
migrating data files, users, and groups. If you select this category without
selecting the others, MIGRATE.EXE displays a series of error messages while
attempting to make trustee assignments. See the online documentation,
DynaText CD, in System Messages, for more information on error messages.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
3-14    MIGRATE.EXE Across-The-Wire Migration

Print Queues and Print Servers

Print queues are network directories that store print jobs. When the printer
assigned to a print queue is ready, the print server takes the print job out of the
print queue and sends it to the assigned printer. The print queue can hold as
many print jobs as disk space available.

NetWare print servers run through the PSERVER.NLM on an intraNetWare
server. intraNetWare print servers can service up to 255 printers with any
number of print queues assigned to the printer.

The following information migrates from NetWare 3 to intraNetWare for each
print queue:

■ Print queue operators

■ Print queue servers

■ Print queue status information

■ Print queue users

Print queues and print server definitions that migrate from NetWare 3 to
intraNetWare include the following information about each print server:

■ Full server name

■ Print server operators

■ Print server users

■ Print server configuration files

Migrating print queues and print servers works best when done in conjunction
with users and groups. If you select this category without selecting the others,
the utility displays a series of error messages while attempting to set up users
and operators of print queues and print servers. See the online documentation,
DynaText CD, in System Messages, for more information on error messages.

An additional step (MIGPRINT.EXE) is required to migrate the printing
environment to intraNetWare. “See Migrating Printing Environments” in this
chapter.
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Before You Begin
Before beginning the migration process, you should go through the NetWare 3
server (source server) directories and clean up any old files or users that you no
longer need. You might want to review the current directory structure and
revise the organization of the files. When migrating information to a new
intraNetWare server (destination server), it is advisable to allocate some time
before you start the migration process for configuration changes to either the
source server or the destination server. This will ensure that after the migration
is complete, the intraNetWare server is configured as you expect.

If you use accounting, determine that the source server contains the charge
configurations you want, because the source server's configuration either
overrides or merges with the configuration of the destination server.

When migrating data, be aware that if a file already exists on the source server
with the same filename as a file in the same directory on the destination server,
the Across-the-Wire Migration utility does not overwrite the file. This prevents
the NetWare 3 utilities and NLMs from overwriting the intraNetWare versions.
You will receive a message in the migration report log stating that the utility
did not overwrite the file. If you wish such a file to migrate, you should change
the filename on either the source server or the destination server before
beginning the migration process. This could be important if you have different
versions of the same program on the different servers. If the destination server
has the most recent version of a program, the Across-the-Wire Migration utility
does not migrate the older program files from the source server if the files have
the same name. See the Merging Users and Groups section later in this chapter.

If you are transferring user information to the destination server, it is best to
transfer their complete configuration information including data files, groups,
printing configurations, and trustee assignments.

Bindery Context

Migrated users and groups will be placed into the container designated as the
bindery context of the intraNetWare Server. If multiple bindery contexts are
set, the users and groups will be created in the first bindery context. You can
use the CONFIG server console command to verify the order of the bindery
context containers.
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Note: While multiple contexts can be set for bindery emulation, those contexts are
then viewed together as a single common “bindery.” This is important to
understand, especially in a case where multiple NetWare 3 servers are being
migrated into the same tree.

For example, suppose you are migrating two NetWare 3 servers, ACCT_1 and
SALES_1, into an intraNetWare tree. A user named Ron exists on each server,
but these represent two separate and distinct user accounts. You want to
migrate server ACCT_1 into the container .OU=Acct.O=Novell and server
SALES_1 into the container .OU=Sales.O=Novell.

You set the bindery context to .OU=Acct.O=Novell;.OU=Sales.O=Novell and
proceed to migrate. The migration of server ACCT_1 will create Ron in the
first container for which a bindery context is set, which is OU=Acct. You then
set the bindery context to .OU=Sales.O=Novell;.OU=Acct.O=Novell and
proceed to migrate server SALES_1. The migration of SALES_1 will merge its
Ron with the Ron from ACCT_1, since Ron already exists in the “global”
bindery context made up of OU=Acct and OU=Sales.

There are two ways to avoid this accidental merging of users. One is to ensure
that all users on the NetWare 3 servers who are in fact separate users have
distinct and unique names prior to migrating. Alternatively, a single bindery
context could be set on the intraNetWare server as each server is migrated.

Using the above example, the bindery context would be set only to
.OU=Acct.O=Novell while ACCT_1 is migrated, and set only to
.OU=Sales.O=Novell while SALES_1 is migrated. In this way, the destination
of each server’s users and groups can be controlled. However, if you create
duplicate names in this manner, and you later set the bindery context to
multiple containers in which conflicting names exist, only the user defined in
the first bindery context will be found.

Merging Users and Groups

When migrating multiple NetWare 3 servers into the same container in an
intraNetWare tree, groups and users that have the same name will be merged,
with the exception of user account restrictions and login scripts.
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For example, suppose that Ron exists on the source NetWare 3 server and also
in the destination server’s bindery context. You set up Ron on the NetWare 3
server to require a password, to have concurrent login and time restrictions, to
have a login script, and to have membership in groups Everyone and SSUsers.
The Ron on the intraNetWare server has no password and no account
restrictions, but has both a bindery and NDS login script and belongs to
WPUsers.

After running the migration utility, Ron on the intraNetWare server is now a
member of SSUsers, WPUsers, and Everyone, still has no password, has no
time restrictions, and the Ron login scripts are unchanged. This scenario is
shown in Table 3-2:

Table 3-2
 Merging Users and Groups

Existing NetWare 3
 RON

Existing intraNetWare
RON

Resulting intraNetWare
RON

Password = Yes Password = No Password = No

Time Restrictions = Yes Time Restrictions = none Time Restrictions = none

Concurrent Connections =
1

Concurrent Connections =
not set

Concurrent Connections =
not set

Group Membership =
Everyone, SSUsers

Group Membership =
WPUsers

Group Membership =
Everyone, SSUsers, WPUsers

Bindery login script Bindery and NDS login
script

Bindery and NDS login script
(contents unchanged)



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
3-18    MIGRATE.EXE Across-The-Wire Migration

Workstation Memory Problems

The process of migration creates an intermediate file in the specified working
directory. This file is used to convert bindery information and file system
trustee assignments from the source server to a format compatible with the
destination server. After the file is created in the working directory, it is read
back into memory in increments and sent to the destination server. If the
number of users, groups, and/or file trustees is large on the source server, it is
possible that the workstation memory will not be adequate to hold a file record
from the intermediate file.

Memory errors are posted at the workstation, but migration may continue, if
desired. The result may be loss of information for the users, groups, or file
trustees being migrated. To avoid memory problems, it is best to do the
migration in several sections. First, migrate everything EXCEPT the categories
All Information, Data Files, and Trustee Assignments. Next, migrate the Data
Files. Finally, migrate the Trustee Assignments.

Necessary Resources

The following resources are necessary to migrate from NetWare 3 to
intraNetWare:

■ Compaq SmartStart or the intraNetWare package from Novell

■ A NetWare 3 source server

■ A DOS workstation (client workstation) with at least 640 KB RAM,
480KB free memory, and 5MB of free disk space on either its hard drive
or a network drive (using NETX.COM 3.26 or later or VLM 1.20 or
later). The CONFIG.SYS should allow at least FILES=20. The client
software IPX Retry Count should be set to 60.

■ An intraNetWare destination server (also referred to as NetWare 4.x
destination server)
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Prerequisites

Prerequisites for migrating from NetWare 3 to intraNetWare are:

■ Move any files other than PRINTCON.DAT and LOGIN out of the
SYS:MAIL directory. The user print job configurations
(PRINTCON.DAT) and DOS user login scripts (LOGIN) migrate from
SYS:MAIL to the users’ new mail directory on the destination server.

NOTE: The Across-the-Wire Migration utility does not copy other files left in the
mail directories to the destination mail directory.

■ Use PRINTUSR.EXE to find obsolete user accounts and delete them.
Use DUPBIND.EXE to find different types of objects with the same
name. Resolve the conflict by renaming one of the objects. These
utilities are found in the file AN304X.ZIP on the Novell Support
Connection CD, Disk 2, in the \DOWNLOAD\NETWARE subdirectory.

■ Run the BINDFIX  utility on the source server, then run the VREPAIR
utility.

BINDFIX  prompts you to delete the mail subdirectories and trustee
rights of deleted users. See NetWare 3 documentation for more
information on the BINDFIX  utility.

Use VREPAIR to correct volume problems or to remove name space
entries from File Allocation Tables (FATs) and Directory Entry Tables
(DETs).

■ Delete unnecessary files.

■ When migrating two or more NetWare 3 source servers onto one
intraNetWare server, you need to plan for extra disk space for volume
SYS. To accommodate additional users and their login scripts, SYS
requires 6MB of additional disk space for each additional server
migrated.
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■ Ensure that you have the NetWare Migration Utility diskettes.

You can create the Migration Utility diskettes from the Compaq
SmartStart package, intraNetWare package, or get them from
CompuServe. See the following section for instructions on creating the
Migration Utility diskettes.

Creating Migration Utility Diskettes

To create Migration Utility diskettes from the Compaq SmartStart package or
intraNetWare package, follow these steps:

NOTE: You will need two formatted High-Density diskettes.

1. Insert the intraNetWare Software from Compaq No. 1 CD or the
intraNetWare CD into the CD-ROM drive of the server.

2. From the server console, enter:

LOAD INSTALL

Press Enter. The Installation Options menu is displayed.

3. Select Choose an item or product listed above from the Other Installation
Options menu.

4. Select Product Options (other optional installation items) from the
Installation Options menu.

5. Select Make Diskettes from the Other Installation Items/Products menu.

6. Verify that the path shown on the screen corresponds to the source
directory where the intraNetWare server installation files are located.

On the Compaq SmartStart package, intraNetWare Software from
Compaq No. 1 CD, the path is:

<Drive_or_Vol_Name>:\411\Products\NW411\Install\IBM\DOS\XXX\<Language_Dir>

Example: D:\411\Products\NW411\Install\IBM\DOS\XXX\English
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On the intraNetWare package, intraNetWare CD, the path is:

<Drive_or_Vol_Name>:\Products\NW411\Install\IBM\DOS\XXX\<Language_Dir>

Example: D:\Products\NW411\Install\IBM\DOS\XXX\English

Press Enter to continue.

7. Select Create NetWare Migration Utility Diskettes.

Press F10 to accept your selection and continue.

8. Insert a formatted diskette in drive A and press Enter to continue.

9. Follow the instructions on the screen for copying the utilities and
labeling the diskettes.

You will use the Migration Utility diskettes during the Across-the-Wire
Migration.

Migrating Across-the-Wire
The Across-the-Wire Migration utility migrates all information, including data
files and bindery information, from a NetWare 3 server, across the network to
an intraNetWare server.

When you use the migration utility, it is important to have only bindery
connections because the utility depends on bindery emulation to work. To
ensure that you have only bindery connections, log in to the intraNetWare
server as Supervisor using the /B option. The bindery emulation Supervisor
uses the password used to install the server.

For example:

LOGIN <Destination_Server_Name>/SUPERVISOR /B
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Installing the NetWare Migration Utility

Before starting the Across-the-Wire Migration utility, you must install the
NetWare Migration Utility diskettes on the hard drive of your DOS
workstation. You must have at least 5 megabytes of available disk space.

To start the Across-the-Wire Migration utility, follow these steps:

1. From your DOS workstation, log in to your intraNetWare destination
server using the /B option for bindery mode as described above and
attach to your NetWare 3 source server as Supervisor, using the
command:

LOGIN <Source_Server_Name>/Supervisor /NS

Make sure that you are the only user logged into the network.

2. Insert the  Migration Utility DISK 1 in drive A.

3. At the A prompt type:

INSTALL

Press Enter. By default the install program creates a directory on the
hard drive of your DOS workstation called MIGRATE and copies the
migration utility files from drive A to the MIGRATE directory.

Use the following example to change the default parameters of the
installation program if you are using floppy drives other than A and hard
drives other than C:

INSTALL <Floppy Drive>: <Hard Drive>:\<Directory>

For example:  INSTALL B: D:\Mydir

4. When prompted, insert the Migration Utility DISK 2 in drive A and press
any key to continue the installation of the Across-the-Wire Migration
utility.

5. Change to the migrate directory on the hard drive of your workstation
and type:

MIGRATE
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Press Enter. The Select the type of migration menu is displayed.

6. Select Across-the-Wire migration from the Select the type of migration
menu and press Enter.

The Select the source LAN type menu is displayed.
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7. Select NetWare 3 from the Select the source LAN type menu and press
Enter.

The Select the destination LAN type menu is displayed.

8. Select NetWare 4.x from the Select the destination LAN type menu and
press Enter.

The migration utility configuration form is displayed.
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Using the Migration Utility Configuration
Form

To complete the migration utility configuration form, follow these steps:

1. Under Step 1, press the Down Arrow key to accept the default working
directory, or press Enter to specify another working directory.

The working directory is where the bindery information and migration
reports are stored. You need 5 megabytes of free disk space in this
directory.

2. Under Step 1, press Enter to select an error/warning action.

Table 3-3 describes the different options for error/warning actions.

Table 3-3 Error/Warning Options

Error/ Warning Action Description

Pause after warnings and errors Choose this option if you want the utility to stop

after each warning and error and prompt you to

continue with the migration.

Each time an error is reported and you are

prompted, you can choose to discontinue the

prompting.

Do not pause after warnings and

errors

Choose this option if you do not want to be

prompted after each warning and error.

NOTE: All errors are listed in the report file regardless of the option you select.
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Select the type of error/warning action you require and press Enter.

3. Under Step 2, press Enter to display a list of source servers.

Choose the source server from which you want to migrate. Press Ins to
see a list of available servers you can log in to if the NetWare 3 source
server you want to select is not shown. Press Enter to accept the source
server. Type the Supervisor name and password if prompted.

NOTE: To migrate multiple source servers, you must migrate them one at a
time.

4. Under Step 2, press Enter to select information to migrate.

Select the categories of information to be migrated from the source
server using F5 to mark your selections and then press Enter. This
allows you to create a customized destination server.
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! IMPORTANT: The migration utility program cannot migrate the printing
environment to intraNetWare servers. After this migration procedure,
use MIGPRINT.EXE to migrate your printing environment. See Migrating
Printing Environments in this TechNote for more information.

Table 3-4 describes the information that can be migrated.

Table 3-4
 Information To Be Migrated

Category Description

All Information Migrates all information listed in this table.

Data Files Migrates all data files and their DOS and NetWare attributes for files

and directories to the corresponding intraNetWare attributes.

Trustee

Assignments

Migrates rights assigned to users and groups for directories and files to

corresponding intraNetWare rights.

Users Migrates users accounts, users work groups, and security

equivalencies.

User Restrictions Migrates account restrictions, station restrictions, and time restrictions.

If users exist on the destination server, their restrictions are not

overwritten.

If you select this category, you must also select Users.

If a user does not exist on the destination server, the restrictions set on

the source server are migrated to the destination server and are not

overwritten or merged by any subsequently migrated source servers.

Volume and disk restrictions for users are not migrated because of

differences in NetWare 3 and intraNetWare. In NetWare 3.12, the

restrictions are server-wide; whereas in intraNetWare, the restrictions

are volume-specific.
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Table 3-4
 Information To Be Migrated

Category Description

Groups Migrates the Group's members and assigned group trustee rights for

directories and files. Groups that existed on the source server remain

intact.

If multiple source servers are migrated, groups from the servers are

merged on the destination server.

Default Account

Restrictions

Migrates default account restrictions. Default account restrictions on

the destination server are overwritten by any source server that also

has default account restrictions.

Accounting

Information

Migrates the accounting charge method chosen to charge for services

(blocks read, blocks written, connect time, disk storage, service

requests).

Charge rates that exist on the source server remain intact.

Print queues and

print servers

See Migrating Printing Environments in this TechNote for more

information.

Non-Novell

bindery objects

When this option is selected, all static objects in the source server’s

bindery are migrated to the destination server. For each object

migrated, all bindery properties are migrated, but no attempt is made

to interpret their structure or meaning.

5. Under Step 2, press Enter to display a list of volumes on the source
server. Mark the volumes using F5 and press Enter again.

Select source volumes to migrate only if you are migrating files and
trustee assignments contained on those volumes. Select the volume you
want to migrate and press Enter.
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6. Under Step 3, press Enter to display a list of servers on the network.

Select the intraNetWare destination server from which you want to
migrate the NetWare 3 source server. If the intraNetWare destination
server you want to select is not shown, press Ins to see a list of available
servers you can access. Press Enter to accept the destination server.

7. Under Step 3, press Enter to display a list of selected source volumes
and their default destination volumes.

Select a source volume and press Enter again to specify the destination
volume and directory of your choice on the intraNetWare destination
server. To browse the existing directory structure on the destination
server, press Ins.

NOTE: The volume organization, as well as the directory structure, is migrated.
You can modify the organization on the destination server after all source
servers have been migrated.

Continue to specify destination paths if you have multiple volumes.

Press F10 when selections are complete.

8. Under Step 3, press Enter to choose a password option.

There are two options for assigning passwords. Table 3-5 describes the
two options. Highlight the password option you want and press Enter.
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Table 3-5
Assigning Password Options

Password Option Description

Assign Random Passwords
(Default)

A password for each user name that has a password
on the source server is generated randomly and stored
in a file called NEW.PWD in SYS:SYSTEM on the
intraNetWare destination server.

NOTE: New passwords are given only to users and
print servers that had a password on the source
server. The supervisor’s password is not changed.
Only users with rights to this server have access to the
password file. Users cannot login until they are given
passwords.

Assign No Passwords Users who had a user name on the NetWare 3 server
can log in using their previous user name. They are not
prompted for a password.

Users have the option to create their password if no
password was issued upon migration.

NOTE: If user account restrictions require users to have
a password, they are prompted to type a new
password, which the system stores.

Figure 3-4 shows an example of a completed configuration form.
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Figure 3-4. Example of a Completed Migration Utility Configuration Form

9. Press F10 to display the Select a migration action menu.

Select Start migration and press Enter.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
3-32    MIGRATE.EXE Across-The-Wire Migration

The bindery information is copied to the working directory on your
DOS workstation and translated into the intraNetWare format; it is then
copied to the intraNetWare server. The data files are migrated directly to
the intraNetWare destination server.

If errors occur during migration, you will receive the following
message:

Table 3-6 describes what happens if you select Y, N, or I.

Table 3-6 Error Selection Definitions

If you select Then

Yes The migration continues. The error is written to the migration
report file, and you are prompted again the next time an error
occurs.

No The migration stops. The error is written to the migration
report file. You receive this message:

Migration from the source server to the destination server is
complete. Press Enter to continue.

Ignore Error The migration continues. The error is written to the report file.
You are no longer prompted when an error occurs, but all
errors are written to the migration report file.

The Across-the-Wire Migration utility creates a migration report log file
named MIGxxx.RPT, where “xxx” is the number of the report generated.
This file is written to the working directory specified (C:\MIGRATE) on
the DOS workstation. See Appendix A, “Examples of Migration
Reports,” in this TechNote for an example of a migration report log file.
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A message is displayed stating that the migration process has completed.
If you do not want to view the migration report, select Exit (return to
DOS) from the Select a migration action menu. Next, select Yes from the
Exit menu to return to DOS.

To view the migration report from MIGRATE.EXE, follow these steps:

1. Highlight View Migration Reports from the Select a Migration Action
menu, then select the report for the migration you completed and press
Enter.

2. Press Esc twice to exit the report and return to the Select a Migration
Action menu.

3. Highlight Exit (return to DOS) from the Select a Migration Action menu.
Highlight Yes from the Exit menu to return to DOS.

After the migration has completed, you can choose to view the
migration report. See “Viewing the Migration Report” section in this
TechNote for more information.

You are now ready to migrate the printing environment.

Migrating Printing Environments

The migration utility program cannot migrate the printing environment to
intraNetWare servers. intraNetWare has a specific program, MIGPRINT.EXE ,
that can migrate your printing environment.

To migrate your printing environment, follow these steps:

1. From your local workstation, login to the intraNetWare destination server
as Admin.

! IMPORTANT: Do not use the /B option. To run the MIGPRINT.EXE utility,
you must be authenticated to an intraNetWare tree with NDS.

2. Create a search drive on the intraNetWare server by mapping a search
drive to SYS:SYSTEM/NLS.

For example: MAP INSERT S1:=SYS:SYSTEM/NLS
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3. Attach to the NetWare 3 source server as Supervisor. You will need to
use

LOGIN <Source_Server_Name>/Supervisor /NS

4. Run the MIGPRINT.EXE utility from the MIGRATE directory on your
workstation by typing:

MIGPRINT /S=<Source_Server_Name> /D=<Destination_Server_Name>

For example: MIGPRINT /S=Server312 /D=Server411

Press Enter.

If you wish to move the print queues to a volume other than SYS:, use the
/VOL= parameter to specify the volume on the destination server. You must
specify a distinguished name for the volume object.

PRINTCON.DAT is migrated as an NDS property of the NDS user object and as
PRINTJOB.DAT in the SYS:MAIL directory of the corresponding bindery user.
When an NDS user selects its Print Job Configuration property, the Print Job
attribute is converted from a pre-intraNetWare format to the intraNetWare
format. When a bindery emulation user accesses the PRINTJOB.DAT, the Print
Job configuration will point to the bindery file server defined as the source
server when running MIGPRINT.EXE. The bindery file server name cannot be
changed. Print job configurations need to be recreated for users who will
continue to access the server in bindery mode, unless the new server is renamed
to the old server’s name after migration. Print devices and forms do not
migrate.

When migrating from multiple NetWare 3 servers to a single intraNetWare
server, print queues that already exist with the same names will not be
duplicated. Printers migrated with the same name as those already created will
be created as numbers 0000, 1000, 2000, and so forth. If MIGPRINT.EXE is
run more than twice, the printer names will then be 0001, 1001, 2001, and so
forth.
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The MIGPRINT.EXE utility creates a print migration report log file named
MPxxx.RPT, where “xxx” is the number of the report generated. This file is
written to the working directory (C:\MIGRATE) on your workstation. After the
print migration is completed, the ASCII text file, MPxxx.RPT, can be viewed
with a text editor. See Appendix A, “Examples of Migration Reports,” in this
TechNote for an example of a print migration report log file.

After the Migration

After the migration is complete, check the intraNetWare server and do the
following:

■ Use UIMPORT.EXE to complete user login script migration.

■ Update references to the NetWare 3 server in user login scripts.

Although user login scripts are migrated, they are not modified. Server
names and directory paths need to be changed to match your new
environment.

■ Check user restrictions and accounting charge rates to make sure your
system is configured the way you want it.

■ If you choose to assign random passwords, you might want to print the
NEW.PWD file located in SYS:SYSTEM on the intraNetWare server
and distribute the password information to your users. The users should
change their passwords immediately.

The NEW.PWD file, an ASCII text file, shows passwords sorted by date.
If users were migrated from more than one server, the current password
is the last one listed on the report.

■ Examine the files in merged directories and reorganize them if
necessary. Any directories that were merged can contain unrelated files
that need to be consolidated or removed.
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■ Update migrated print queues and print servers.

Check print servers and print queues to make sure they are configured
correctly. Also make sure that the physical printer connection is secure.
Use the NetWare print utilities to verify print queue and print server
configuration.

■ Run third-party applications. You might have to reinstall them to work
properly under intraNetWare. The following conditions require you to
reinstall an application:

❏ The application has an .EXE file that did not migrate.

❏ The application is path-specific and you changed the path structure
during migration.

You might also have to enter new paths in the setup files for third-party
applications. Check applications to see if they run properly after making
any changes.

■ Some DOS applications do not work when installed on volumes that
have more than 32 megabytes of disk space. Some of these applications
can be made to work by doing the following:

❏ Use NWADMIN.EXE or NETADMIN.EXE (located in
SYS:PUBLIC) to restrict the disk space in the directory of the
application on the destination server.

❏ Make the directory a fake root with MAP (see the online
documentation, DynaText CD, in Concepts).

Viewing the Migration Report

After the migration is complete, you can choose to view the migration report.
The report is an ASCII text file that consists of the following:

■ Summary information of the bindery import phase (migrating bindery
data from the source server to the working directory).

■ Summary information of the bindery export phase (migrating bindery
data from the working directory to the destination server).
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■ A listing of each item in each category that was read from the source
server.

■ A listing of each item in each category that was written to or created on
the destination server.

■ The number of errors that occurred during the migration process.

You can view the migration report with any text editor or through the
MIGRATE.EXE utility.

Consolidating Command Line Utilities

If during the migration process you elect to migrate all information from the
NetWare 3 source server or the SYS: volume, be aware that some of the
NetWare 3 command line utilities have been consolidated or changed in
intraNetWare. The consolidation of the NetWare 3 command line utilities is
shown in Table 3-7.

Table 3-7
Command Line Utilities

NetWare 3 intraNetWare

ALLOW, GRANT, REMOVE, REVOKE, RIGHTS, TLIST RIGHTS

ATOTAL and PAUDIT AUDITCON

ATTACH and LOGIN LOGIN

BINDFIX and BINDREST DSREPAIR

CASTON, CASTOFF, and SEND SEND

CHKDIR, CHKVOL, NDIR, and LISTDIR NDIR

DSPACE, SECURITY, SYSCON, and USERDEF NETWARE ADMINISTRATOR or
NETADMIN

FCONSOLE MONITOR

FILER, SALVAGE, PURGE, and VOLINFO FILER

FLAG, FLAGDIR, and SMODE FLAG
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Table 3-7
Command Line Utilities

NetWare 3 intraNetWare

MAKEUSER UIMPORT

RCONSOLE and ACONSOLE RCONSOLE

SESSION NETUSER

SLIST and USERLIST NLIST

The migration utility does not block these utilities from being migrated to the
intraNetWare destination server; however, intraNetWare does not support these
utilities and they should be removed from the intraNetWare server after the migration.

The following command line utilities should be removed from the
intraNetWare server if they were copied during the migration process:

■ ACONSOLE ■ PAUDIT

■ ALLOW ■ PURGE

■ ATOTAL ■ REMOVE

■ ATTACH ■ REVOKE

■ BINDFIX ■ SALVAGE

■ BINDREST ■ SECURITY

■ CASTON ■ SLIST

■ CASTOFF ■ SMODE

■ DSPACE ■ SYSCON

■ FCONSOLE ■ TLIST

■ FLAGDIR ■ USERDEF

■ GRANT ■ USERLIST

■ LISTDIR ■ VOLINFO

■ MAKEUSER
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Summary
When using MIGRATE.EXE, you can migrate specific data and user
information to the intraNetWare server. You can migrate information from:

■ Accounting Information ■ Users

■ User Restrictions ■ Account Restrictions

■ Groups and Security Equivalences■ Data File Volumes

■ Trustee Assignments ■ Print Queues and Print Servers
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Chapter 4
DS Migrate and File Migration
Utilities

Overview
These utilities allow you to upgrade your NetWare 3 bindery server by
migrating modeled bindery information to an existing intraNetWare NDS tree.
Bindery migration is done through the new DS Migrate utility.

DS Migrate is a migration and modeling solution provided from a partnership
agreement between Preferred Systems Inc., the makers of DS Standard (the
utility on which DS Migrate is based) and Novell. Following the migration of
the server bindery, the server files are migrated using the new File Migration
utility.

Both DS Migrate and the File Migration utility are launched through the Tools
menu of NetWare Administrator. This method is one of the recommended ways
of migrating a NetWare server Across-the-Wire, rather than using
MIGRATE.EXE for both bindery and file migration.

How DS Migrate Works

Bindery Migration

DS Migrate converts bindery objects such as users, groups, queues, printers,
print servers, and so forth, into Novell Directory Services (NDS) objects. DS
Migrate migrates a NetWare 3 bindery through a three-step process. Each step
is discussed below.
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The Discover Step

From a NetWare client running Windows 3.1x or Windows 95 and logged in to
an intraNetWare server, the network supervisor connects to the NetWare 3
server whose bindery is to be migrated. The network supervisor launches DS
Migrate through NetWare Administrator and indicates the desired bindery
server to discover. A report is generated, and the bindery is placed in a
graphical structure that appears like an NDS tree. At this point, the bindery
information is placed in the DS Migrate database where it can be modeled.

The Model Step

With the bindery displayed in a graphical NDS tree-like structure, the structure
is saved in a view. The network supervisor then modifies the view to his or her
liking, including adding or deleting objects, moving objects, granting or
deleting rights and trustee assignments, and so forth. Changes made in the view
do not affect the actual NDS tree until those changes are merged to the actual
NDS tree during the configure step. Once the modeling process is complete, the
information displayed in the view can be configured (or merged) into the NDS
tree.

The Configure Step

The network supervisor logs in or maps a drive to the intraNetWare server.
From there he or she configures the objects within the view. Once all replicas
have been updated, the new bindery information becomes part of the NDS tree.

Items Migrated to NDS

The following bindery information is converted to NDS:

■ All user account restrictions

■ Mail directories and contents

■ Default user account restrictions, which become the properties of
USER_TEMPLATE.

■ User login scripts-both bindery and NDS

■ Group memberships and security equivalencies
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■ Novell print servers, queues, and printers

■ User print job configurations

■ System login script

NOTE: The instructions within the System login script become part of the Container
login script.

■ Directory level trustee assignments (DS Migrate also creates the
directories where trustees exist).

NOTE: When migrating a NetWare 3 server, the directories and associated trustees
are created using the File Migration utility.

■ File level trustee assignments

Working in conjunction, DS Migrate and the File Migration utility
assure that file level trustee assignments are migrated properly.
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Items Not Migrated to NDS

The following bindery information is not converted to NDS:

■ User passwords

NOTE: Passwords can be assigned globally or individually in the modeling process.

■ Printer definition database

File Migration

Once the NetWare 3 server bindery has been migrated, the server files are
migrated using the File Migration Utility. The File Migration utility is a
Graphical User Interface (GUI) utility that is run from a NetWare Client
running Windows 3.1x or Windows 95. Files from a NetWare 3 server are
copied by simply indicating the source and destination volumes in the utility’s
Wizard-based interface.

NetWare Server Files Not Migrated

The File Migration utility migrates all NetWare 3 server files and subdirectories
except for the following:

■ TTS$LOG.ERR from each migrated
volume

■ VOL$LOG.ERR from each migrated
volume

■ All files in SYS:SYSTEM ■ The SYS:SYSTEM\NLS
subdirectory

■ All files in SYS:PUBLIC ■ All files in SYS:/PUBLIC/OS2

■ All files in SYS:PUBLIC/UNIX ■ All files in SYS:PUBLIC/NLS

■ All files in SYS:PUBLIC/CLIENT ■ The SYS:LOGIN directory

■ The SYS:ETC directory ■ Any files that are currently open
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Preparing for Migration
Prior to migration, you must do the following:

■ Meet all client workstation system requirements

■ Disable Service Advertising Protocol (SAP) filtering on servers
involved in the migration process

■ Setup NetWare Administrator on the workstation

Client Workstation System Requirements

To run DS Migrate, the File Migration utility, and NetWare Administrator, your
NetWare client workstation must meet the following system requirements:

■ Windows 3.1x or Windows 95

■ Virtual Loadable Module (VLM) or NetWare Client 32 software

■ At least 8 MB of RAM

■ 1.2 MB of free disk space for NetWare Administrator

■ 3 MB of disk space for each NetWare server discovered

■ The following line included in your CONFIG.SYS file:

FILES = 40

Disabling Service Advertising Protocol (SAP)
Filtering

If you plan to use the File Migration utility to migrate NetWare 3 server files to
an intraNetWare server, you should first ensure that Service Advertising
Protocol (SAP) filtering is disabled on each server. If SAP filtering cannot be
disabled, you should ensure that the default server (preferred server) for the
client workstation through which you are running the utility is on the same
LAN segment as the other servers you are migrating to and from.
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You can change the default server setting for the client workstation you are
running the utility from by using the Preferred Server setting. You set this
parameter in the Control Panel →Network→Novell NetWare Client 32→
Properties for Windows 95 workstations, or in the NET.CFG file for VLMs
and for NetWare Client 32 for DOS and Windows workstations.

If either of the two servers that you are using for the migration exist across a
routed LAN segment, you must ensure that SAP filtering is disabled.

Setup NetWare Administrator

DS Migrate and the File Migration utility are launched through NetWare
Administrator. If you do not have NetWare Administrator already set up on
your workstation, you must do so at this time.

For a Client Running Windows 3.1x

Prerequisites

❏ A workstation cabled to the network and running Windows 3.1x
and either VLM or Client 32 software

❏ 1.2 MB of free disk space on the workstation

❏ A drive mapping to SYS:PUBLIC on the intraNetWare server

❏ Authentication to an NDS tree

Procedure

1. In Program Manager, choose the program group you want to start
NetWare Administrator from.

2. Click File→New.

3. Choose Program Item→OK.

4. In the “Description” field, enter NWADMIN→<Tab>.

5. Click Browse.
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6. In the Drives drop-down list, choose the drive that points to
SYS:PUBLIC.

7. Click on File Name→NWADMN3X.EXE→OK. The path to the
executable file is placed in the “Command Line” text box.

8. Again, choose OK→Yes. NetWare Administrator is created as a program
item icon in the group you selected.

9. Before exiting Windows, select Options→Save Settings on Exit.

For a Client Running Windows 95

Prerequisites

❏ A workstation cabled to the network and running Windows 95 and
Novell Client 32 software

❏ 1.2 MB of free disk space on the workstation

❏ A drive mapping to SYS:PUBLIC on the intraNetWare server

❏ Authentication to an NDS tree

Procedure

1. From the Windows 95 desktop, single click the right mouse button and
choose New→Shortcut

2. In the Command Line text box, enter
Z: \PUBLIC\WIN95\NWADMN95.EXE <Enter>

3. Choose Finish.

4. NetWare Administrator is created as a shortcut icon on your desktop.

Run DS Migrate
This process involves running DS Migrate to migrate the NetWare 3 server’s
bindery. The procedures are divided into the three sub-steps: discover, model,
and configure.
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The procedures that follow are those required to migrate a single volume
NetWare server to a single volume intraNetWare server. Based on your source
and destination server configurations, the procedures below may need to be
modified to address your server configuration needs.

Discover the NetWare Bindery

Prerequisites

❏ From a NetWare client running Windows 3.1x or Windows 95, log
in or map a drive to an intraNetWare server (as a user with
Supervisor rights) from which you can run the NetWare
Administrator utility.

❏ From the same workstation, establish a network connection (as a
user with Supervisor rights) to each bindery server to be migrated.

Procedure

The procedures in the following sections are somewhat condensed. Along with
these procedures, we recommend that you use the comprehensive Windows
online help that is built into the DS Migrate utility.

You can access the DS Migrate help system table of contents through the Help
menu, or by clicking the Help button (located on the far-right end of the
toolbar). You can access context-sensitive help by pressing F1.

1. Launch NetWare Administrator by double-clicking the NWADMIN
icon.

2. Select Tools→DS Migrate→Continue. The DS Migrate main window
appears.

3. Discover the bindery server you are mapped to by choosing File→New
View→Bindery View. You can also discover the bindery view by
clicking the Bindery Discovery toolbar button (the second button from
the left) on the toolbar. The Enter New View from Bindery screen
appears.
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4. Enter the view name and author for the new view and click OK.  For
information on views, refer to the DS Migrate online help. The Specify
Discover Parameters dialog box appears.

5. Choose the server to discover and the information you want discovered,
and click OK . The bindery objects you chose are discovered. DS
Migrate then generates a report displaying all of the information
captured in the discover.

6. Review the report for any errors (listed at the bottom of the report) and
close it when finished. The report is saved on the server in the
BINDDISC.LOG file. The NetWare bindery appears in a graphical NDS
tree-like structure where it can be modeled.

Model the NetWare Bindery

With the NetWare 3 bindery information discovered and saved to the DS
Migrate database, you can now begin the modeling process.

All bindery objects are placed into an Organizational Unit (OU) which is given
the same name as the server being upgraded. These objects, including the OU,
can be renamed, moved, or modified as desired. In addition, new NDS tree
objects can be created. During the modeling process, object properties and
login scripts can be created or edited as well.

The modeling changes affect only the DS Migrate database. The original
bindery objects in the NetWare 3 server and the actual intraNetWare NDS tree
where these objects will eventually reside are left untouched until the configure
process.

Modeling Considerations

It is important that the modeled tree structure be similar to that of the
intraNetWare NDS tree. Specifically, the container, server, and volume objects
that exist in the actual intraNetWare NDS tree above the objects being migrated
should also exist in the modeled tree.
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If the names of the source (NetWare 3) server and destination (intraNetWare)
server are different, the following objects and properties must be modified
during the modeling process:

■ Print queues - These must be modified to reflect the new intraNetWare
volume names where the queue directories reside.

■ Login scripts - These may require modifications to reflect new server
and volume names.

■ Print jobs - These may require modification to reflect new queue
information.

NOTE: DS Migrate has a Find and Replace utility under the Tools menu. This utility
will allows you to identify users and groups, and modify their properties before they
are configured to the NDS tree.

Model the Objects

Procedure

1. Rename the discovered bindery server and volume objects to match the
names of those in the actual intraNetWare NDS tree. Double click the
object and modify the Name field to do this.

2. Verify that all print queue objects’ volume properties now reflect the
actual intraNetWare volume names by double-clicking the queues and
reading the Volume property.

3. Add or rename container objects (the Organization and Organizational
Units) in the view as needed so that the tree structure above the
container holding the discovered objects appears identical to the actual
intraNetWare NDS tree where these objects will be migrated.

4. Drag and drop all NetWare 3 server and volume objects that were
renamed in Step 1 into the proper containers to match the locations of
the actual server and volume objects in the intraNetWare NDS tree.
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Configure the NetWare Bindery to the NDS
Tree

With the modeling process completed, you are ready to configure (or merge)
the modeled bindery to the NDS tree.

Prerequisites

❏ From a NetWare client running Windows 3.1x or Windows 95, log
in or map a drive (as ADMIN or a user with Supervisor rights) to
the intraNetWare server SYS: volume.

❏ Launch NetWare Administrator and then select Tools→DS Migrate.

Procedure

1. Select File→Open View.

2. Choose the desired view and click OK to activate the view.

3. Consistent with NDS security, you must have sufficient rights to
configure selected objects and containers.

4. Select Tools→Options→Configure.

5. Decide if you want directory trustees configured for directories that do
not yet exist on the destination intraNetWare server (these are
directories that have not yet been migrated through the file migration
process).

If you decide not to migrate the trustee assignments, un-check the
Create trustee directories if they do not exist check box in the Configure
dialog box.
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6. Set other desired configuration options in the Configure dialog box.
These include password and object merge options.

a. Selecting the Configure passwords checkbox lets you control
whether User passwords are configured to your live NDS tree.
Selecting this box activates the Create passwords for new objects
and Replace passwords for existing objects checkboxes.

b. Select the Create passwords for new objects checkbox if you want
to configure the passwords for any new users being added to the
live tree. Deselect this checkbox if you want new users added to the
live tree to have blank passwords.

c. Select the Replace passwords for existing objects checkbox if you
also want to configure the passwords for existing users in the live
tree with the passwords assigned to those users in the DS Migrate
view. Deselect this checkbox if you do not want to replace existing
user’s passwords during the configuration.

d. If you choose to have DS Migrate configure random passwords for
each user, they are placed in a text file (DSCONFIG.LOG) in the
SYS:\SYSTEM\DSMIGRATE\DATA\OUTPUT subdirectory. You
will need to devise a process to distribute these passwords to the
users so that they can log in.

e. If you do choose not to have DS Migrate configure random
passwords, each user will be required to enter a password during
their initial logon.

7. When all desired options have been set, click OK.

8. Choose View→Configure All Objects. A pre-configuration verification
is run. The pre-configuration verification checks that the integrity of the
objects is complete and can be merged into the intraNetWare NDS tree.
A dialog box displays when the pre-verification process is complete. If
errors were encountered, the dialog indicates this as well. Refer to the
on-line documentation for error explanations.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
4-13

Migration from NetWare 3 to intraNetWare

If Then

The dialog indicates that there were errors Click Cancel to close the dialog and go back and

correct the errors in the view.

Or

Click OK to ignore the errors and configure.

NOTE: Any pre-configuration errors must be

corrected either before or after configuration. If

you ignore the errors at this time, you will need to

correct them after the configuration.

No errors are indicated in the dialog Click OK to configure.

The time required for bindery information to configure itself in the NDS
tree varies according to the number of objects in the current view. Once
configured, a report appears.

9. Review the report for errors and then close it. Errors are documented at
the bottom of the report.

10. Perform additional measures as needed.

Item Action needed

User passwords Establishing them on the intraNetWare server

(This will depend on the password options you

set in Step 6).

Login scripts May need to be updated to reflect new server and

volume names

Print job files May need to be updated to reflect new queues



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
4-14    DS Migrate and File Migration Utilities

11. Continue with Migrate Server Files.

Migrate Server Files

File Migration Overview

Once the NetWare 3 bindery has been migrated, the NetWare 3 server files are
migrated using the new NetWare File Migration utility.

Like DS Migrate, the File Migration utility is launched through the Tools menu
of the NetWare Administrator utility.

! IMPORTANT:  The File Migration utility must be run on the same workstation
that you used to run DS Migrate.

The File Migration utility allows you to easily migrate server volumes by
simply designating the source server and the specific volume and subdirectory
on the destination server.

The NetWare File Migration utility uses a Windows help wizard. The wizard
provides visible online help for each page of the utility’s interface.

Prepare to Migrate NetWare 3 Server
Files

Make sure each of the following is true for your setup:

❏ You must have Supervisor or Supervisor Equivalent rights to both
the source (NetWare 3) and destination (intraNetWare) servers.

❏ If any of the volumes you are going to migrate contain files with
non-DOS naming conventions, load the appropriate name spaces on
the destination volumes:

Add Name Space name_space [ to volume-name]

❏ In the SYS:SYSTEM directory on the source server, update the
NLMs with the following NLMs located on the intraNetWare
Operating System CD in PRODUCTS\NW3X:
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For a NetWare 3.11 source server For a NetWare 3.12 source server

TSA311.NLM TSA312.NLM

SPXS.NLM SPXS.NLM

TLI.NLM TLI.NLM

CLIB.NLM CLIB.NLM

AFTER311.NLM AFTER311.NLM

A3112.NLM A3112.NLM

SMDR.NLM SMDR.NLM

STREAMS.NLM STREAMS.NLM

❏ Update the server drivers to the latest Compaq Novell Support
Software Diskettes (NSSD).

❏ Restart the source server and load TSA31x.NLM.

❏ If you are migrating volumes with Macintosh name space support
and the MAC.NAM file is earlier than version 3.12, dismount the
volume, unload MAC.NAM, load the 3.12 version of MAC.NAM
(located in PRODUCTS\NW3X) and then run the VREPAIR.NLM.

32-character Macintosh filenames are renamed during file migration. To
maintain filenames, reduce 32-character filenames prior to running the
NetWare File Migration utility.

Migrate the Server Files

Procedure

1. In the NetWare Administrator utility, choose Tools→File Migration.

Be sure to follow the directions on each of the wizard pages before
continuing.
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2. Click Next to continue. A new screen appears where you can indicate
the source server and volume whose files you want to migrate.

3. In the Source server field, click the down arrow and choose the desired
NetWare 3 server.

4. In the Source volume field, click the down arrow and choose the desired
volume for the server you selected.

5. Click Next to continue. A new screen appears with a field for you to
type the source server password.

6. In the Password field, type the NetWare 3 server password.

7. Click Next to continue. A new screen appears where you indicate your
destination server, volume object and directory path.

8. In the Destination server field, click the down arrow and choose the
server you want to migrate the files to.

9. In the Destination volume field, click the down arrow and choose the
volume you want to migrate the files to.

10. In the Destination directory field, click the down arrow and choose the
directory you want the files migrated to. Destination directories must be
located at the root of the volume.

11. Click Next to continue. A new screen appears with a field for you to
type the destination server password.

12. In the Password field, type the intraNetWare server password.
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13. Click Next to continue. At this point, the File Migration utility:

a. Verifies that the source and destination information you entered is
valid and can be migrated.

b. Verifies that you have appropriate rights to the source and
destination servers.

c. Locates and reads the DS Migrate name mapping file created by DS
Migrate.

d. Reads all users and groups on the source server and checks for the
NDS name property.

e. Disables login privileges for all users who are not currently logged
in to the source server.

f. Reads the name space information on the source and destination
volumes.

If you encounter problems, specific messages or dialogs appear that
require your input to fix the problems.

14. Click Migrate  to begin the file migration. The Migrating Files screen
appears showing the progress of the migration. You can stop the
migration by clicking Stop.

If you are migrating Then

Filenames that already exist on the destination

Server

The migrated file is renamed.

The log file MIGRATE.LOG displays the name of

the renamed file.

Directories that already exist on the destination

Server

The directory contents are merged into the

directory with the same name.

At this point, the File Migration utility automatically loads the
TSA410.NLM and MAP3XIDS.NLM on the destination server.

A screen informs you when the migration for the server volume is
complete. You can view the migration log by clicking View log. The log
is stored as MIGRATE.LOG in the root of the destination path.
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15. Migrate another server volume or exit the utility.

If you want to Then

Migrate another server volume Click Again.

Click Next and start the file migration process

again, beginning with Step 2.

Exit the File Migration utility Click Done.
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Chapter 5
Simware’s REXXWARE Migration
Toolkit (RMT)

Overview
Simware’s REXXWARE Migration Tool (RMT) is a server-based utility that is
used in Across-The-Wire upgrades of large-scale NetWare 3 networks to
intraNetWare. After you have installed intraNetWare on the destination servers
using the Install utility, you use RMT to migrate network information and data
files from the NetWare 3 source servers. With RMT, you can migrate multiple
NetWare 3 servers at one time. You can also consolidate multiple NetWare 3
servers into a single intraNetWare server at one time.

How RMT Works

How RMT Migrates Information

First, RMT creates a Novell Directory Services (NDS) model of the NetWare 3
bindery. RMT then extracts bindery objects such as users, groups, queues,
printers, and print servers from the specified NetWare 3 source servers,
converts them into NDS objects, and places them in an intraNetWare database
on the destination servers. You have complete control over every step of this
process to ensure that the resulting intraNetWare database accurately models
the NDS tree structure you have established.

Second, RMT migrates the NDS model of user, group, and print-system objects
from the intraNetWare database to the live NDS tree. You can edit the NDS
model graphically to ensure it fits your planned NDS tree structure before
migrating it to the live NDS environment.

When you have completed the migration of the NDS model to the live NDS
environment, RMT migrates data files from the selected source NetWare 3
servers to the destination intraNetWare servers. You can consolidate multiple
volumes from the source server into a single volume on the destination sever.
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RMT Menus

RMT has the following top-level menus, each of which is one major task of a
migration.

The wording of some options is abbreviated in the following diagram:

Figure 5-1.   RMT Menus
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Overview of RMT Migration Tasks

Figure 5-2.   RMT Task Flow Chart

Each migration with RMT involves seven high-level tasks:

1. Extract 3.x server objects into a 3x database.
2. Generate a NetWare 3 report.
3. Prepare an intraNetWare (4x) database.
4. Apply the 3x database to the intraNetWare (4x) database.
5. Generate a report for the intraNetWare (4x) database.
6. Edit the intraNetWare (4x) database.
7. Migrate from the intraNetWare (4x) database to live intraNetWare.
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Task 1 - Extracting Information from the
NetWare 3 Server

In this task, you extract the following information from NetWare 3 server
binderies, and store the resulting records and properties in a NetWare 3
database:

■ Standard bindery objects (such as USERS, GROUPS,
PRINT_QUEUES, PRINT_SERVERS)

■ Their properties (such as user objects and the groups to which they
belong)

Choose the following options in order to perform this task:

1. Filter 4x Servers (the default is ON) to set this option to OFF (by
choosing the Show All Servers option) if you are connected to a WAN or
if you have a large number of servers.

2. Select Server to display a list of NetWare 3 servers and to choose the
server you want to extract. For each additional server, repeat this and the
following two steps.

3. Select Object Type to choose from a list of object types (such as USER)
for extraction.

4. Perform Extract to read the objects and their properties on the selected
NetWare 3 servers, and to create a copy of them in the NetWare 3
database.
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Task 2 - Generating NetWare 3 Reports

Task 2 allows you to create a NetWare 3 report to find out exactly which user,
group, print server, and/or print queue objects are on each NetWare 3 server. It
generates the report on any object class or objects that have common attributes
(for example, all user objects with Supervisor equivalence). You can select the
detail level you want for your NetWare 3 reports.

Choose the following options to perform this task:

■ Report Page Size to specify the number of lines per page (the default is
66) for a report.

■ Generate 3x Report to produce a formatted report on any objects that
you have extracted into the NetWare 3 database.

■ Generate 3x Dump to produce a dump of the contents of your extracted
servers, which are now in the NetWare 3 database.
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Task 3 - Preparing an intraNetWare
Database

Task 3 creates an intraNetWare database and makes it ready to receive the
NetWare 3 database information by extracting an existing NDS tree or
emulating an NDS installation. It also creates the container structure from your
NDS plan and associates NetWare 3 servers to NDS server objects, and the
NetWare 3 volumes to NDS volume objects. Set the time zone for each NDS
server object.

Choose the following options in order to perform this task:

1. Select an intraNetWare Database either to choose an existing database
that represents your NDS environment, or to create a new intraNetWare
database.

2. Edit Container Objects in the intraNetWare database to add, delete, or
modify any Organization (O), Organizational Unit (OU), Locality (L), or
Country (C) object.

3. Create Additional intraNetWare Server & Volume Objects in the
intraNetWare database when you are migrating to more than one server
at a time.

4. Associate 3x Servers & Volumes to intraNetWare to map your migration
on a server-to-server basis (you can also use this step to consolidate
servers).

5. Set intraNetWare Server Time Zones to specify the number of hours a
server is offset from Greenwich Mean Time (GMT) so that RMT will set
the correct user login times when migrating users. This option does not
reset the time zone on the server itself.
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Task 4 - Applying the NetWare 3
Database to an intraNetWare Database

In Task 4, you bring the information from NetWare 3 database objects to the
corresponding intraNetWare database objects by selecting an intraNetWare
database to receive the NetWare 3 information. You then configure the user
Identification Template to parse first names and last names correctly before
applying the NetWare 3 database object information to the intraNetWare
database. At this point, the intraNetWare database becomes a virtual NDS tree,
which you will edit.

Choose the following options in order to perform this task:

1. Select an intraNetWare Database to choose the database that represents
your NDS environment, or to create a new intraNetWare database that
models your NDS plan.

2. Identification Template to edit the default format for user objects to the
format you want for mapping the Full Name format in NetWare 3 to First
Name and Last Name user attributes in NDS and a placeholder for Middle
Name.

3. Apply 3x DB to intraNetWare DB to take the NetWare 3 server
information extracted into the NetWare 3 database, and apply it to the
intraNetWare database.
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Task 5 - Generating an intraNetWare
Report

Task 5 creates and runs a report to check whether your intraNetWare database
model matches your NDS plan. It reports on any object class or objects that
have common attributes (for example, all users with Admin equivalence). You
can select the detail level you want for reports on the virtual NDS tree.

Choose the following options to perform this task:

■ Report Page Size to specify the number of lines per page (the default is
66) for a report.

■ Generate intraNetWare Report to produce a formatted report on any
objects that you have extracted into the intraNetWare database.

■ Generate intraNetWare Dump to produce a dump of the contents of
your extracted servers, which are now in the intraNetWare database.
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Task 6 - Editing an intraNetWare
Database

In Task 6, you model your intraNetWare database into the exact NDS tree
structure you have planned by moving all of the database objects to the NDS
contexts shown in your plan. You can then edit the objects to give them new
NDS attributes (for example, Email Address). If necessary, combine duplicate
objects of the same class originating from different NetWare 3 servers (for
example, consolidate the contents of several servers in the same container).
You can also resolve duplicate objects of different classes originating from the
same NetWare 3 server.

Choose the following options in order to perform this task:

1. Select intraNetWare Database to choose from a list of databases that you
created when you prepared the intraNetWare database.

2. Edit Container Objects to edit or create new Country, Organization, or
Organizational Unit objects.

3. Edit Leaf Objects to edit objects in the intraNetWare database to change
their context to fit your plan and to add attributes (such as Email
Address).

4. Edit Duplicate Objects to combine or rename objects with the same
object name, originating from different NetWare 3 servers, or from the
live NDS tree.

5. Batch Edit to use an external ASCII input file to modify the attribute
values of objects in the intraNetWare database (same procedure as Leaf
Edit, but with input given through a file rather than built interactively).
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Task 7 - Migrating

Finally, in Task 7 you bring the intraNetWare database model of your NDS
plan into your live NDS environment. You can choose the type of initial
passwords you want to give users on the intraNetWare servers (such as null,
random, or passwords from an external file you create). You then migrate the
user, group, and print-system objects to the live NDS tree, and update
references within the objects in the live NDS tree. When you begin the actual
migration, you choose the type of file migration to perform, either test or real.
You also select whether to migrate files and directories from the DOS name
space, or from other name spaces, such as Mac, OS/2, NT, and NFS.

Choose the following options in order to perform this task:

1. Select an intraNetWare Database to choose a virtual NDS tree from
among those that you have created.

2. Set 3x SUPERVISOR Associations to map each NetWare 3 Supervisor
object to a line intraNetWare user who is an Admin-equivalent user in
the corresponding part of your NDS tree.

You must assign an Admin-equivalent user for each intraNetWare
server in the NDS tree. If you do not, RMT will set the Supervisor
association to your login userid.

3. Check Existence of Volumes and Servers to compare volumes and
servers in the intraNetWare database against the live NDS tree.

4. Migrate Objects to NDS to migrate users and groups, print environment,
and the references for these objects.

5. (Optional) If you are migrating files with name spaces other than DOS,
run the Name Space Applet on the NetWare 3 server first, then on the
intraNetWare server.

6. Migrate File System to bring the files, directories, and trustees over from
the NetWare 3 environment to the NDS environment. You can use either
the Express Migration or Standard Migration option.
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Before Running RMT

Before you run RMT, ensure that you complete the following tasks:

■ With no users logged in, run the Novell utility BINDFIX on each of
your NetWare 3 servers to purge deleted records from the bindery.

■ Back up all the NetWare 3 servers that you will be migrating.

■ If BTRIEVE.NLM is already loaded on the intraNetWare server where
RMT is running, carefully unload any operations that use Btrieve,
unload Btrieve, and then load it with the following line:

LOAD BTRIEVE -b=64K

■ Make sure all intraNetWare servers are updated with the latest Novell
intraNetWare updates for Directory Services, such as DS.NLM and
DSREPAIR.NLM.

■ Turn off all automatic backups and cancel any manual backups planned
for the migration period. A backup during the migration period could
disrupt a migration.

■ If you have a WAN, create a local replica of your NDS Partition on your
RMT server or elsewhere on your LAN. When RMT is updating a local
replica of NDS, performance is better. In addition, any danger of a break
in the link to the server where NDS is located is greatly reduced.

NOTE:  The RMT server should be part of an NDS tree unless you are accessing
more than one NDS tree during migration. In such a case, the RMT server should
not be part of any NDS tree.

■ 32 MB (64 MB recommended) is the minimum memory you should
have on the intraNetWare server where you are installing RMT.

■ If you get a “Cache memory allocator out of memory” error, ensure
there is enough unfragmented memory. Save your previous SET
command settings, issue three set commands, and edit the three SET
command lines in AUTOEXEC.NCF. Here is a convenient way to do
this.
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1. Save your previous SET command settings:

a. Go to the system console and type:

LOAD SERVMAN

b. Choose Server Parameters→Memory.

c. Change one value to another number, and then change it back to the
original number.

d. Press Enter→Esc.

e. When prompted with Copy parameters to a file?, press Enter to
accept (creating or updating your SETCMD.CP file with the current
settings).

2. Issue the three SET commands and update your AUTOEXEC.NCF file:

a. Press Esc until you reach Choose Server Parameters.

b. Choose Memory.

c. Vary three memory settings downward from their current levels by
using these SET commands from the system console or by using
SERVMAN.NLM:

SET MINIMUM FREE MEMORY FOR GARBAGE COLLECTION

SET NUMBER OF FREES FOR GARBAGE COLLECTION

SET GARBAGE COLLECTION INTERVAL

a. Press Enter for each setting.

d. Press Esc.

e. When prompted with Update AUTOEXEC.NCF?, press Enter to
accept.

f. Press Esc to exit SERVMAN.

3. When you have finished running RMT, do the following:

a. Go to the system console and type:

b. LOAD SERVMAN.

c. Choose Server Parameters→Memory.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
5-13

Migration from NetWare 3 to intraNetWare

d. Change the three values back to those listed in
SYS:\SYSTEM\SETCMD.CP.

e. Press Enter→Esc.

f. When prompted with Copy parameters to a file?, press Enter to
accept (updating your SETCMD.CP file with the current settings).
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Final Tips for Using RMT
■ Ensure that you have adequate free space on the RMT server.  A large

migration may use from 10 to 200MB of free space on a server to store
the RMT, its databases, reports, and log files.

■ Make a copy of the 4.x database after applying the 3.x database to it, but
before migrating.  If anything goes wrong with the migration, you will
have a backup database to restore.

■ Any reference to SUPERVISOR is translated to the distinguished name
of the Admin during the migration.

■ Do not skip running BINDFIX on the 3.x bindery before you extract.

■ You may consolidate several 3.x servers on one intraNetWare server by
extracting information on subsequent servers into the 3.x database
created by extracting the first 3.x server. Answer Yes to Append to
existing 3x DB? when prompted.

■ Ensure that you have created the emulated server and volume objects
and created appropriate associations before applying the 3x database to
the intraNetWare (4x) database.

■ When editing the intraNetWare (4x) database, remember that you can
use Batch Edit to change the property values (attributes) that groups of
leaf objects should have in common.

■ Before migrating files with name spaces other than DOS, remember to
run the Name Space Applet on the NetWare 3 server first, then on the
intraNetWare server.

■ Remember that files in the SYSTEM, PUBLIC, MAIL, LOGIN, and
ETC directories will not be migrated to the intraNetWare server because
those directories contain 3.x specific files.  Move files to other
directories if they need to be migrated.
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Chapter 6
Workstation Software and
Management

This chapter describes the procedures for installing workstation software and
management applications. Detailed explanation of these procedures is
contained on the intraNetWare Online Documentation CD, which is accessed
by using the DynaText viewer. See Chapter 7 for instructions on installing and
using DynaText.

NetWare Client 32 Software
This section provides procedures to install NetWare Client 32 Software from
the intraNetWare server.

To install NetWare Client 32 software, you need to first install intraNetWare or
use the Installation Utility to make client diskettes. If intraNetWare has not
been installed yet, see the Compaq SmartStart documentation or the
intraNetWare documentation for information on installing intraNetWare.

You can install the NetWare Client 32 Software from the intraNetWare server
or by using the NetWare Client 32 diskettes. To make the NetWare Client 32
diskettes, use the SmartStart package or the intraNetWare package. Compaq
recommends installing the NetWare Client 32 Software from the intraNetWare
server because it:

■ Is fastest

■ Is easiest

■ Requires no diskettes
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Before You Begin

Client Requirements

The following resources are necessary to install NetWare Client 32 Software
for Windows NT, Windows 95, and DOS/Windows 3.1x workstations:

■ A 386 processor or better for Windows 3.1x; 486 or better for Windows
95 and Windows NT

■ RAM as follows:

❏ At least 12 MB of Ram (16 MB recommended) for Windows NT

❏ At least 6 MB of RAM for Windows 95

❏ At least 5 MB of RAM for Windows 3.1x and DOS

■ 6 KB of conventional memory; remaining memory is allocated to
extended memory

■ A memory manager, such as HIMEM.SYS, EMM386.EXE, QEMM, or
386MAX

■ A network board installed in your workstation and a record of the board
settings to use during the installation process

■ A physical connection to a NetWare network

■ A supported operating system

Communication Protocol

A communications protocol is a set of rules determining the “language” used to
move data across the network. The protocol guarantees that two devices using
the same protocol can communicate because they “speak the same language.”

The communications protocol is provided to the workstation by IPX.NLM for
DOS/Windows 3.1x and Windows 95. The intraNetWare Client 32 for
Windows NT does not ship with its own IPX/SPX protocols, but uses
Microsoft’s NWLink instead.
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Open Data-Link Interface (ODI)
Specifications

intraNetWare network workstations use a version of the IPX communications
protocol that works according to the ODI specifications. ODI allows you to run
multiple protocols on the same cabling system. This increases the functionality
of your network by allowing devices with different communications protocols
to exist on the same network. For example, a computer can run both the IPX
and TCP/IP protocols on the same Network Interface Card (NIC).

The benefits of using ODI are:

■ Concurrent communication with a variety of workstations, servers, and
mainframe computers using different protocols.

■ Use of any NIC designed to ODI specifications for communications.

■ Fewer hardware components to maintain.

Link Support Layer (LSL)

LSL is the implementation of the ODI specification. LSL acts like a
switchboard to route network information of different protocols between the
Local Area Network (LAN) driver and the appropriate communications
software.

LSL is loaded on the workstation by LSLC32.NLM for DOS/Windows 3.1x and
Windows 95, and LSL.SYS for Windows NT.

LAN Driver

The LAN driver controls the workstation NIC. NetWare Client 32 supports
several different methods for connecting the workstation to the server. An
example of a LAN driver is CNE2000.LAN.

NOTE: You will need the manufacturer’s MLID driver for the NIC installed in your
workstation, if one is not provided with the intraNetWare workstation software.
intraNetWare workstation software supports most NICs. If a driver is not listed for
your particular NIC, check the packaging or contact the NIC manufacturer to obtain
an intraNetWare compatible driver.
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NetWare Client 32 for Windows NT

NetWare Client 32 is installed using the Windows NT Graphical User Interface
(GUI) setup program, SETUPNW.EXE. It can be installed in the following
ways:

■ Using a server-based Windows install (UNATTEND.TXT setup) on a
workstation that does not have Windows NT installed

■ Using the SETUPNW.EXE application on a workstation that already has
Windows NT installed

■ Using the Automatic Client Update (ACU) for NT

NetWare Client 32 installation incorporates Windows NT property pages that
were created specifically to set NetWare Client 32 configuration parameters
contained in the Windows NT Registry. These pages use a GUI to replace
editing network configuration settings in a configuration file.

Installing NetWare Client 32 Using a
Server-Based Windows NT Install
(UNATTEND.TXT Setup)

This method prepares the Windows NT and NetWare Client 32 files on a server
so that they can be installed at the same time. During installation, the files are
copied from the server to the workstation. See the help files in NetWare Client
32 for more information about UNATTEND.TXT setup.

Installing NetWare Client 32 on a
Workstation that has Windows NT
Installed

This method can be used if you are upgrading from the NetWare DOS
Requester (VLM) client. If you do not have any network client software
installed, you need to have the Windows NT CD-ROM or diskettes, or the
Windows NT *.CAB files.
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After the installation is complete, you can customize the client using the
Network Configuration Page. Here you can also set the interrupt and address of
the workstation’s NIC. You can also specify which of the GUI login cards
display when LOGINWNT.EXE is launched.

Installing NetWare Client 32 Using
Automatic Client Update (ACU) for
Windows NT

ACU for NT automatically updates NetWare Client 32 for Windows NT
software. It operates through network-based login scripts or through NAL.
When a user logs in to the network or clicks on the NAL-installed update icon,
the update mechanism checks the version of the client software and updates
older clients automatically. You can custom-configure the installation and
update for each user. ACU for NT can also update the Microsoft Client for
NetWare Networks, but does not work with NETX or with the VLM programs.

Configuring Network Parameters in
Windows NT

NetWare Client 32 is designed to minimize configuration time. Most default
values will suffice in most environments. NetWare Client 32 uses some settings
as a guide, or as an initial value, and then dynamically adjusts the settings’ run-
time equivalents for optimum performance, reducing the amount of time you
spend on configuration.

After installing NetWare Client 32, you can customize the client for your
workstation.

1. To open the network properties window, perform either of the
following:

a. On the desktop, right click on Network Neighborhood
icon→Properties.

b. On the task bar, click the Start button→Setting→Control
Panel→Network icon.

2. With the Network properties window open, select Novell NetWare
Client 32→Properties.
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The NetWare Client 32 Properties window allows you to change settings at a
workstation. On the Client 32 tab, you can specify the following:

■ Preferred server

■ Preferred tree

■ Name context

■ First network drive

On the Login tab, you can set which of the tabs appear when the GUI login is
executed.

NetWare Client 32 for Windows NT
Installation Procedure

Perform the following steps to complete installation of NetWare Client 32
software:

1. Start Windows NT.

2. Verify Microsoft’s Client Service for NetWare is loaded.

a. Right-click on Network Neighborhood.

b. Select Properties � Services tab.

c. Client Services for NetWare should be listed as an installed service.

d. Click OK.

3. Start the SETUPNW.EXE program.

4. After consenting to the software license agreement, an information box
indicating that Microsoft Client Service for NetWare will be removed is
displayed. Click Yes to continue.

5. SETUPNW.EXE performs the following:

a. Removes existing client information from the Registry database.

b. Adds the new intraNetWare Client keys to the Registry.

c. Copies the necessary files to the workstation.
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6. When the step above is complete, an Installation Complete information
box is displayed. You can either:

a. Close the installation program by clicking the Close button.

b. Reboot the workstation by clicking the Reboot button.

7. After rebooting, you should see a new intraNetWare Client window
instructing you to press Ctrl+Alt+Delete  to log in. After doing so, the
login interface is displayed for you to login.

8. The installation process is complete.

NetWare Client 32 for Windows 95

NetWare Client 32 is installed using the Windows 95 Graphical User Interface
(GUI) setup program, SETUP.EXE. It can be installed in the following ways:

■ Using a server-based Windows install (MSBATCH setup) on a
workstation that does not have Windows 95 installed

■ Using the SETUP.EXE application on a workstation that already has
Windows installed

■ Using the Automatic Client Update (ACU) for Windows 95

NetWare Client 32 installation incorporates Windows 95 property pages that
were created specifically to set NetWare Client 32 configuration parameters
contained in the Windows 95 Registry. These pages use a GUI to replace
editing network configuration settings in a configuration file.

Installing NetWare Client 32 Using a
Server-Based Windows 95 Install
(MSBATCH Setup)

This method prepares the Windows 95 and NetWare Client 32 files on a server
so that they can be installed at the same time. During installation, the files are
copied from the server to the workstation. See the help files in NetWare Client
32 for more information about MSBATCH setup.
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Installing NetWare Client 32 on a
Workstation that has Windows 95
Installed

This method can be used if you are upgrading from the NetWare DOS
Requester (VLM) client. If you do not have any network client software
installed, you need to have the Windows 95 CD-ROM or diskettes, or the
Windows 95 *.CAB files.

After the installation is complete, you can customize the client using the
Network Configuration Page. Here you can also set the interrupt and address of
the workstation’s NIC. You can also specify which of the GUI login cards
display when LOGINW95.EXE is launched.

Installing NetWare Client 32 Using
Automatic Client Update (ACU) for
Windows 95

ACU for Windows 95 automatically updates NetWare Client 32 for Windows
95 software. It operates through network-based login scripts or through NAL.
When a user logs in to the network or clicks on the NAL-installed update icon,
the update mechanism checks the version of the client software and updates
older clients automatically. You can custom-configure the installation and
update for each user.  ACU can also update the Microsoft Client for NetWare
Networks, but does not work with NETX or with the VLM programs.

Configuring Network Parameters for
Windows 95

NetWare Client 32 is designed to minimize configuration time. Most default
values will suffice in most environments. NetWare Client 32 uses some settings
as a guide, or as an initial value, and then dynamically adjusts the settings’ run-
time equivalents for optimum performance, reducing the amount of time you
spend on configuration.
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After installing NetWare Client 32, you can customize the client for your
workstation.

1. To open the network properties window, perform either of the following:

a. On the desktop, right click on Network Neighborhood
icon→Properties.

b. On the task bar, click the Start button→Setting→Control
Panel→Network icon.

2. With the Network properties window open, select Novell NetWare
Client 32→Properties.

The NetWare Client 32 Properties window allows you to change settings at a
workstation. On the Client 32 tab, you can specify the following:

■ Preferred server

■ Preferred tree

■ Name context

■ First network drive

On the Login tab, you can set which of the tabs appear when the GUI login is
executed.

NetWare Client 32 for Windows 95
Installation Procedure

Perform the following steps to complete installation of NetWare Client 32
software:

1. Run SETUP.EXE.

2. When the Software License Agreement page appears, click Yes to
accept the agreement and display the NetWare Client 32 installation
screen.

3. Select whether or not to update NDIS drivers to ODI automatically, if
available.

4. Click Start. SETUP.EXE automatically installs and configures NetWare
Client 32 with default properties.
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5. When the setup is complete, click Customize.

6. Select Novell NetWare Client 32 → Properties.

7. Type in the Preferred server, Preferred tree, and Name context. Leave
the First network drive set to F.

8. Click Login and select the following:

a. Display script page

b. Display variables page

c. Save settings when exiting Login

9. Click OK→OK.

10. If prompted to configure the resources for your board, do the following:

a. Add the interrupt values

b. Add the I/O address range values

c. Add the memory address values

11. Wait while Windows builds a driver information database.

12. When prompted, click Yes to restart your computer.

13. The installation process is complete.

NetWare Client 32 for DOS/Windows 3.1x

NetWare Client 32 needs specific files to be copied into the Windows
directories, and it also requires several Windows files to be modified. The
NetWare Client 32 installation software automatically does this.

NetWare Client 32 software is installed on a DOS/Windows 3.1 workstation by
running INSTALL.EXE from DOS, or SETUP.EXE from Windows. Both of
these programs can modify the AUTOEXEC.BAT and CONFIG.SYS files to
enable the client to load automatically on startup. The first line in the
Installation Configurations screen, “Modify AUTOEXEC.BAT and
CONFIG.SYS”, is defaulted to Yes, which allows the Install program to change
these configuration files. After the installation is complete, you should confirm
the settings in the workstation’s NET.CFG file.
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Installing NetWare Client 32 Using
Automatic Client Update (ACU) for
DOS/Windows 3.1x

If you are installing to a DOS/Windows 3.1x workstation, you can use
Automatic Client Update to update NETX, VLMs, or an older version of
NetWare Client 32 to the current version.

ACU for DOS/Windows 3.1x uses the following utilities:

■ NWDETECT – begins the ACU process by looking for an Install Stamp
in the NET.CFG file on the workstation, and detecting whether a
difference exists between the parameters in the login script and the
NET.CFG file.

■ NWSTAMP – updates (or creates) the Install Stamp in the NET.CFG
file.

■ NWLOG.EXE – produces a log file that contains the following
information:

❏ Date

❏ Time

❏ Username

❏ IPX external network number

❏ Node address

❏ Any text defined by the network administrator

■ REBOOT – automatically reboots the workstation.
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Configuring Network Parameters for
DOS/Windows 3.1x

NET.CFG specifies non-default value settings for NetWare Client 32 software
configuration options, such as the default hardware setting on the NIC, whether
or not you are using multiple protocols, or if you are using the LAN WorkPlace
software. To create or modify the NET.CFG, complete the following:

1. Use a DOS text editor to type section headings and options in an
existing or new NET.CFG file. The default location of the NET.CFG file
is C:\NOVELL\CLIENT32.

2. Copy or save the NET.CFG to the client workstation’s
NOVELL\CLIENT32 directory.

NetWare Client 32 for DOS/Windows 3.1x
Installation Procedure

Complete the following steps to install NetWare Client 32 software:

1. Close all other programs running on the computer.

2. From Program Manager, choose File→Run.

3. Browse to the NetWare Client 32 SETUP.EXE file.

4. Click OK.

5. Select the appropriate language for your system→OK.

6. In the Welcome dialog box, click Continue→Yes to accept the Software
License Agreement.

7. Click Next at the Directory Locations dialog box.

8. Select a 32-bit LAN driver for your NIC.

9. Confirm that the board setting specifies the correct ODI LAN driver for
your NIC.

10. Click Next→Next.

11. When the installation is completed, select Restart Computer
(Recommended)→OK.
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12. After the workstation has restarted, and Windows is running, run
NetWare User Tools for Windows.

13. Click the NetWare Settings button→Startup tab.

14. Verify that “Launch on Startup” is selected.

15. Click the Login tab.

16. Verify that “Display Connection Page”, “Display Script Page”, “Display
Variables Page”, and “Restore Permanent Connections” are selected.

17. Click OK.

18. Exit NetWare User Tools for Windows.

19. Reboot the workstation.

Automatic Client Update (ACU)

NetWare Automatic Client Update (ACU) allows administrators to
automatically update NetWare Client software.

Automatically Updating NetWare Client
32 for Windows NT

To use ACU, the following must be performed:

❏ Place the NetWare Client 32 installation files and Windows NT
installation *.CAB files in a directory where they can be read during
client login.

❏ Verify that the user has Read and File Scan rights to this directory.

NOTE: ACU for Windows NT will not update NETX or VLM clients.

ACU executes the following instruction from a login script:

@\\servername\volume\…\SETUP.EXE /ACU
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The instruction automatically updates the client workstations during the next
login. Depending upon which login script is modified, the administrator can
allow different clients to update. If the user login script is modified, only that
client will automatically update. If a container login script is modified, all
clients in that container will automatically update. A profile login script can be
used to automatically update selected groups of clients.

When the user at the workstation logs in, ACU checks the client’s files to see if
the system files are newer than the client’s files. If they are, a dialog box is
displayed asking them to “Click Continue to install the newer version, or
Cancel to retain your existing client software.” If the user chooses Continue, the
update starts automatically, and the files are copied to the workstation. If the
user chooses Cancel, the workstation continues to use the older client software.
Each time that the user logs in with the older client software, ACU will attempt
to update the workstation’s client. After the client has been updated, the user
must reboot the workstation in order to use the new client software.

Automatically Updating NetWare Client
32 for Windows 95

To use ACU, the following must be performed:

■ Place the NetWare Client 32 installation files and Windows 95
installation *.CAB files in a directory where they can be read during
client login.

■ Verify that the user has Read and File Scan rights to this directory.

NOTE: ACU for Windows 95 will not update NETX or VLM clients.

ACU executes the following instruction from a login script:

@\\servername\volume\…\SETUP.EXE /ACU

The instruction automatically updates the client workstations during the next
login. Depending upon which login script is modified, the administrator can
allow different clients to update. If the user login script is modified, only that
client will automatically update. If a container login script is modified, all
clients in that container will automatically update. A profile login script can be
used to automatically update selected groups of clients.
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When the user at the workstation logs in, ACU checks the client’s files to see if
the system files are newer than the client’s files. If they are, a dialog box is
displayed asking them to “Click Continue to install the newer version, or
Cancel to retain your existing client software”. If the user chooses Continue, the
update starts automatically, and the files are copied to the workstation. If the
user chooses Cancel, the workstation continues to use the older client software.
Each time that the user logs in with the older client software, ACU will attempt
to update the workstation’s client. After the client has been updated, the user
must reboot the workstation in order to use the new client software.

Automatically Updating NetWare Client
32 for DOS/Windows 3.1x

The following must be performed before using ACU to update client software
on DOS and Windows 3.1x workstations:

1. Choose a login script for the type of workstation to be updated.

2. Install NetWare Client 32 installation files in a directory on a network
server. Users must have Read and File Scan rights to this directory.

3. Copy the ACU utilities and files to the NetWare Client 32 parent
directory. The ACU utilities and files are located in the
SYS:PUBLIC\CLIENT\DOSWIN32\ADMIN\DOS_ACU subdirectory.

4. Create a LOG subdirectory in the NetWare Client 32 parent directory.

5. Review the settings in INSTALL.CFG, located in the NetWare Client 32
parent directory. The InstallType setting located under [Setup] should be
set as follows:

[Setup]

    InstallType=AUTO
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6. Edit your login script and insert the ACU commands. If you placed the
NetWare Client 32  files in SYS:PUBLIC\CLIENT\DOSWIN32
directory on you server, the commands would be:

MAP I:=server/SYS:PUBLIC\CLIENT\DOSWIN32
#I:NWDETECT Novell_Client32 4.1.0
IF ERROR_LEVEL = “1” THEN
    #I:INSTALL
    IF ERROR_LEVEL = “0” THEN
        #I:NWSTAMP Novell_Client32 4.1.0
        #I:NWLOG /F I:\LOG\UPDATE.LOG
        #I:REBOOT
    END
END
MAP DEL I

intraNetWare Online Documentation
CD

The intraNetWare Online Documentation CD contains the prerequisites, setup,
installation, and other pertinent information on the following subjects. You can
use the DynaText viewer to access this information. Refer to Chapter 6 for
additional information on how to install and use the DynaText viewer.

■ NetWare Client 32 Software for DOS and Windows 3.1x

■ NetWare Client 32 Software for Windows 95

■ intraNetWare Client for Windows NT

■ NetWare Application Manager

■ Workstation Manager

■ Automatic Client Update
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NetWare Application Manager (NAM)
NetWare Application Manager (NAM) allows users to run network applications
that have been configured by the network administrator. NAM consists of
Application objects and the NetWare Application Launcher (NAL). The
application’s setup information is stored as an Application object in the
Directory tree. NAL displays icons for all available applications in a window at
the workstation and allows the user to double-click the icon to launch the
application.

NAM eliminates the need for users to have a drive mapping or path to an
application’s directory in order to use the application.

Using NAM to configure NDS and the File
System for NAL

NAM supplies four new objects in the Directory. These objects are Application
objects for Windows NT, Windows 95, Windows 3.x, and DOS applications.

Figure 6-1.   Application Objects

To configure NDS and the file system for NAL, you must complete the
following tasks:

■ Create Application objects.

■ Configure the Application objects.

■ Assign appropriate file system rights to the application’s directory.

■ Configure the user’s workstations.
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Creating Application Objects

You can create Application objects in the same way you create other NDS
objects in NetWare Administrator. Select the container where the Application
object will reside and choose Create from the Object menu. When creating the
Application object, you must provide a name for the object and a path to the
application the object represents.

Configuring the Application Object

Application objects can contain many pages of information. However, the only
information necessary to provide access to a network application is the path to
the application and a list of User objects that are allowed access to the
application.

After creating an Application object, you must associate User objects with the
Application object and provide any special commands that should be executed
when the user launches the application. Figure 6-2 shows the Applications
property page.
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Figure 6-2.   Configuring an Application Object

Application objects have the ability to map network drives and capture printer
ports when the application is launched from the workstation. These drives and
ports are only active as long as the application is running; when the user exits
the application, the mappings and captures are deleted.

Scripts can also be added to the Application object. These scripts run when the
application is launched from NAL. These scripts use the same syntax as login
scripts.

You can also enter a description and names of contacts for the application that
can be viewed by users.
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NAM also adds the Applications and Launcher Configuration property pages to
the Container and User objects in the Directory. The Applications property
page (Figure 6-3) allows you to specify which applications can be launched by
the user (icon appears in the user’s NAL window) and which applications
launch automatically when NAL is launched.

Figure 6-3.   Application Property Page for the Corp Container

The Launcher Configuration property page (Figure 6-4) allows you to
configure how NAL functions on the desktops of Windows workstations.
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Figure 6-4.   Launcher Configuration Page for the Corp Container

! IMPORTANT:  To launch an application with NAL, users need the
appropriate rights to the directory where the network application is
located.

Customizing NAL to Replace the
Windows Interface

No special configuration is needed to run NAL from a workstation. Users can
run NAL from the PUBLIC directory or from a copy of NAL that is stored on
the workstation’s hard disk.

NAL can also be configured to replace the normal Windows interface
(EXPLORER.EXE in Windows 95 or PROGMAN.EXE in Windows 3.x) so that
users only have access to those applications which have been associated with
their User objects.
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To replace the Windows interface with NAL, perform the following:

1. If you are using Windows 95, copy the following files to a directory on
the local hard disk:

a. NALW95.EXE

b. NALRES32.DLL

c. NALBMP32.DLL

d. NAL.HLP

2. If you are using Windows 3.x, copy the following files to a directory on
the local hard disk:

a. NALW31.EXE

b. NALRES.DLL

c. NALBMP.DLL

d. NAL.HLP

3. Edit the SYSTEM.INI file to set NAL as the shell. Find the line in the
[boot] section that starts with SHELL=, as in the following:

SHELL=EXPLORER.EXE

Replace the setting with the location of the NAL files, as in the
following:

SHELL=C:\path\NAL95.EXE

4. Save the changes and restart Windows.
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Launching Network Applications with NAL

Network applications are launched from the NAL window. A user can double-
click the application’s icon to run the application. When the application is
launched, NAL runs any scripts associated with the Application object, checks
the path to the application, and then launches the application.

When the user exits the application, any mappings or other special commands
that were set with the Application object’s script are removed.
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Chapter 7
DynaText

This chapter provides installation procedures for the NetWare online
documentation, DynaText. It also discusses setting up your workstation to view
and start DynaText.

Novell online documentation allows you to electronically store and access
NetWare manuals from your workstation.

The Novell online documentation has two parts:

■ Document Collection – contains the intraNetWare product
documentation in the online documentation set, as shown in Figure 7-1.
The collections are available in several languages.

Figure 7-1. Document Collections

■ DynaText Viewer Software – allows you to read, search, annotate, and
print online documentation from Windows or Macintosh clients.

The online documentation can be accessed three different ways:
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■ From the network – After the DynaText viewer and the document
collection are installed on the server, they are available to all
workstations on the network.

■ From a standalone workstation - After the DynaText viewer and the
document collection are installed on the workstation, they are available
to all users of that workstation.

■ From the product CD-ROM – Install the DynaText viewer on a local
or network hard disk and leave the document collection on the product
CD-ROM. For network access, you can mount the CD-ROM on the
server as an intraNetWare volume. For standalone access, you can set up
the CD-ROM on the workstation.

Before You Begin
You must install DynaText on a computer (the intraNetWare server, client
workstation with local hard disk, or standalone computer) with the following:

■ A minimum of 60 megabytes hard disk space free (for each language) to
have both the viewer and the document collection installed on the
server.

■ If only the viewer files will be installed and the document collection
files will be read directly from CD-ROM, the server needs only 6
megabytes of disk space for the first viewer language. For each
additional viewer language, add 2 megabytes.

■ A CD-ROM drive that can read ISO 9660 formatted CDs.

You can view DynaText from a computer (the client workstation or standalone
computer) with the following:

■ VGA, or Super VGA display card and monitor

■ Minimum of 4 MB of RAM (recommended 8 MB or more)

■ Microsoft Windows 3.x, Windows 95, Windows NT, or OS/2 2.1x
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Installing DynaText
This procedure involves copying the DynaText files and the intraNetWare
document collections from the Compaq SmartStart package or the
intraNetWare package to the hard drive on your server on the SYS volume in
the DOC subdirectory.

Install DynaText by following these steps:

1. Insert the intraNetWare From Compaq No. 2 CD or the online
documentation CD into the CD-ROM drive of the workstation.

2. Login to your server as a user with all rights to the SYS volume.

3. Locate SETUPDOC.EXE on the CD and run it from within Windows.

4. Install the DynaText viewer to your local drive.

a. Click the DynaText viewer Install.

b. Select the source path and click OK.

c. Select the local destination directory and click OK.

d. Select the languages for the DynaText viewer and click OK.

e. To install the viewer, click OK in the confirmation box.

f. To create a viewer icon, click Yes.

g. Click OK when prompted.

5. Install the intraNetWare document collections.

a. Click the Document Collections Install.

b. Select the source path for the documentation and click OK.

c. Specify the destination directory on your own server to which the
document collection will be copied and click OK.

d. Select the document collection you want to use and click OK.

e. Confirm your installation selections and click OK.

The online documentation will be copied to your selected
destination.
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f. Click OK when prompted.

g. Click Continue in the success box.

6. Configure the viewer to access the document collections.

a. Click Configure Viewer.

b. Select the DynaText viewer on your local drive and click
Configure.

c. Click Advanced to configure the shared copies of the document
collections.

d. Click Create.

e. Click Select.

You might get a message about the SYS:volume being almost out of
disk space. The file will still be created.

f. Click Create to create the SYSDOCS.CFG file on your server.

g. Click the SYSDOCS.CFG file you just created and click Select.

h. Select each collection on your server and click the Add arrow, or
double-click each collection.

i. When all the collections are in the upper window, click Save.

j. Click Exit.

k. Click Yes to quit SETUPDOC.EXE.

Now you can set up access to the DynaText Viewer on your Windows
workstation.

Setting Up a Workstation for Viewing
DynaText is an application for the Windows environment. The following
resources are necessary for the NetWare Client workstation from which
DynaText is viewed.

■ Minimum of 4 MB of RAM, 8 MB recommended

■ Microsoft Windows 3.x, Windows 95, Windows NT, or OS/2 2.1x

■ VGA or Super VGA display card and monitor
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■ Access to the network as a NetWare Client

■ Login to the server that has DynaText loaded

To set up a workstation that has a viewer icon created, follow these steps:

1. Ensure the following line is in your AUTOEXEC.BAT file:

SET NWLANGUAGE=<language>
For example: SET NWLANGUAGE=ENGLISH

For language, substitute the name of the language for the book text, for
example, English, Deutsch, Español, or Français. This variable
specifies which set of electronic books will be viewed. The name must
match one of the subdirectories under the following directory path:

❏ From Compaq SmartStart installation: \DOC directory

❏ From intraNetWare installation: \DOC directory

2. Reboot or enter SET NWLANGUAGE=LANGUAGE at the command
line to make the language setting effective.

Start Microsoft Windows, if your workstation is running Windows 3.x.
You are now ready to use DynaText.

Editing Configuration Files
You should edit the configuration files, if your installation meets any of the
following criteria:

■ Documentation files are installed somewhere other than DOC and
DOCVIEW, which are at the root of the same drive or volume.

■ Simultaneous access to multiple languages is required.

■ Multiple collections are installed.

■ Some installed collections are for private viewing only.

The configuration files, SYSDOCS.CFG and DYNATEXT.INI, are text files and
can be edited with any text editor.
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SYSDOCS.CFG

The SYSDOCS.CFG file references the location of public collections. No other
configuration options are specified in SYSDOCS.CFG. This file contains a
section for each platform, which references the location of the documentation
databases. If you have multiple public collections, you need to separate each
collection with a semicolon and no space.

For example, the SYSDOCS.CFG file should reside in the SYS:PUBLIC
directory on the intraNetWare server or the \PUBLIC directory on the CD-
ROM.

DYNATEXT.INI

The DYNATEXT.INI file is the Windows DynaText configuration file. It
references private collections and points to the SYSDOCS.CFG file, which
references public collections. The DYNATEXT.INI file also references the
location of resource files for the viewer and defines viewer presentation
characteristics such as color and window location. This file is
self-documenting; each parameter is explained within the file. Use the
instructions provided for each section to make the modifications.

The DYNATEXT.INI file should reside in the \DOCVIEW\DTAPPWIN
directory. To provide for individual setup, the DYNATEXT.INI file can be
copied to the user’s Windows directory where it will take precedence over
other versions of the file. If a user has a local copy of the DYNATEXT.INI file,
the local copy is used by the viewer instead of the public copy.
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Starting DynaText
After you install DynaText, you can access it from a client workstation running
Windows. To run DynaText, follow these steps:

1. Start Windows. If you are accessing the collection from the network,
login to the appropriate server.

2. Select the DynaText icon on your Windows desktop. Icons for the
available bookshelves appear.

3. Select the icon for the bookshelf containing the book you want to view.
Icons for the books in the bookshelf appear.

4. Select the icon for the book you want to view. The text and the Table of
Contents outline for the book you specified appear.

DynaText also has online help available. Select the Help option from the menu
bar.
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Appendix A  
Examples of Migration Reports

This appendix contains examples of migration reports:

■ Migration Utility Reports

❏ MIG001.RPT - MIGRATION.EXE Migration Report

❏ MP001.RPT - MIGPRINT.EXE Print Migration Report

■ DS Migrate Reports

❏ BINDDISC.LOG

❏ DSCONFIG.LOG

❏ PRECONFIG.LOG

■ RMT Reports

❏ DUMPBIND.SUM ❏ MIGCOUNT.LOG

❏ MIGPRINT.LOG ❏ MIGUSERS.LOG

❏ MIGPASS.LOG ❏ MIGGROUP.LOG

❏ APPLY3X.LOG ❏ TREEWALK.LOG

❏ CONSIST.LOG ❏ DMARKUP.LOG

❏ MIGFILES.LOG ❏ EXTRACT4.LOG

❏ XCLASS.LOG ❏ TOLIVE.LOG

❏ XREFOBJS.LOG ❏ XREFPRNT.LOG

❏ DUMPBIND.LOG ❏ DUPOBJ.LOG
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  MIGRATE.EXE
Each log file is written to the C:\MIGRATE directory on the workstation. NetWare
updates the log file with important information. This file is used to troubleshoot or
determine the status of the migration process. The file also contains a history of
system activity and can be used to track the events that occurred prior to a failure.
See “Viewing the Migration Report” in Chapter 4 for more information on viewing
the migration report.

The migration utility creates a migration report log file named MIGxxx.RPT (where
“xxx” is the number of the report generated). The print migration utility creates a
print migration report log file named MPxxx.RPT (where “xxx” is the number of
the report generated). This appendix contains an example of a migration report log
file, MIG001.RPT, and a print migration report log
file, MP001.RPT.

  MIG001.RPT
NetWare Migration Utility v4.16, Bindery Import Phase

˝

Migration summary:
˝

˝

    Source NetWare server: CTREC, NetWare v3.12 (50 user) (8/12/93)
˝

    Report file name: C:\MIGRATE\MIG000.RPT
˝

    Import phase started: 11-11-97 3:43:38 pm

    Information will be migrated from the following volumes:

        SYS:

    The following will be read from the source NetWare server:

        * Accounting charge rates

        * Trustee assignments

        * Default account restrictions

        * Users

        * User restrictions
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        * Groups

        * Non-Novell bindery objects

    The following will not be read from the source NetWare server:

        * Data files

        * Print queues and print servers

--------------- End of migration summary ---------------

Reading trustee assignments from the source server.

    SYS:PUBLIC

        Trustee : EVERYONE (group), [ R    F ]

        Trustee : NOVCLASS (user), [ R    F ]

        Trustee : APPCLASS (user), [ R    F ]

        Trustee : EVAL (user), [ R    F ]

        Trustee : CLASSROOM (group), [ R    F ]

    SYS:PUBLIC\MCAFEE

        Trustee : GUEST (user), [ RWCEMF ]

    SYS:MAIL

        Trustee : EVERYONE (group), [   C    ]

    SYS:MAIL\1

        Trustee : SUPERVISOR (user), [ RWCEMF ]

    SYS:MAIL\2000001

        Trustee : GUEST (user), [ RWCEMF ]

SYS:MAIL\17000063

        Trustee : CINDY (user), [ RWCEMF ]

SYS:MAIL\2500001F

        Trustee : CAROLE (user), [ RWCEMF ]
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SYS:MAIL\3B0000B0

        Trustee : MIKE_K (user), [ RWCEMF ]

SYS:MAIL\48000089

        Trustee : RON (user), [ RWCEMF ]

SYS:USERS\MIKE_K

        Trustee : MIKE_K (user), [SRWCEMFA]

SYS:USERS\CINDY

        Trustee : CINDY (user), [ RWCEMFA]

SYS:DOC

        Trustee : S&S (group), [ R    F ]

    SYS:DOCVIEW

        Trustee : APPCLASS (user), [ R    F ]

        Trustee : NOVCLASS (user), [ R    F ]

        Trustee : CLASSROOM (group), [ R    F ]

        Trustee : S&S (group), [ R    F ]

Reading accounting charge rates from the source server.

    Accounting activated : No

Reading default account balance and account restrictions from the source

server.

    Account expires : No

    Limit connections : Yes

    Concurrent connections : 2

    Create home directory : Yes

    Require a password : Yes

    Password minimum length : 5

    Force password changes : No

    Require unique passwords : No
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    Account balance : 0

    Allow unlimited credit : Yes

    Time restrictions apply : No

    Detect intruders : Yes

    Incorrect login attempts : 5

    Bad login count retention time : 0 days, 1 hours, 0 minutes

    Lock account after detection : Yes

    Length of account lockout : 0 days, 0 hours, 20 minutes

Reading users from the source server.

    SUPERVISOR

        Security equivalent to : EVERYONE (group)

        Mail directory : SYS:MAIL\1

        Associated file : SYS:MAIL\1\LOGIN

        Associated file : SYS:MAIL\1\LOGIN.OS2

        Console operator : No

        Workgroup manager : No

        Account uses a password : Yes

        Account disabled : No

        Account expires : No

        Limit connections : No

        Allow password changes : Yes

        Require a password : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

    GUEST

        Security equivalent to : EVERYONE (group)

        Mail directory : SYS:MAIL\2000001

        Associated file : SYS:MAIL\2000001\LOGIN

        Associated file : SYS:MAIL\2000001\LOGIN.OS2

        Console operator : No

        Workgroup manager : No

        Account uses a password : No

        Account disabled : No

        Account expires : No
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        Limit connections : No

        Allow password changes : No

        Require a password : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

CINDY

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : CNI (group)

        Security equivalent to : S&S (group)

        Mail directory : SYS:MAIL\17000063

        Associated file : SYS:MAIL\17000063\LOGIN

        Associated file : SYS:MAIL\17000063\LOGIN.OS2

        Console operator : No

        Workgroup manager : No

        Account uses a password : Yes

        Account disabled : No

        Account expires : No

        Limit connections : No

        Allow password changes : Yes

        Require a password : Yes

        Password minimum length : 5

        Force password changes : No

        Require unique passwords : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

CAROLE

        Full name : CAROLE

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Mail directory : SYS:MAIL\2500001F

        Console operator : No

        Workgroup manager : No

        Account uses a password : Yes

        Account disabled : No
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        Account expires : No

        Limit connections : No

        Allow password changes : Yes

        Require a password : Yes

        Password minimum length : 4

        Force password changes : No

        Require unique passwords : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

MIKE_K

        Full name : Mike Kettleson

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : S&S (group)

        Security equivalent to : NOVTEST (group)

        Security equivalent to : CNI (group)

        Mail directory : SYS:MAIL\3B0000B0

        Console operator : No

        Workgroup manager : No

        Account uses a password : Yes

        Account disabled : No

        Account expires : No

        Limit connections : No

        Allow password changes : Yes

        Require a password : Yes

        Password minimum length : 5

        Force password changes : No

        Require unique passwords : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

    RON

        Full name : RON LEDBETTER

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : NOVTEST (group)
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        Security equivalent to : CNI (group)

        Security equivalent to : S&S (group)

        Mail directory : SYS:MAIL\48000089

        Console operator : No

        Workgroup manager : No

        Account uses a password : Yes

        Account disabled : No

        Account expires : No

        Limit connections : No

        Allow password changes : Yes

        Require a password : Yes

        Password minimum length : 5

        Force password changes : No

        Require unique passwords : No

        Time restrictions apply : No

        Non-Novell item property : MY_LT_FILTER

Reading groups from the source server.

    EVERYONE

        Full name : EVERYONE

        Managed by : SS1 (user)

        Managed by : CAROLE (user)

        Managed by : GUEST (user)

        Managed by : S&S (group)

        Group member : SUPERVISOR

        Group member : GUEST

        Group member : CAROLE

        Group member : RON

        Group member : MIKE_K

        Group member : CINDY

        Console operator : No

        Workgroup manager : No

    S&S

        Full name : Service and Support

        Group member : MIKE_K
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        Group member : RON

        Group member : CINDY

        Console operator : No

        Workgroup manager : No

    CNI

        Full name : NetWare Instructors

        Managed by : CINDY (user)

        Managed by : MIKE_K (user)

        Managed by : RON (user)

        Managed by : CAROLE (user)

        Group member : JIM

        Group member : CINDY

        Group member : MIKE_K

        Group member : RON

        Console operator : No

        Workgroup manager : No

Reading non-Novell bindery objects from the source server.

    LT_AUDITOR

        Non-Novell item property : LTA_LAN_FILTER

        Non-Novell item property : SYS_LT_FILTER

        Non-Novell item property : LTA_BIND_FILTER

        Non-Novell item property : LTA_NODE_LIST

        Non-Novell item property : LTA_WARN_MESS

            MIGRATE-4.16-232: An internal error has occurred.  The bindery

                property is too large to read into available memory.

            Property name : LTA_WARN_MESS

        Non-Novell item property : LTAUDITOR_CFG

        Non-Novell item property : LTA_USERS_LIST

        Non-Novell item property : LTA_METER_LIST

    AUDITOR_PARAM

        Non-Novell item property : INSTALL_DATE
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Finished reading information from NetWare server CTREC.

 NetWare Migration Utility v4.16, Bindery Export Phase

Migration summary :

    Destination NetWare server : ECORP411, NetWare 4.11 (August 22, 1996)

    Report file name : C:\MIGRATE\MIG000.RPT

    Export phase started : 11-11-97 2:56:17 pm

    The following table lists volumes selected for migration from the

        source server with their corresponding destination directories on

        the destination server :

        SYS:                 ECORP411\SYS:\

    Random passwords will be generated for users and print servers which

        had a password on the source server.   The new passwords can be

        found in the file SYS:SYSTEM/NEW.PWD on the destination server.

    To setup Directory Services login scripts, login to the Directory and

        run UIMPORT, using UIMPORT.CTL and UIMPORT.DAT (in SYS:SYSTEM on

        the destination server).

    The following will be migrated to the destination NetWare server:

        * Accounting charge rates

        * Trustee assignments

        * Default account restrictions

        * Users

        * User restrictions

        * Groups

        * Non-Novell bindery objects

    The following will not be migrated to the destination NetWare server:



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-11

Migration from NetWare 3 to intraNetWare

        * Data files

        * Print queues and print servers

--------------- End of migration summary ---------------

Writing default account balance and account restrictions to the destination

server.

    Account expires : No

    Limit connections : Yes

    Concurrent connections : 2

    Create home directory : Yes

    Default home directory : ECORP411\SYS:USERS

    Require a password : Yes

    Password minimum length : 5

    Force password changes : No

    Require unique passwords : No

    Account balance : 0

    Allow unlimited credit : Yes

    Time restrictions apply : No

    Bindery update status : Update succeeded

    Detect intruders : Yes

    Incorrect login attempts : 5

    Bad login count retention time : 0 days, 1 hours, 0 minutes

    Lock account after detection : Yes

    Length of account lockout : 0 days, 0 hours, 20 minutes

    Bindery update status : Update succeeded

Writing accounting charge rates to the destination server.

    Accounting activated : No

Creating groups on the destination server.

    EVERYONE

        Creation status : The group has been created.

        Full name : EVERYONE
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        Console operator : No

        Workgroup manager : No

    S&S

        Creation status : The group has been created.

        Full name : Service and Support

        Console operator : No

        Workgroup manager : No

    CNI

        Creation status : The group has been created.

        Full name : NetWare Instructors

        Console operator : No

        Workgroup manager : No

Creating users on the destination server.

    SUPERVISOR

        User's mail directory : ECORP411\SYS:MAIL\1

        Creation status : The user already exists; migrated information

            (except user restrictions) is being merged.

        Console operator : No

        Workgroup manager : No

        Associated file : ECORP411\SYS:MAIL\1\LOGIN

        Special note : The user's name and the location of his/her login

            script have been written to UIMPORT.DAT in SYS:SYSTEM on the

            destination server.  Use UIMPORT to copy the login script to

            Directory Services.

        Associated file : ECORP411\SYS:MAIL\1\LOGIN.OS2

        Non-Novell item property : MY_LT_FILTER

    GUEST

        Creation status : The user has been created.

        User's mail directory : ECORP411\SYS:MAIL\D3010074

        User's home directory : ECORP411\SYS:USERS\GUEST

        Give a random password : No

        Console operator : No
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        Workgroup manager : No

        Associated file : ECORP411\SYS:MAIL\D3010074\LOGIN

        Special note : The user's name and the location of his/her login

            script have been written to UIMPORT.DAT in SYS:SYSTEM on the

            destination server.  Use UIMPORT to copy the login script to

            Directory Services.

        Associated file : ECORP411\SYS:MAIL\D3010074\LOGIN.OS2

        Non-Novell item property : MY_LT_FILTER

    CINDY

        Creation status : The user has been created.

        User's mail directory : ECORP411\SYS:MAIL\1020064

        User's home directory : ECORP411\SYS:USERS\CINDY

        Give a random password : Yes

        Console operator : No

        Workgroup manager : No

        Associated file : ECORP411\SYS:MAIL\1020064\LOGIN

        Special note : The user's name and the location of his/her login

            script have been written to UIMPORT.DAT in SYS:SYSTEM on the

            destination server.  Use UIMPORT to copy the login script to

            Directory Services.

        Associated file : ECORP411\SYS:MAIL\1020064\LOGIN.OS2

        Non-Novell item property : MY_LT_FILTER

    CAROLE

        Creation status : The user has been created.

        User's mail directory : ECORP411\SYS:MAIL\11020016

        User's home directory : ECORP411\SYS:USERS\CAROLE

        Give a random password : Yes

        Full name : CAROLE

        Console operator : No

        Workgroup manager : No

        Non-Novell item property : MY_LT_FILTER

    MIKE_K

        Creation status : The user has been created.

        User's mail directory : ECORP411\SYS:MAIL\1F020013
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        User's home directory : ECORP411\SYS:USERS\MIKE_K

        Give a random password : Yes

        Full name : Mike Kettleson

        Console operator : No

        Workgroup manager : No

        Non-Novell item property : MY_LT_FILTER

    RON

        Creation status : The user has been created.

        User's mail directory : ECORP411\SYS:MAIL\23020008

        User's home directory : ECORP411\SYS:USERS\RON

        Give a random password : Yes

        Full name : RON LEDBETTER

        Console operator : No

        Workgroup manager : No

        Non-Novell item property : MY_LT_FILTER

    Writing user account restrictions to the destination server.

        SUPERVISOR

            This user account existed before the migration took place; the

            user's account restrictions will not be changed.

        GUEST

            Account disabled : No

            Account expires : No

            Limit connections : No

            User can change password : No

            Require a password : No

            Time restrictions apply : No

            Bindery update status : Update succeeded

        CINDY

            Account disabled : No

            Account expires : No

            Limit connections : No

            User can change password : Yes
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            Require a password : Yes

            Password minimum length : 5

            Force password changes : No

            Require unique passwords : No

            Time restrictions apply : No

            Bindery update status : Update succeeded

        CAROLE

            Account disabled : No

            Account expires : No

            Limit connections : No

            User can change password : Yes

            Require a password : Yes

            Password minimum length : 4

            Force password changes : No

            Require unique passwords : No

            Time restrictions apply : No

            Bindery update status : Update succeeded

        MIKE_K

            Account disabled : No

            Account expires : No

            Limit connections : No

            User can change password : Yes

            Require a password : Yes

            Password minimum length : 5

            Force password changes : No

            Require unique passwords : No

            Time restrictions apply : No

            Bindery update status : Update succeeded

        RON

            Account disabled : No

            Account expires : No

            Limit connections : No

            User can change password : Yes

            Require a password : Yes
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            Password minimum length : 5

            Force password changes : No

            Require unique passwords : No

            Time restrictions apply : No

            Bindery update status : Update succeeded

Creating non-Novell bindery objects on the destination server.

    LT_AUDITOR

        Creation status : The bindery object has been created.

        Non-Novell item property : LTA_LAN_FILTER

        Non-Novell item property : SYS_LT_FILTER

        Non-Novell item property : LTA_BIND_FILTER

        Non-Novell item property : LTA_NODE_LIST

        Non-Novell item property : LTAUDITOR_CFG

        Non-Novell item property : LTA_USERS_LIST

        Non-Novell item property : LTA_METER_LIST

    AUDITOR_PARAM

        Creation status : The bindery object has been created.

        Non-Novell item property : INSTALL_DATE

Setting up properties for users on the destination server.

    SUPERVISOR

        Security equivalent to : EVERYONE (group)

    GUEST

        Security equivalent to : EVERYONE (group)

    CINDY

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : CNI (group)

        Security equivalent to : S&S (group)

    CAROLE
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        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

    MIKE_K

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : S&S (group)

        Security equivalent to : NOVTEST (group)

        Security equivalent to : CNI (group)

    RON

        Security equivalent to : EVERYONE (group)

        Security equivalent to : SUPERVISOR (user)

        Security equivalent to : NOVTEST (group)

        Security equivalent to : CNI (group)

        Security equivalent to : S&S (group)

Setting up properties for groups on the destination server.

    EVERYONE

        Managed by : CAROLE (user)

        Managed by : S&S (group)

        Group member : SUPERVISOR (user)

        Group member : GUEST (user)

        Group member : CAROLE (user)

        Group member : RON (user)

        Group member : MIKE_K (user)

        Group member : CINDY (user)

    S&S

        Group member : MIKE_K (user)

        Group member : RON (user)

        Group member : CINDY (user)

    CNI

        Managed by : CINDY (user)

        Managed by : MIKE_K (user)

        Managed by : RON (user)

        Managed by : CAROLE (user)
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        Group member : CINDY (user)

        Group member : MIKE_K (user)

        Group member : RON (user)

Setting up properties for non-Novell bindery objects on the destination

server.

    LT_AUDITOR

        No set properties required changes.

    AUDITOR_PARAM

        No set properties required changes.

Writing random passwords for users.

    CINDY

    CAROLE

    MIKE_K

    RON

Writing trustee assignments to the destination server.

    ECORP411\SYS:\PUBLIC

        Trustee assignment : [ R    F ], EVERYONE (group)

    ECORP411\SYS:\PUBLIC\MCAFEE

            MIGRATE-4.16-004: The program cannot add a trustee to a

                directory.

            Object : GUEST (user)

            Directory path : ECORP411\SYS:\PUBLIC\MCAFEE

        ECORP411\SYS:\MAIL

        Trustee assignment : [   C    ], EVERYONE (group)

    ECORP411\SYS:\MAIL\1

        Path name changed to : SYS:MAIL\1
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        Trustee assignment : [ RWCEMF ], SUPERVISOR (user)

    ECORP411\SYS:\MAIL\2000001

        Path name changed to : SYS:MAIL\D3010074

        Trustee assignment : [ RWCEMF ], GUEST (user)

    ECORP411\SYS:\MAIL\17000063

        Path name changed to : SYS:MAIL\1020064

        Trustee assignment : [ RWCEMF ], CINDY (user)

    ECORP411\SYS:\MAIL\2500001F

        Path name changed to : SYS:MAIL\11020016

        Trustee assignment : [ RWCEMF ], CAROLE (user)

    ECORP411\SYS:\MAIL\3B0000B0

        Path name changed to : SYS:MAIL\1F020013

        Trustee assignment : [ RWCEMF ], MIKE_K (user)

    ECORP411\SYS:\MAIL\48000089

        Path name changed to : SYS:MAIL\23020008

        Trustee assignment : [ RWCEMF ], RON (user)

    ECORP411\SYS:\USERS\MIKE_K

        Trustee assignment : [SRWCEMFA], MIKE_K (user)

    ECORP411\SYS:\USERS\CINDY

        Trustee assignment : [ RWCEMFA], CINDY (user)

    ECORP411\SYS:\DOC

        Trustee assignment : [ R    F ], S&S (group)

    ECORP411\SYS:\DOCVIEW

        Trustee assignment : [ R    F ], S&S (group)

The program has completed writing information to server ECORP411.

A total of 12 errors or warnings were reported during migration.
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  MP001.RPT
NetWare Printing Environment Migration Utility

˝

˝

Source NetWare server : CTREC
˝

Destination NetWare server : ECORP411

Destination context : OU=CNI.O=CTREC

Migrating the printer devices

            MIGPRINT.EXE-4.11-039: Could not read the printer device.

Migrating the printer forms

            MIGPRINT.EXE-4.11-034: The program could not read the source printer

        form.

Migrating print queues

    Q_CTREC

        User : EVERYONE (Group)

            MIGPRINT.EXE-4.11-029: The program could not add an attribute to

            the Directory because it references an object that does not exist

            in the current context.

        Print server : PS_CTREC (Print Server)

            MIGPRINT.EXE-4.11-031: The print server referenced by this

            attribute does not exist in the current context.  Print servers

            are created later in the migration process.

Migrating print servers

    PS_CTREC

         Migrating printers serviced by PS_CTREC

            P_CTREC

                Type : Parallel port

                Starting form : 0

                Buffer size (KB) : 3

                Sampling interval : 5
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                Banner type : Text

                Driver name : NPRINTER

                Default queue : Q_CTREC

                Print server : PS_CTREC

                Object to notify :

                Print queue : Q_CTREC

        Printer to service : P_CTREC (Printer)

        Operator : CINDY (User)

        User : EVERYONE (Group)

            MIGPRINT.EXE-4.11-029: The program could not add an attribute to

            the Directory because it references an object that does not exist

            in the current context.

Migrating print job configurations

        GUEST

        Source configuration exists : No

        Print job configuration updated : No

    CINDY

        Source configuration exists : No

        Print job configuration updated : No

    CAROLE

        Source configuration exists : No

        Print job configuration updated : No

    MIKE_K

        Source configuration exists : No

        Print job configuration updated : No

    RON

        Source configuration exists : No

        Print job configuration updated : No
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  DS Migrate

BINDDISC.LOG
Discover results for file server TAPE_CD are being recorded to:

˝

'Z:\SYSTEM\DSMIGRAT\DATA\OUTPUT\binddisc.log'
˝

˝

The following information will be captured as Organization: Organization
˝

File Server
˝

Volume
˝

NNS Domain
˝

User
˝

Group

System Printer

Print Queue

Print Server

Process started on Tuesday, December 23, 1997 12:27 pm

Capturing default user information.

Captured file server information (FID:0000000033).

Capturing console operators.

Captured console operator: BACKUP_EXEC

1 console operator discovered.

Captured system login script.

Captured system AUTOEXEC file.

Captured volume: SYS

Captured volume: DIMAGE

2 volumes discovered.

0 domains discovered.

0 profiles discovered
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Capturing user: SUPERVISOR

Capturing group memberships:

EVERYONE

1 group membership discovered.

Capturing security equivalences:

EVERYONE

1 security equivalence discovered.

Capturing Trustee Assignments for SUPERVISOR.

SYS:PUBLIC   [ R    F ]

SYS:ARCSERVE.6   [ RWCE F ]

SYS:MAIL/1   [ RWCEMF ]

SYS:SYSTEM/06000003.QDR   [ RW   F ]

4 trustees discovered.

Capturing volume information.

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.

User does not have personal print job definitions.

Merged DOS and OS/2 login scripts.

Captured user: SUPERVISOR

Capturing user: GUEST

Capturing group memberships:

EVERYONE

1 group membership discovered.

Capturing security equivalences:

EVERYONE

1 security equivalence discovered.

Capturing Trustee Assignments for GUEST.

SYS:MAIL/2000001   [ RWCEMF ]

1 trustee discovered.

Capturing volume information.

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.

User does not have personal print job definitions.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-24    Examples of Migration Reports

Merged DOS and OS/2 login scripts.

Captured user: GUEST

Capturing user: SANDY

Capturing group memberships:

EVERYONE  CNI

2 group memberships discovered.

Capturing security equivalences:

EVERYONE  CNI

2 security equivalences discovered.

Capturing Trustee Assignments for SANDY.

SYS:MAIL/900005D   [ RWCEMF ]

SYS:USERS/SANDY   [ RWCEMFA]

2 trustees discovered.

Capturing volume information.

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.

User does not have personal print job definitions.

Merged DOS and OS/2 login scripts.

Captured user: SANDY

Capturing user: MIKE_K

Capturing group memberships:

EVERYONE  CNI  FAX

3 group memberships discovered.

Capturing security equivalences:

EVERYONE  SUPERVISOR  CNI  FAX

4 security equivalences discovered.

Capturing Trustee Assignments for MIKE_K.

SYS:MAIL/A00003E   [ RWCEMF ]

SYS:USERS/MIKE_K   [ RWCEMFA]

2 trustees discovered.

Capturing volume information.

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.
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User does not have personal print job definitions.

Merged DOS and OS/2 login scripts.

Captured user: MIKE_K

Capturing user: CINDY

Capturing security equivalences:

EVERYONE  SUPERVISOR  CNI

3 security equivalences discovered.

Capturing group memberships:

EVERYONE  CNI

2 group memberships discovered.

Capturing Trustee Assignments for CINDY.

SYS:MAIL/1E00002B   [ RWCEMF ]

SYS:USERS/CINDY   [ RWCEMFA]

2 trustees discovered.

Capturing volume information.

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.

User does not have personal print job definitions.

Merged DOS and OS/2 login scripts.

Captured user: CINDY

Capturing user: JOHNC

Capturing group memberships:

EVERYONE

1 group membership discovered.

Capturing security equivalences:

EVERYONE  SUPERVISOR

2 security equivalences discovered.

Capturing Trustee Assignments for JOHNC.

SYS:MAIL/360000C2   [ RWCEMF ]

SYS:USERS/JOHNC   [ RWCEMFA]

DIMAGE:TECHWRIT   [SRWCEMFA]

DIMAGE:COMPAQ   [ RWC MF ]

4 trustees discovered.

Capturing volume information.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-26    Examples of Migration Reports

Captured volume restriction for: SYS

Captured volume restriction for: DIMAGE

2 volume entries discovered.

User does not have personal print job definitions.

Merged DOS and OS/2 login scripts.

Captured user: JOHNC

6 users discovered.

Capturing user workgroup managers.

0 workgroup managers discovered.

Capturing group: EVERYONE

Capturing group memberships:

SUPERVISOR  GUEST  CINDY  SANDY  MIKE_K

JOHNC

6 group memberships discovered.

Capturing Trustee Assignments for EVERYONE.

SYS:PUBLIC   [ R    F ]

SYS:MAIL   [   C    ]

SYS:BKUPEXEC   [ R      ]

SYS:BKUPEXEC/PM   [ RW   F ]

SYS:BKUPEXEC/CATALOGS   [ R    F ]

SYS:BKUPEXEC/DOS_WS   [ R    F ]

SYS:BKUPEXEC/NOTIFY   [ RWC  F ]

SYS:BKUPEXEC/WIN_WS/WIN31   [ R    F ]

SYS:BKUPEXEC/WIN_WS/WIN95/ENG   [ R    F ]

SYS:BKUPEXEC/WIN_WS/WIN95/DEU   [ R    F ]

SYS:BKUPEXEC/WIN_WS/WIN95/FRA   [ R    F ]

11 trustees discovered.

Captured group: EVERYONE

Capturing group: CNI

Capturing group memberships:

CINDY  SANDY  MIKE_K

3 group memberships discovered.

Capturing Trustee Assignments for CNI.

SYS:   [ RWCEMF ]
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1 trustee discovered.

Captured group: CNI

Capturing group: FAX

Capturing group memberships:

MIKE_K

1 group membership discovered.

Capturing Trustee Assignments for FAX.

0 trustees discovered.

Captured group: FAX

3 groups discovered.

Capturing group workgroup managers.

0 workgroup managers discovered.

There are no System Printer Definitions to discover.

Capturing print queue: TECHQ

Capturing queue users:

EVERYONE

Capturing queue operators:

CINDY

Captured print queue: TECHQ

1 print queue discovered.

Capturing print server: TECHW

Capturing print server operators:

CINDY

Capturing print server users:

EVERYONE

Capturing file servers serviced:

TAPE_CD

Capturing printer configurations:

Capturing queues serviced by...

TECHQ

Capturing notification list...
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Unable to get Object ID for  probably because this object doesn't exist anymore.

Relationship to this object not recorded.

Captured TECHP

Capturing print server operators:

CINDY

Capturing queues serviced by...

TECHQ

Capturing notification list...

Unable to get Object ID for  probably because this object doesn't exist anymore.

Relationship to this object not recorded.

Captured print server: TECHW

1 print server discovered.

Process finished successfully on Tuesday, December 23, 1997 12:29 pm.

  DSCONFIG.LOG
------------------------ 12/23/97 12:42:44 PM Configure ------------------------

˝

˝

Configure Options Settings:
˝

˝

Append multi-valued properties.

Do not Create Trustee directories if they do not exist.

Configure passwords.

Create passwords for new objects.

Replace passwords for existing objects.

Begin configure of object O=Organization of type Organization

End configuring object O=Organization.

Begin configure of object OU=TAPE_CD.O=Organization of type Organizational Unit
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End configuring object OU=TAPE_CD.O=Organization.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_DIMAGE does not exist in
Directory Services.

Error - A mandatory attribute for TAPE_CD_DIMAGE Volume does not exist, therefore we can not configure this object.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_SYS does not exist in
Directory Services.

Error - A mandatory attribute for TAPE_CD_SYS Volume does not exist, therefore we can not configure this object.

Begin configure of object CN=CNI.OU=TAPE_CD.O=Organization of type Group

End configuring object CN=CNI.OU=TAPE_CD.O=Organization.

   Write property of type ACL.

Begin configure of object CN=EVERYONE.OU=TAPE_CD.O=Organization of type Group

End configuring object CN=EVERYONE.OU=TAPE_CD.O=Organization.

   Write property of type ACL.

Begin configure of object CN=FAX.OU=TAPE_CD.O=Organization of type Group

End configuring object CN=FAX.OU=TAPE_CD.O=Organization.

   Write property of type ACL.

Begin configure of object CN=TECHW TECHP.OU=TAPE_CD.O=Organization of type Printer

End configuring object CN=TECHW TECHP.OU=TAPE_CD.O=Organization.

   Write property of type ACL.

   Write property of type ACL.

   Write property of type ACL.

   Write property of type ACL.

Begin configure of object CN=TECHW.OU=TAPE_CD.O=Organization of type Print Server

End configuring object CN=TECHW.OU=TAPE_CD.O=Organization.

   Write property of type ACL.

   Write property of type ACL.

   Write property of type ACL.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Queue TECHQ does not exist in Directory
Services.

Error - A mandatory attribute for TECHQ Queue does not exist, therefore we can not configure this object.

Begin configure of object CN=CINDY.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=CINDY.OU=TAPE_CD.O=Organization.
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Begin configure of object CN=GUEST.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=GUEST.OU=TAPE_CD.O=Organization.

Begin configure of object CN=JOHNC.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=JOHNC.OU=TAPE_CD.O=Organization.

Begin configure of object CN=MIKE_K.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=MIKE_K.OU=TAPE_CD.O=Organization.

Begin configure of object CN=SANDY.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=SANDY.OU=TAPE_CD.O=Organization.

Begin configure of object CN=SUPERVISOR.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

End configuring object CN=SUPERVISOR.OU=TAPE_CD.O=Organization.

Begin configure of object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization of type User

   Write property of type Surname.

   Write property of type CN.

End configuring object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_DIMAGE does not exist in
Directory Services.

Error - A mandatory attribute for TAPE_CD_DIMAGE Volume does not exist, therefore we can not configure this object.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_SYS does not exist in
Directory Services.

Error - A mandatory attribute for TAPE_CD_SYS Volume does not exist, therefore we can not configure this object.

Begin discovering object O=Organization.

   Discovering 2 properties type ACL

   Discovering 2 properties type Object Class

   Discovering property of type O

   Discovering property of type Revision

   Discovering trustees for object O=Organization.



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-31

Migration from NetWare 3 to intraNetWare

Complete discovering object O=Organization.

Begin configure of object O=Organization of type Organization

End configuring object O=Organization.

Begin discovering object OU=TAPE_CD.O=Organization.

   Discovering 2 properties type ACL

   Discovering 2 properties type Object Class

   Discovering property of type OU

   Discovering property of type Revision

   Discovering trustees for object OU=TAPE_CD.O=Organization.

Complete discovering object OU=TAPE_CD.O=Organization.

Begin configure of object OU=TAPE_CD.O=Organization of type Organizational Unit

   Write property of type Login Script.

   Write property of type Lockout After Detection.

   Write property of type Detect Intruder.

End configuring object OU=TAPE_CD.O=Organization.

Begin discovering object CN=CNI.OU=TAPE_CD.O=Organization.

   Discovering property of type ACL

   Discovering property of type CN

   Discovering 2 properties type Object Class

   Discovering property of type Revision

   Discovering trustees for object CN=CNI.OU=TAPE_CD.O=Organization.

Complete discovering object CN=CNI.OU=TAPE_CD.O=Organization.

Begin configure of object CN=CNI.OU=TAPE_CD.O=Organization of type Group

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

End configuring object CN=CNI.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=EVERYONE.OU=TAPE_CD.O=Organization.

   Discovering property of type ACL

   Discovering property of type CN
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   Discovering 2 properties type Object Class

   Discovering property of type Revision

   Discovering trustees for object CN=EVERYONE.OU=TAPE_CD.O=Organization.

Complete discovering object CN=EVERYONE.OU=TAPE_CD.O=Organization.

Begin configure of object CN=EVERYONE.OU=TAPE_CD.O=Organization of type Group

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

End configuring object CN=EVERYONE.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.
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   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=FAX.OU=TAPE_CD.O=Organization.

   Discovering property of type ACL

   Discovering property of type CN

   Discovering 2 properties type Object Class

   Discovering property of type Revision

   Discovering trustees for object CN=FAX.OU=TAPE_CD.O=Organization.

Complete discovering object CN=FAX.OU=TAPE_CD.O=Organization.

Begin configure of object CN=FAX.OU=TAPE_CD.O=Organization of type Group

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

   Write property of type Member.

End configuring object CN=FAX.OU=TAPE_CD.O=Organization.

*********************************************************************

Error - Server CN=TAPE_CD.OU=TAPE_CD.O=Organization

does not exist in Directory Services.  You must create it

in Directory Services before the application can configure

this server.

*********************************************************************

Begin discovering object CN=TECHW TECHP.OU=TAPE_CD.O=Organization.

   Discovering 4 properties type ACL

   Discovering property of type CN

   Discovering 3 properties type Object Class

   Discovering property of type Revision

Complete discovering object CN=TECHW TECHP.OU=TAPE_CD.O=Organization.
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Begin configure of object CN=TECHW TECHP.OU=TAPE_CD.O=Organization of type Printer

   Warning - CN=TECHQ.OU=TAPE_CD.O=Organization does not exist in Directory Services, cannot create directory Queue attribute.

   Write property of type Print Server.

   Write property of type Printer Configuration.

   Write property of type Operator.

   Warning - CN=TECHQ.OU=TAPE_CD.O=Organization does not exist in Directory Services, cannot create directory Default Queue
attribute.

   Write property of type Owner.

End configuring object CN=TECHW TECHP.OU=TAPE_CD.O=Organization.

Begin discovering object CN=TECHW.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering property of type Host Device

   Discovering 3 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Revision

Complete discovering object CN=TECHW.OU=TAPE_CD.O=Organization.

Begin configure of object CN=TECHW.OU=TAPE_CD.O=Organization of type Print Server

   Write property of type SAP Name.

   Write property of type Printer.

   Write property of type Operator.

   Write property of type User.

End configuring object CN=TECHW.OU=TAPE_CD.O=Organization.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Queue TECHQ does not exist in Directory
Services.

Error - A mandatory attribute for TECHQ Queue does not exist, therefore we can not configure this object.

Begin discovering object CN=CINDY.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering 2 properties type Group Membership

   Discovering property of type Revision
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   Discovering trustees for object CN=CINDY.OU=TAPE_CD.O=Organization.

Complete discovering object CN=CINDY.OU=TAPE_CD.O=Organization.

Begin configure of object CN=CINDY.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

End configuring object CN=CINDY.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=GUEST.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering property of type Group Membership

   Discovering property of type Revision

   Discovering trustees for object CN=GUEST.OU=TAPE_CD.O=Organization.

Complete discovering object CN=GUEST.OU=TAPE_CD.O=Organization.

Begin configure of object CN=GUEST.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Password Unique Required.
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   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

End configuring object CN=GUEST.OU=TAPE_CD.O=Organization.

Begin discovering object CN=JOHNC.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering property of type Group Membership

   Discovering property of type Revision

   Discovering trustees for object CN=JOHNC.OU=TAPE_CD.O=Organization.

Complete discovering object CN=JOHNC.OU=TAPE_CD.O=Organization.

Begin configure of object CN=JOHNC.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.
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   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

End configuring object CN=JOHNC.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=MIKE_K.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering 3 properties type Group Membership

   Discovering property of type Revision

   Discovering trustees for object CN=MIKE_K.OU=TAPE_CD.O=Organization.

Complete discovering object CN=MIKE_K.OU=TAPE_CD.O=Organization.

Begin configure of object CN=MIKE_K.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.
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   Write property of type Account Balance.

End configuring object CN=MIKE_K.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=SANDY.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering 2 properties type Group Membership

   Discovering property of type Revision

   Discovering trustees for object CN=SANDY.OU=TAPE_CD.O=Organization.

Complete discovering object CN=SANDY.OU=TAPE_CD.O=Organization.

Begin configure of object CN=SANDY.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Security Equals.

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

End configuring object CN=SANDY.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=SUPERVISOR.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering property of type CN
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   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering property of type Group Membership

   Discovering property of type Revision

   Discovering trustees for object CN=SUPERVISOR.OU=TAPE_CD.O=Organization.

Complete discovering object CN=SUPERVISOR.OU=TAPE_CD.O=Organization.

Begin configure of object CN=SUPERVISOR.OU=TAPE_CD.O=Organization of type User

   Write property of type Security Equals.

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Script.

   Write property of type Login Intruder Attempts.

   Write property of type Login Intruder Address.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

End configuring object CN=SUPERVISOR.OU=TAPE_CD.O=Organization.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

   Trustee points to a bindery server.  An NDS object can not have a trustee to a bindery server.

Begin discovering object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization.

   Discovering 6 properties type ACL

   Discovering 2 properties type CN

   Discovering 4 properties type Object Class

   Discovering property of type Public Key

   Discovering property of type Surname

   Discovering property of type Revision

   Discovering trustees for object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization.

Complete discovering object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization.
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Begin configure of object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization of type User

   Write property of type Password Unique Required.

   Write property of type Password Required.

   Write property of type Password Allow Change.

   Write property of type Minimum Account Balance.

   Write property of type Login Intruder Attempts.

   Write property of type Login Grace Remaining.

   Write property of type Login Grace Limit.

   Write property of type Login Disabled.

   Write property of type Login Allowed Time Map.

   Write property of type Locked By Intruder.

   Write property of type Language.

   Write property of type Allow Unlimited Credit.

   Write property of type Account Balance.

   Write property of type Full Name.

End configuring object CN=USER_TEMPLATE.OU=TAPE_CD.O=Organization.

Password Configure Summary

Object Name Password Status

CN=TECHW.OU=TAPE_CD.O=Organization (None) (New)

CN=CINDY.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=GUEST.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=JOHNC.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=MIKE_K.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=SANDY.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=SUPERVISOR.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=TERESA.OU=TAPE_CD.O=Organization DEFAULTPW (New)

CN=USER_TEMPLATE.OU=TAPE_CD.O=Organiza
tion

DEFAULTPW (New)

Number of Warnings found 2.
˝

Number of Errors found 13.
˝

---------------------- 12/23/97 12:44:53 PM End Configure ----------------------
˝
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  PRECONFIG.LOG
------------------- 12/23/97 12:40:45 PM Preconfigure Verify -------------------

˝

˝

*********************************************************************

Error - Server CN=TAPE_CD.OU=TAPE_CD.O=Organization

does not exist in Directory Services.  You must create it

in Directory Services before the application can configure

this server.

*********************************************************************

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_DIMAGE does not exist in
Directory Services.

Error - The Host Server CN=TAPE_CD.OU=TAPE_CD.O=Organization associated with Volume TAPE_CD_SYS does not exist in
Directory Services.

Number of Warnings found 0.

Number of Errors found 3.

----------------- 12/23/97 12:40:59 PM End Preconfigure Verify -----------------

RMT Reports

DUMPBIND.SUM
Summary File        Time: 11:05:38     Date: 19 Nov 1997

------------

TAPE_CD

   Users:         20

   Groups:        3

   Print Queues:  1

   Print Servers: 1

   Servers:       1

   Volumes:       2

   Total:         28

   Elapsed Time:  00:00:14
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Total Number of Objects Read: 28

Total Time in Seconds        = 14.170000 seconds

Number of Seconds per Object = 0.506071429

MIGCONT.LOG
>>>

˝

>>>  Start: MIGCONT.LOG
˝

>>>   Date: Wednesday, 19 Nov 1997
˝

>>>   Time: 1:16pm
˝

>>>
˝

>>>   NOTE: To verify this log search for 'ERROR', 'SYNTAX' and '*** Note'.

>>>

Searching for container class COUNTRY

Searching for COUNTRY containers at level [Root]

Searching for container class ORGANIZATION

Searching for ORGANIZATION containers at level [Root]

Skipping TRASH_CAN record 1 (0.660000)

  Object Name    = O=TRASH_CAN

  Object Context = [Root]

Searching for container class LOCALITY

Searching for LOCALITY containers at level [Root]

Searching for container class ORGANIZATIONAL_UNIT

Searching for ORGANIZATIONAL_UNIT containers at level [Root]

Searching for container class COUNTRY

Searching for COUNTRY containers at level O=EMA

Searching for COUNTRY containers at level O=CTREC

Searching for COUNTRY containers at level O=TRASH_CAN

Searching for container class ORGANIZATION

Searching for ORGANIZATION containers at level O=EMA

Searching for ORGANIZATION containers at level O=CTREC

Searching for ORGANIZATION containers at level O=TRASH_CAN

Searching for container class LOCALITY
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Searching for LOCALITY containers at level O=EMA

Searching for LOCALITY containers at level O=CTREC

Searching for LOCALITY containers at level O=TRASH_CAN

Searching for container class ORGANIZATIONAL_UNIT

Searching for ORGANIZATIONAL_UNIT containers at level O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level O=CTREC

Searching for ORGANIZATIONAL_UNIT containers at level O=TRASH_CAN

Skipping TRASH_CAN record 2 (3.030000)

  Object Name    = OU=TAPE_CD

  Object Context = O=TRASH_CAN

Searching for container class COUNTRY

Searching for container class ORGANIZATION

Searching for container class LOCALITY

Searching for LOCALITY containers at level OU=Corp.O=EMA

Searching for LOCALITY containers at level OU=Prod.O=EMA

Searching for LOCALITY containers at level OU=Lon.O=EMA

Searching for LOCALITY containers at level OU=Par.O=EMA

Searching for LOCALITY containers at level OU=Sao.O=EMA

Searching for LOCALITY containers at level OU=Tok.O=EMA

Searching for LOCALITY containers at level OU=Syd.O=EMA

Searching for LOCALITY containers at level OU=New.O=EMA

Searching for LOCALITY containers at level OU=CNI.O=CTREC

Searching for LOCALITY containers at level OU=TAPE_CD.O=TRASH_CAN

Searching for container class ORGANIZATIONAL_UNIT

Searching for ORGANIZATIONAL_UNIT containers at level OU=Corp.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Prod.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Lon.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Par.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Sao.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Tok.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=Syd.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=New.O=EMA

Searching for ORGANIZATIONAL_UNIT containers at level OU=CNI.O=CTREC

Searching for ORGANIZATIONAL_UNIT containers at level OU=TAPE_CD.O=TRASH_CAN

>>>

>>>    End: MIGCONT.LOG

>>>   Date: Wednesday, 19 Nov 1997
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>>>   Time: 1:16pm

>>>

>>> Elapsed Time = 5.610000

MIGPRINT.LOG
>>>

˝

>>>  Start:  MIGPRINT.LOG
˝

>>>   Date: Wednesday, 19 Nov 1997
˝

>>>   Time: 1:16pm
˝

>>>
˝

      NOTE: To verify this log search for 'ERROR', 'SYNTAX' and '*** Note'.
˝

˝

      DESCRIPTION OF RETURN CODES
˝

˝

      -606 Entry Already Exists.  The Toolkit attempted to create an object that

           already exists in the current context.  This object may exist under a

           different class.  NDS does not allow duplicate object names, even

           if they are of different object class types, in the same context.

Adding record ( PRINT_QUEUE ) 1 to NDS.....(0.990000)

  Object Name    = TECHQ

  Object Context = OU=Corp.O=EMA

  Class          = C_QUEUE

  HostServer     = CN=ECORP411.OU=Corp.O=EMA

  QueueDirectory = SYS:/QUEUES

    ERROR ADDING OBJECT TO NDS: TECHQ to OU=Corp.O=EMA (-606  ERR_ENTRY_ALREADY_EXISTS ).

Adding record ( PRINT_SERVER ) 1 to NDS.....(1.640000)

  Object Name    = TECHW

  Object Context = OU=Corp.O=EMA

    ERROR ADDING OBJECT TO NDS: TECHW to OU=Corp.O=EMA (-606  ERR_ENTRY_ALREADY_EXISTS ).
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Adding record ( PRINTER ) 1 to NDS.....(2.080000)

  Object Name    = TAPE_CD_TECHW_000_TECHP

  Object Context = OU=Corp.O=EMA

    Setting Attribute: A_NOTIFY = 0

    Setting Attribute: A_OWNER = 0

>>>

>>>    End:  MIGPRINT.LOG

>>>

>>>   Date: Wednesday, 19 Nov 1997

>>>   Time: 1:16pm

>>>

>>>   Elapsed Time = 2.790000

MIGUSERS.LOG
>>>

˝

>>>  Start: MIGUSERS.LOG
˝

>>>   Date: Wednesday, 19 Nov 1997
˝

>>>   Time: 1:12pm
˝

˝

      NOTE: To verify this log search for 'ERROR', 'SYNTAX' and '*** Note'.

      DESCRIPTION OF RETURN CODES

      -606 Entry Already Exists.  The Toolkit attempted to create an object that

           already exists in the current context.  This object may exist under a

           different class.  NDS does not allow duplicate object names, even

           if they are of different object class types, in the same context.

Adding record 1 to NDS.....(2.040000)

  Object Name    = MIKE_K

  Object Context = OU=Corp.O=EMA

  Object Status   = Object already exists ...

    ERROR ADDING OBJECT: MIKE_K to OU=Corp.O=EMA
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                   CODE: -606 -  ERR_ENTRY_ALREADY_EXISTS

Skipping TRASH_CAN record 2 (1.810000)

  Object Name    = APPCLASS

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Skipping TRASH_CAN record 3 (3.190000)

  Object Name    = GUEST

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Skipping TRASH_CAN record 4 (3.580000)

  Object Name    = NOVCLASS

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Skipping TRASH_CAN record 5 (4.020000)

  Object Name    = CINDY

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Skipping TRASH_CAN record 6 (4.400000)

  Object Name    = GORDON

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Begining cleanup of password migration containers under: .OU=~BINDERY~.OU=CORP.O=EMA

    Searching .OU=TAPE_CD.OU=~BINDERY~.OU=CORP.O=EMA for user objects.

        Removing: .OU=TAPE_CD.OU=~BINDERY~.OU=CORP.O=EMA from NDS.

    Removing: .OU=~BINDERY~.OU=CORP.O=EMA from NDS.

Update NDS objects.....

>>>

>>>   End: MIGUSERS.LOG

>>>  Date: Wednesday, 19 Nov 1997

>>>  Time: 1:13pm

>>>

>>> Elapsed Time = 4.950000
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MIGPASS.LOG
>>>

˝

>>>  Start: MIGPASS.LOG
˝

>>>   Date: Wednesday, 19 Nov 1997
˝

>>>   Time: 1:10pm

˝

      NOTE: To verify this log search for 'ERROR', 'SYNTAX' and '*** Note'.

41 Bindery was closed for = 0.060000

Delete OK: CN=Techw Type 7 On Ecorp411.OU=Corp.O=EMA

Delete OK: Bindery Type=8+CN=Aq6 Chey Type 8 On Ecorp411.OU=Corp.O=EMA

Delete OK: Bindery Type=1959+CN=Tape Cd Type 7a7 On Ecorp411.OU=Corp.O=EMA

Delete OK: Bindery Type=1960+CN=Backup Exec Type 7a8 On Ecorp411.OU=Corp.O=EMA

Delete OK: Bindery Type=9+CN=As Backup Server Type 9 On Ecorp411.OU=Corp.O=EMA

>>>

>>>   End: MIGPASS.LOG

>>>  Date: Wednesday, 19 Nov 1997

>>>  Time: 1:12pm

>>>

>>> Elapsed Time = 108.750000

MIGGROUP.LOG
>>>

˝

>>>  Start: MIGGROUP.LOG
˝

>>>   Date: Wednesday, 19 Nov 1997
˝

>>>   Time: 1:13pm
˝

>>>
˝

˝

      NOTE: To verify this log search for 'ERROR', 'SYNTAX' and '*** Note'.
˝

˝
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      DESCRIPTION OF RETURN CODES

      -606 Entry Already Exists.  The Toolkit attempted to create an object that

           already exists in the current context.  This object may exist under a

           different class.  NDS does not allow duplicate object names, even

           if they are of different object class types, in the same context.

Skipping TRASH_CAN record 1 (0.710000)

  Object Name    = EVERYONE

  Object Context = OU=TAPE_CD.O=TRASH_CAN

Skipping TRASH_CAN record 2 (0.880000)

  Object Name    = CNI

  Object Context = OU=TAPE_CD.O=TRASH_CAN

>>>

>>>    End: MIGGROUP.LOG

>>>   Date: Wednesday, 19 Nov 1997

>>>   Time: 1:13pm

>>>

>>> Elapsed Time = 1.320000

APPLY3X.LOG
>>>

˝

>>> Start: APPLY3X.LOG
˝

>>>
˝

Setting up to apply server TAPE_CD
˝

Adding record 3 to 4X database.....(2.260000)

   Object Name    = SANDY

   Object Class   = USER

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 5 to 4X database.....(3.470000)

   Object Name    = EVERYONE

   Object Class   = GROUP

   Object Context = OU=Corp.O=EMA.[Root]
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Adding record 6 to 4X database.....(3.020000)

   Object Name    = MIKE_K

   Object Class   = USER

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 7 to 4X database.....(4.680000)

   Object Name    = TECHW

   Object Class   = PRINT_SERVER

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 8 to 4X database.....(3.960000)

   Object Name    = GUEST

   Object Class   = USER

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 9 to 4X database.....(6.430000)

   Object Name    = CINDY

   Object Class   = USER

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 10 to 4X database.....(7.530000)

   Object Name    = CNI

   Object Class   = GROUP

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 12 to 4X database.....(7.960000)

   Object Name    = TECHQ

   Object Class   = PRINT_QUEUE

   Object Context = OU=Corp.O=EMA.[Root]

Adding record 13 to 4X database.....(9.840000)

   Object Name    = JOHNC

   Object Class   = USER

   Object Context = OU=Corp.O=EMA.[Root]

Applied 13 records for server TAPE_CD

Applied a total of 9 3X records to the 4XDB.....

Adding PRINTER record 1 to 4X database.....(19.350000)

   Object Name    = TAPE_CD_TECHW_000_TECHP

   Object Context = OU=Corp.O=EMA.[Root]

>>>

>>>   End: APPLY3X.LOG

>>>

>>> Elapsed Time = 19.730000
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TREEWALK.LOG
>>>

˝

>>> Start: Discover Live NDS Tree. 4X DB= EMA_TREE2
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 11:23am
˝

>>>
˝

>>>
˝

˝

SEARCH FOR CONTAINERS AT CONTEXT: [ROOT]
˝

˝

VERIFYING CONFIGURATION FOR EXCLUDED CONTAINERS

    NO EXCLUSIONS WERE DETECTED.

    SEARCHING FOR LOCALITY CONTAINERS.

    SEARCHING FOR COUNTRY CONTAINERS.

    SEARCHING FOR ORGANIZATION CONTAINERS.

        FOUND 2 CONTAINER(S).

    SEARCHING FOR ORGANIZATIONAL_UNIT CONTAINERS.

    ==> O=EMA

    ==> O=CTREC

    F10 WAS PRESSED. EXTRACTION WILL BEGIN FROM: [ROOT]

>>>

>>>  End : Discover Live NDS Tree

>>>  Time: 11:23am

>>>

CONSIST.LOG
>>>

˝
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>>> Start:
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 12:55pm
˝

>>>

>>>

     ***************************************

              RMT CONSISTENCY CHECK

       START: Date: Wednesday, 19 Nov 1997

              Time: 12:55pm

     ***************************************

Version: 1.55b (18 Aug 1997 10:17am)

RMT NLM Versions:

In RMT directory Loaded in memory

--------------------------------------------------------------------

RXMTKERN 1.53.1(a) December 16 /96 1.53.1(a) December 16 /96

RXMTSNUT 1.52.2(b) September 12 /96 1.52.2(b) September 12 /96

RXMTNDS 1.53.1(a) November 27 /96 1.53.1(a) November 27 /96

RXMTARC 1.53.4(d) January 7 /97 1.53.4(d) January 7 /97

RXMTKIT 1.50.1(a) March 22 /96 1.50.1(a) March 22 /96

Loaded in memory

----------------------------------------------

CLIB 4.11.0() August 23 /96

DS 5.73.0() July 29 /96

DSAPI 5.00.2(b) July 1 /96

BTRIEVE 6.10.6(f) May 3 /96

MATHLIB 4.20.0() October 6 /95

NWSNUT 4.16.0() July 1 /96

OS2 Unavailable

MAC Unavailable

NFS Unavailable
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Server information

==================

Server Name: ECORP411

Netware Version: 4

NetWare Sub Version: 11

Max Connections Supported: 9

Connections In Use: 1

Max Volumes Supported: 64

Revision Level: 0

SFT Level: 2

TTS Level: 1

Peak Connections Used: 1

Accounting Version: 1

VAP Version: 1

Print Server Version: 0

Virtual Console Version: 1

Security RestrictionLevel: 1

CLib Major Version: 4

CLib Minor Version: 11

Clib Revision: 0

Login successful

     User id:   .cindy.cni.ctrec

     password:  _______________

File server #1

  Server DS Name = .CN=ECORP411.OU=Corp.O=EMA.[Root]

  Server Name = ECORP411

  Associated 3.x Server = 1

TAPE_CD

  Time Zone = -6

  Supervisor = .CN=Admin.O=EMA

  Origin = NDS

  Can Authenticate = Yes

  Number of volume = 2

Volume #1
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  Volume DS Name = .CN=ECorp_SYS.OU=Corp.O=EMA.[Root]

  Volume Name = SYS:

  Associated 3.x Volume = 1

TAPE_CD/SYS:

  Host Server = CN=ECORP411.OU=Corp.O=EMA

  Origin = NDS

  Is Mounted = Yes

Volume #2

  Volume DS Name = .CN=ECorp_Vol1.OU=Corp.O=EMA.[Root]

  Volume Name = VOL1:

  Associated 3.x Volume = 0

  Host Server = CN=ECORP411.OU=Corp.O=EMA

  Origin = NDS

  Is Mounted = Yes

>>> Total number of server(s)                      : 1

>>> Total number of volume(s)                      : 2

>>> Total Time                                     : 00:00:36

>>>

>>>  End :

>>>  Time: 12:55pm

>>>

DMARKUP.LOG
>>>

˝

>>> Start: Process Marked-Up DUPOBJ.LOG File
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 12:49pm
˝

>>>
˝

>>>
˝
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>>>
˝

>>>  NOTE: To verify this log, search for 'LINE'.

>>>

>>>  Database     : EMA_TREE2

    <Operation canceled by the user>

MIGFILES.LOG

˝

     ***************************************
˝

          MIGRATE FILES AND DIRECTORIES
˝

˝

       START: Date: Wednesday, 19 Nov 1997
˝

              Time: 1:36pm

     ***************************************

Summary of volume(s)/directorie(s) selected for migration:

     TAPE_CD/SYS:/USERS

Verifying Destination Volumes

        Destination Volume ECORP411/SYS:/ is available

All volumes available

    Migfiles detected a value in the MergedTo Field.

    Object   : GUEST (USER)

    Merged To: .CN=Guest.OU=Corp.O=EMA

    Owners, Attributes, and Trustees will be applied to the Merged object

    Migfiles detected a value in the MergedTo Field.

    Object   : CINDY (USER)

    Merged To: .CN=Cindy.OU=Corp.O=EMA
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    Owners, Attributes, and Trustees will be applied to the Merged object

    Migfiles detected a value in the MergedTo Field.

    Object   : EVERYONE (GROUP)

    Merged To: .CN=Everyone.OU=Corp.O=EMA

    Owners, Attributes, and Trustees will be applied to the Merged object

    Migfiles detected a value in the MergedTo Field.

    Object   : CNI (GROUP)

    Merged To: .CN=Cni.OU=Corp.O=EMA

    Owners, Attributes, and Trustees will be applied to the Merged object

    1. Processing Directory : TAPE_CD/SYS:/USERS

        Created directory ECORP411/SYS:/USERS on SYS

        Listing files on TAPE_CD/SYS:/USERS/*.*

              0 files and     12 directories found.

       Processing Directory: TAPE_CD/SYS:/USERS complete.

    2. Processing Directory : TAPE_CD/SYS:/USERS/CINDY

        Created directory ECORP411/SYS:/USERS/CINDY on SYS

        >>> Trustee Rights for ID: 503316523 applied Successfully

        Source Path: TAPE_CD/SYS:/USERS/CINDY

        Destination Path: ECORP411/SYS:/USERS/CINDY

        Rights: 251

        Listing files on TAPE_CD/SYS:/USERS/CINDY/*.*

              0 files and      0 directories found.

        No Files found in Directory TAPE_CD/SYS:/USERS/CINDY

       Processing Directory: TAPE_CD/SYS:/USERS/CINDY complete.

    3. Processing Directory : TAPE_CD/SYS:/USERS/JOHNC

        Created directory ECORP411/SYS:/USERS/JOHNC on SYS
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        >>> Trustee Rights for ID: 905969858 applied Successfully

        Source Path: TAPE_CD/SYS:/USERS/JOHNC

        Destination Path: ECORP411/SYS:/USERS/JOHNC

        Rights: 251

        Listing files on TAPE_CD/SYS:/USERS/JOHNC/*.*

              0 files and      0 directories found.

        No Files found in Directory TAPE_CD/SYS:/USERS/JOHNC

       Processing Directory: TAPE_CD/SYS:/USERS/JOHNC complete.

    4. Processing Directory : TAPE_CD/SYS:/USERS/MIKE_K

        Created directory ECORP411/SYS:/USERS/MIKE_K on SYS

        >>> Trustee Rights for ID: 167772222 applied Successfully

        Source Path: TAPE_CD/SYS:/USERS/MIKE_K

        Destination Path: ECORP411/SYS:/USERS/MIKE_K

        Rights: 251

        Listing files on TAPE_CD/SYS:/USERS/MIKE_K/*.*

              0 files and      0 directories found.

        No Files found in Directory TAPE_CD/SYS:/USERS/MIKE_K

       Processing Directory: TAPE_CD/SYS:/USERS/MIKE_K complete.

    5. Processing Directory : TAPE_CD/SYS:/USERS/RON

        Created directory ECORP411/SYS:/USERS/RON on SYS

        Listing files on TAPE_CD/SYS:/USERS/RON/*.*

              2 files and      2 directories found.

       Processing Directory: TAPE_CD/SYS:/USERS/RON complete.

    6. Processing Directory : TAPE_CD/SYS:/USERS/RON/312PT8

        Created directory ECORP411/SYS:/USERS/RON/312PT8 on SYS

        Listing files on TAPE_CD/SYS:/USERS/RON/312PT8/*.*

              4 files and      1 directories found.

       Processing Directory: TAPE_CD/SYS:/USERS/RON/312PT8 complete.
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    7. Processing Directory : TAPE_CD/SYS:/USERS/SANDY

        Created directory ECORP411/SYS:/USERS/SANDY on SYS

        >>> Trustee Rights for ID: 150995037 applied Successfully

        Source Path: TAPE_CD/SYS:/USERS/SANDY

        Destination Path: ECORP411/SYS:/USERS/SANDY

        Rights: 251

        Listing files on TAPE_CD/SYS:/USERS/SANDY/*.*

              0 files and      0 directories found.

        No Files found in Directory TAPE_CD/SYS:/USERS/SANDY

       Processing Directory: TAPE_CD/SYS:/USERS/SANDY complete.

    *** End of File/Directory Processing ***

    DIRDB.001 closed successfully

    DIRDB.001 deleted successfully

>>> Total number of directories migrated : 7

>>> Total number of files migrated : 6

: ----------

>>> Total number of directories and files : 13

>>> Total Time : 00:00:30

>>> Total bytes migrated : 2284810

>>> Number of seconds per Dir/File : 0.24983871

>>> Bytes/Sec : 73751.1298

>>> LogoutFromFileServer ECORP411 Rc = 0

>>> LogoutFromFileServer TAPE_CD Rc = 0

>>> NWDS Logout from     EMA_TREE2 Rc = 0

     ***************************************

          MIGRATE FILES AND DIRECTORIES

       END: Date: Wednesday, 19 Nov 1997
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            Time: 1:37pm

     ***************************************

EXTRACT4.LOG
>>>

˝

>>> Start: Extract Live NDS Tree EMA_TREE2
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 11:23am
˝

>>>
˝

>>>
˝

RECORD # 1
˝

       NAME : PAIGE
˝

       CONTEXT : OU=CORP.O=EMA.[ROOT]
˝

       CLASS : USER
˝

˝

RECORD # 2

       NAME : CINDY

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : USER

RECORD # 3

       NAME : ADMIN

       CONTEXT : OU=SYD.O=EMA.[ROOT]

       CLASS : USER

RECORD # 4

       NAME : CINDY

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER
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RECORD # 5

       NAME : SANDY

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER

RECORD # 6

       NAME : RON

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER

RECORD # 7

       NAME : MIKE_K

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER

RECORD # 8

       NAME : CAROLE

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER

RECORD # 9

       NAME : JIM

       CONTEXT : OU=CNI.O=CTREC.[ROOT]

       CLASS : USER

RECORD # 10

       NAME : STUDENTS

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 11

       NAME : WPUSERS

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 12

       NAME : MRKTG
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       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 13

       NAME : ACCTG

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 14

       NAME : EMAILUSERS

       CONTEXT : OU=CORP.O=EMA.[ROOT]

RECORD # 16

       NAME : EVERYONE

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 17

       NAME : CNI

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : GROUP

RECORD # 18

       NAME : CORP_P

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : PRINTER

RECORD # 19

       NAME : PROD_P

       CONTEXT : OU=PROD.O=EMA.[ROOT]

       CLASS : PRINTER

RECORD # 20

       NAME : CORP_PS

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : PRINT_SERVER
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RECORD # 21

       NAME : CORP_Q

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : PRINT_QUEUE

RECORD # 22

       NAME : ECORP411

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : FILE_SERVER

RECORD # 23

       NAME : ECORP_SYS

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : VOLUME

RECORD # 24

       NAME : ECORP_VOL1

       CONTEXT : OU=CORP.O=EMA.[ROOT]

       CLASS : VOLUME

RECORD # 25

       NAME : O=EMA

       CONTEXT : [ROOT]

       CLASS : ORGANIZATION

RECORD # 26

       NAME : O=CTREC

       CONTEXT : [ROOT]

       CLASS : ORGANIZATION

RECORD # 27

       NAME : OU=CORP

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 28

       NAME : OU=PROD



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-62    Examples of Migration Reports

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 29

       NAME : OU=LON

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 30

       NAME : OU=PAR

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 31

       NAME : OU=SAO

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 32

       NAME : OU=TOK

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 33

       NAME : OU=SYD

       CONTEXT : O=EMA.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

RECORD # 34

       NAME : OU=CNI

       CONTEXT : O=CTREC.[ROOT]

       CLASS : ORGANIZATIONAL_UNIT

>>>

>>>  End : 4x NDS Extract

>>>  Time: 11:25am

>>>  Elapsed Time =    0:01:03 (hh:mm:ss) or 63 seconds
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>>>

>>>  TOTAL OBJECTS COPIED TO DATABASE: 34

XCLASS.LOG
>>>

˝

>>> Start: Rename Cross-Class Duplicates
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 12:46pm
˝

>>>
˝

>>>
˝

>>>  DATABASE = EMA_TREE2
˝

>>>
˝

˝

=============================== Renaming Order ================================
˝

     Time: 12:46pm
˝

  Duplicate objects will be renamed in the following order:

1. PRINT_SERVER

2. PRINTER

3. USER

4. GROUP

5. PRINT_QUEUE

=============================END: Renaming Order ==============================

     Time: 12:46pm

================== Rename cross class duplicates using DUPDB ==================

     Time: 12:46pm

PROCESSING DUPLICATE OBJECT: ACCTG

PROCESSING DUPLICATE OBJECT: ADMIN
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PROCESSING DUPLICATE OBJECT: CAROLE

PROCESSING DUPLICATE OBJECT: CINDY

PROCESSING DUPLICATE OBJECT: CNI

PROCESSING DUPLICATE OBJECT: EMAILUSERS

PROCESSING DUPLICATE OBJECT: EVERYONE

PROCESSING DUPLICATE OBJECT: GUEST

PROCESSING DUPLICATE OBJECT: JIM

PROCESSING DUPLICATE OBJECT: MIKE_K

PROCESSING DUPLICATE OBJECT: MRKTG

PROCESSING DUPLICATE OBJECT: RON

PROCESSING DUPLICATE OBJECT: SANDY

PROCESSING DUPLICATE OBJECT: WPUSERS

================END: Rename cross class duplicates using DUPDB ================

     Time: 12:47pm

>>>

>>>  End : Rename Cross-Class Duplicates

>>>  Time: 12:47pm

>>>  Elapsed Time =    0:00:12 (hh:mm:ss) or 12 seconds

>>>

TOLIVE.LOG
>>>

˝

>>> Start: Merge Virtual to Live Summary
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 12:45pm
˝

>>>
˝

>>>
˝

>>>  DATABASE = EMA_TREE2
˝

>>>  SAMECONTEXT = Yes
˝

>>>
˝
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˝

====================== Merge Virtual to Live using DUPDB ======================

     Time: 12:45pm

PROCESSING GROUP ACCTG FROM OU=CORP.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=PROD.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=LON.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=PAR.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=SAO.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=TOK.O=EMA.[ROOT]

PROCESSING GROUP ACCTG FROM OU=SYD.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=PROD.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=LON.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=PAR.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=SAO.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=TOK.O=EMA.[ROOT]

PROCESSING USER ADMIN FROM OU=SYD.O=EMA.[ROOT]

    Setting MESSAGESERVER to CN=ECORP411.OU=Corp.O=EMA

    Setting SECURITYEQUALS to EVERYONE  ID=16777217  3x_Server=TAPE_CD

    Setting SECURITYEQUALS to SUPERVISOR  ID=1  3x_Server=TAPE_CD

    Setting SECURITYEQUALS to CNI  ID=520093766  3x_Server=TAPE_CD

PROCESSING USER CINDY FROM OU=CNI.O=CTREC.[ROOT]

PROCESSING GROUP CNI FROM OU=CORP.O=EMA.[ROOT]

    MERGING CNI INSTANCE FROM TAPE_CD TO INSTANCE FROM OU=CORP.O=EMA.[ROOT]

    Setting GROUPMEMBER to CINDY  ID=503316523  3x_Server=TAPE_CD

    Setting GROUPMEMBER to SANDY  ID=150995037  3x_Server=TAPE_CD

    Setting GROUPMEMBER to MIKE_K  ID=167772222  3x_Server=TAPE_CD

PROCESSING ORGANIZATIONAL_UNIT CNI FROM O=CTREC.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=CORP.O=EMA.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=PROD.O=EMA.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=LON.O=EMA.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=PAR.O=EMA.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=SAO.O=EMA.[ROOT]
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PROCESSING GROUP EMAILUSERS FROM OU=TOK.O=EMA.[ROOT]

PROCESSING GROUP EMAILUSERS FROM OU=SYD.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=CORP.O=EMA.[ROOT]

    MERGING EVERYONE INSTANCE FROM TAPE_CD TO INSTANCE FROM OU=CORP.O=EMA.[ROOT]

    Setting GROUPMEMBER to SUPERVISOR  ID=1  3x_Server=TAPE_CD

    Setting GROUPMEMBER to GUEST  ID=33554433  3x_Server=TAPE_CD

    Setting GROUPMEMBER to CINDY  ID=503316523  3x_Server=TAPE_CD

    Setting GROUPMEMBER to DIMAGE  ID=889192504  3x_Server=TAPE_CD

    Setting GROUPMEMBER to SANDY  ID=150995037  3x_Server=TAPE_CD

    Setting GROUPMEMBER to MIKE_K  ID=167772222  3x_Server=TAPE_CD

    Setting GROUPMEMBER to JOHNC  ID=905969858  3x_Server=TAPE_CD

PROCESSING GROUP EVERYONE FROM OU=PROD.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=LON.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=PAR.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=SAO.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=TOK.O=EMA.[ROOT]

PROCESSING GROUP EVERYONE FROM OU=SYD.O=EMA.[ROOT]

XREFOBJS.LOG
>>>

˝

>>> Start: XREFOBJS.LOG
˝

>>>  Date: Wednesday, 19 Nov 1997

>>>  Time: 1:15pm

>>>

>>>  NOTE: To verify this log search for 'ERROR' and '*** Note'.

>>>

>>>

Default Administrator = .CN=cindy.OU=cni.O=ctrec

Server/Admin Associations

     ~TAPE_CD ECORP411 .CN=Admin.O=EMA~

============================ Xref User Attributes =============================
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    0. User Object: .CN=SANDY.OU=Corp.O=EMA

       Adding Attribute: A_SECURITY_EQUALS

           Setting value to: .CN=Everyone.OU=Corp.O=EMA

                   *** Note: The value already existed.

           Setting value to: .CN=Cni.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_GROUP_MEMBERSHIP

           Setting value to: .CN=Everyone.OU=Corp.O=EMA

                   *** Note: The value already existed.

           Setting value to: .CN=Cni.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_MAILBOX_LOCATION - There are no values to be added

       Adding Attribute: A_MESSAGE_SERVER

           Setting value to: CN=ECORP411.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_PROFILE - There are no values to be added

       Adding Attribute: A_PROFILE_MEMBERSHIP - There are no values to be added

   1. User Object: .CN=JOHNC.OU=Corp.O=EMA

       Adding Attribute: A_SECURITY_EQUALS

           Setting value to: .CN=Everyone.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_GROUP_MEMBERSHIP

           Setting value to: .CN=Everyone.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_MAILBOX_LOCATION - There are no values to be added

       Adding Attribute: A_MESSAGE_SERVER

           Setting value to: CN=ECORP411.OU=Corp.O=EMA

                   *** Note: The value already existed.

       Adding Attribute: A_PROFILE - There are no values to be added

       Adding Attribute: A_PROFILE_MEMBERSHIP - There are no values to be added

========================== END: Xref User Attributes ==========================

========================== Xref Live User Attributes ==========================

======================= END: Xref Live User Attributes ========================
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===================== Xref Groups (Attribute = A_MEMBER) ======================

    1. Group Object = .CN=FAX.OU=Corp.O=EMA

       Adding Attribute: A_MEMBER

           Setting value to: .CN=JOHNC.OU=Corp.O=EMA

                   *** Note: The value already existed.

ERROR: Found a reference to object(USER): CN=MIKE_K.OU=Corp.O=EMA in the 4x DB which was not migrated.

=================== END: Xref Groups (Attribute = A_MEMBER) ===================

=================== Xref Live Groups (Attribute = A_MEMBER) ===================

================ END: Xref Live Groups (Attribute = A_MEMBER) =================

>>>

>>>   End: XREFOBJS.LOG

>>>

>>> Elapsed Time =    0:00:39 (hh:mm:ss) or 39 seconds

XREFPRNT.LOG
>>>

˝

>>> Start: XREFPRNT.LOG
˝

>>>  Date: Wednesday, 19 Nov 1997

>>>  Time: 1:16pm

>>>

>>>  NOTE: To verify this log search for 'ERROR' and '*** Note'.

>>>

>>>

Default Administrator = .CN=cindy.OU=cni.O=ctrec

Server/Admin Associations

     ~TAPE_CD ECORP411 .CN=Admin.O=EMA~

=========================== Xref Printer Attributes ===========================



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-69

Migration from NetWare 3 to intraNetWare

    0. Printer Object: .CN=TAPE_CD_TECHW_000_TECHP.OU=Corp.O=EMA

       Adding Attribute: A_QUEUE

ERROR: Found a reference to object(PRINT_QUEUE): CN=TECHQ.OU=Corp.O=EMA in the 4x DB which was not migrated.

       Adding Attribute: A_NOTIFY

ERROR:   Could not find  from server TAPE_CD in the database

COMMENT: Check if this object still exists in the 3x bindery (PCONSOLE.EXE or SYSCON.EXE)

         Run a 3x and 4x report on the object to see if it exists in the databases

======================== END: Xref Printer Attributes =========================

======================== Xref Live Printer Attributes =========================

====================== END: Xref Live Printer Attributes ======================

======================== Xref Print Server Attributes =========================

====================== END: Xref Print Server Attributes ======================

====================== Xref Live Print Server Attributes ======================

=================== END: Xref Live Print Server Attributes ====================

========================= Xref Print Queue Attributes =========================

====================== END: Xref Print Queue Attributes =======================

====================== Xref Live Print Queue Attributes =======================

==================== END: Xref Live Print Queue Attributes ====================

>>>

>>>   End: XREFPRNT.LOG

>>>

>>> Elapsed Time =    0:00:05 (hh:mm:ss) or 5 seconds



.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .
A-70    Examples of Migration Reports

DUMPBIND.LOG
>>>

˝

>>> Start: DUMPBIND.LOG
˝

>>>
˝

dbFile = ECORP411/SYS:/RMT/DATA\3XDB.001
˝

*******************************************************************************
˝

*
˝

*  START: Gathering information from server TAPE_CD

*

*******************************************************************************

=====================================================

=

=  START : Extracting information about Bindery Object Type GROUP

=

======================================================

        TAPE_CD................................................................

        Found Bindery GROUP Object on TAPE_CD.....

            Object Name      = EVERYONE

            Object ID        = 16777217

            Object Type      = 2

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 1 properties on object EVERYONE

        Adding GROUP record #1 to 3X database.....

        TAPE_CD................................................................

        Found Bindery GROUP Object on TAPE_CD.....

            Object Name      = CNI

            Object ID        = 520093766

            Object Type      = 2

            Object Has Props = 1

            Object Flag      = 0
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            Object Security  = 00110001

        Scanned 1 properties on object CNI

        Adding GROUP record #2 to 3X database.....

        TAPE_CD................................................................

        Found Bindery GROUP Object on TAPE_CD.....

            Object Name      = FAX

            Object ID        = 2298609668

            Object Type      = 2

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 1 properties on object FAX

        Adding GROUP record #3 to 3X database.....

=====================================================

    =

    =  END : Extracting information about Bindery Object Type GROUP

    =        Extracted 3 GROUP objects from TAPE_CD

    =

======================================================

=====================================================
˝

=
˝

=  START : Extracting information about Bindery Object Type PRINT_QUEUE
˝

=
˝

=====================================================

        TAPE_CD................................................................

        Found Bindery PRINT_QUEUE Object on TAPE_CD.....

            Object Name      = TECHQ

            Object ID        = 872415418

            Object Type      = 3

            Object Has Props = 1
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            Object Flag      = 0

            Object Security  = 00110001

        Scanned 5 properties on object TECHQ

            Q_DIRECTORY = SYS:/SYSTEM/340000BA.QDRrops = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 6 properties on object TECHW

            LOGIN_CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF610A1F0A040500007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

            Found property SAP_NAME . Did not store.....

            ACCOUNT_BALANCE =
0000000080000000CADE9B100000220048DF8ADECCDE3EDF441FCADEAB2221122112DA03A7310D0002329B10B60103870104
A731A841BADE48DF3EDF0D003EDF441FBADEA841A7313EDF441FCCDEA841A7313EDF0D00F8C70B003EDF441FE0DEA731A731
3EDF0D00F8C70B0046329B106401FF90FFFF3EDF48DF20DFFFFF0BDF

            Length of ACCOUNT_BALANCE = 128

            IDENTIFICATION = _CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF610B0B0D2A2800007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

        TAPE_CD................................................................

        Found Bindery USER Object on TAPE_CD.....

            Object Name      = SANDY

            Object ID        = 150995037

            Object Type      = 1

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 4 properties on object SANDY

            LOGIN_CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF6007180D260100007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

        Adding USER record #1 to 3X database.....

        TAPE_CD................................................................
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        Found Bindery USER Object on TAPE_CD.....

            Object Name      = MIKE_K

            Object ID        = 167772222

            Object Type      = 1

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 4 properties on object MIKE_K

            LOGIN_CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF610B03122D1200007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

        Adding USER record #2 to 3X database.....

        TAPE_CD................................................................

        Found Bindery USER Object on TAPE_CD.....

            Object Name      = CINDY

            Object ID        = 503316523

            Object Type      = 1

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 4 properties on object CINDY

            LOGIN_CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF610B130B231800007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

            MISC_LOGIN_INFO =
61031A12260903FF760D22140C00760D22140A00F253000EF143F1430200B614930374D058FA5A0E59230000760D22140500F
2530000F143F143B21448A4930374D062FA8C03591800004EFAF143050030000000F143F143F143BB80F14300000000252D000
0000084F5F1431E00002B035F04001100E9128CFBA5014F0A520B

            Length of MISC_LOGIN_INFO = 128

        Adding USER record #3 to 3X database.....

        TAPE_CD................................................................

        Found Bindery USER Object on TAPE_CD.....

            Object Name      = JOHNC
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            Object ID        = 905969858

            Object Type      = 1

            Object Has Props = 1

            Object Flag      = 0

            Object Security  = 00110001

        Scanned 4 properties on object JOHNC

            LOGIN_CONTROL =
00000000000000FF0000FF000000FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF
FFF610B1307280E00007FFFFFFF000000000000000000000000000000000000000000000000000000000000000000000000000
000000000000000000000000000000000000000000000

            Length of LOGIN_CONTROL = 128

         Adding USER record #4 to 3X database.....

======================================================

=

=  END : Extracting information about Bindery Object Type USER

=        Extracted 4 USER objects from TAPE_CD

=

======================================================

        Adding FILE_SERVER record for TAPE_CD to 3X database.....

        Adding VOLUME record 1 for TAPE_CD to 3X database.....

        Adding VOLUME record 2 for TAPE_CD to 3X database.....

*******************************************************************************

*

*  END: Gathering information from server TAPE_CD

*       Extracted 4 objects

*

*******************************************************************************

Total number of objects extracted : 4

>>>

>>>   End: DUMPBIND.LOG

>>>

>>> Elapsed Time = 00:00:14
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DUPOBJ.LOG
>>>

˝

>>> Start: Duplicate Object Summary(Scanned using DUPDB)
˝

>>>  Date: Wednesday, 19 Nov 1997
˝

>>>  Time: 11:44am
˝

>>>
˝

>>>
˝

>>>  ____________________________________________ Example - Start
____________________________________________

>>>

>>>   NOTE: The sample below illustrates how to fill the checkboxes to designate various methods of handling

>>>         duplicate objects. RMT can read a marked-up file back in and perform the actions. This method is

>>>         meant to be used if a manageable number of duplicate objects is found. For large migrations we

>>>         recomend using the batch handling routines first and rerunning the scan.

>>>

>>>                                                                 LEAVE BOXES UNCHECKED TO SKIP THE OBJECT

>>>

>>>                                                                 New Name (max 64 chars) --------------+

>>>                                                              or New Context (max 256 chars) ----------+

>>>                                                              or Number of the Instance to Merge to ---+

>>>                                                                                                       |

>>>                                                                 Move to Another Context ----------+   |

>>>                                                                 Rename -----------------------+   |   |

>>>                                                                 Merge to another Instance-+   |   |   |

>>>   Object                                                        Move to Trash_Can-----+   |   |   |   |

>>>   Instance/Class  Status  Source_Server   Object_Context                              v   v   v   v   v

>>>
________________________________________________________________________________________________
_________

>>>

>>>   SampleDupl

>>>      1 USER          L                    OU=Some Department.O=Some Co

>>>      2 USER          V    TEST            OU=Some Department.O=Some Co               [ ] [x] [ ] [ ] [1

>>>      3 USER          V    TEST_OLD        OU=Some Department.O=Some Co               [x] [ ] [ ] [ ] [

>>>      4 GROUP         V    TEST            OU=Some Department.O=Some Co               [ ] [ ] [x] [ ] [DUP_GRP_SampleDupl
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>>>      5 PRINT_QUEUE   V    TEST            OU=Some Department.O=Some Co               [ ] [ ] [x] [ ] [DUP_P_Q_SampleDupl

>>>      6 PRINT_SERVER  V    TEST            OU=Some Department.O=Some Co               [ ] [ ] [x] [ ] [DUP_P_S_SampleDupl

>>>      7 USER          L                    OU=Another Department.O=Some Co

>>>      8 USER          V    SERVER_TWO      OU=Another Department.O=Some Co            [ ] [ ] [ ] [x] [OU=Yet Another
Department.O=Some Co

>>>      9 USER          V    SERVER_THREE    OU=Another Branch.O=Some Co                [ ] [ ] [ ] [ ] [

>>>

>>>  _____________________________________________ Example - End
_____________________________________________

>>>

>>>

>>>

>>>  DATABASE = EMA_TREE2, CLASS = *, MASK = *

>>>  NOTE:      Under Status,  L = Live Object, V = Virtual Object

>>>

>>>                                                                 LEAVE BOXES UNCHECKED TO SKIP THE OBJECT

>>>

>>>                                                                 New Name (max 64 chars) --------------+

>>>                                                              or New Context (max 256 chars) ----------+

>>>                                                              or Number of the Instance to Merge to ---+

>>>                                                                                                       |

>>>                                                                 Move to Another Context ----------+   |

>>>                                                                 Rename -----------------------+   |   |

>>>                                                                 Merge to another Instance-+   |   |   |

>>>   Object                                                        Move to Trash_Can-----+   |   |   |   |

>>>   Instance/Class  Status  Source_Server   Object_Context                              v   v   v   v   v

>>>

   1. Acctg

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         L                    OU=Prod.O=EMA

   2. Admin

         1 USER          L                    O=EMA

         2 USER          L                    OU=Prod.O=EMA

   3. Carole

         1 USER          L                    OU=Corp.O=EMA

         2 USER          L                    OU=CNI.O=CTREC

   4. Cindy

         1 USER          L                    OU=Corp.O=EMA
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         2 USER          L                    OU=CNI.O=CTREC

         3 USER          V    TAPE_CD         OU=Corp.O=EMA                              [ ] [ ] [ ] [ ] [

   5. CNI

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         V    TAPE_CD         OU=Corp.O=EMA                              [ ] [ ] [ ] [ ] [

   6. EMAILUSERS

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         L                    OU=Prod.O=EMA

   7. Everyone

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         L                    OU=Prod.O=EMA

   8. Guest

         1 USER          L                    OU=Corp.O=EMA

         2 USER          L                    OU=Prod.O=EMA

   9. Jim

         1 USER          L                    OU=Corp.O=EMA

         2 USER          L                    OU=CNI.O=CTREC

  10. MIKE_K

         1 USER          L                    OU=CNI.O=CTREC

         2 USER          V    TAPE_CD         OU=Corp.O=EMA                              [ ] [ ] [ ] [ ] [

  11. Mrktg

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         L                    OU=Prod.O=EMA

  12. Ron

         1 USER          L                    OU=Corp.O=EMA

         2 USER          L                    OU=CNI.O=CTREC

  13. SANDY

         1 USER          L                    OU=CNI.O=CTREC

         2 USER          V    TAPE_CD         OU=Corp.O=EMA                              [ ] [ ] [ ] [ ] [

  14. WPUSERS

         1 GROUP         L                    OU=Corp.O=EMA

         2 GROUP         L                    OU=Prod.O=EMA

>>>

>>>  End : Duplicate Object Summary

>>>  Time: 11:46am

>>>  Elapsed Time =    0:01:24 (hh:mm:ss) or 84 seconds

>>>
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Glossary  

Account See Identity (ID)

Authentication A means of verifying that an object sending
messages or requests to NDS is authorized to do
so.

Bindery A network database, in NetWare versions earlier
than NetWare 4, that contains definitions for
entities such as users, groups, and workgroups. In
NetWare 4, the bindery has been replaced by the
NetWare Directory database, under NDS.

BINDFIX  utility A utility you can use to repair damaged bindery
files. It is intended to correct certain system
security problems. You must be a supervisor or
have equivalent rights to run this utility.

Cross Class Duplicate Two objects of the same name and same context
but different object type, which was allowed in
NetWare 3.x, but is not valid in NDS (and
therefore not in NetWare 4.x). One example would
be a user, a group and a printer with the name of
FAXSERVE in the same context.

Destination server The intraNetWare server to which you migrate
data files, bindery files, and other information
from a previous NetWare version or another
network operating system when upgrading to
intraNetWare.

DynaText Online viewer that allows you to read
intraNetWare online documentation from your
Windows workstation.

DYNATEXT.INI A configuration file that references private
collections and points to the SYSDOCS.CFG file.

Identity (ID) The user name of any person that has access to use
resources on the server.
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License chain Formed as a result of Additive Licensing, which
permits multiple individual licenses to be added
together.

MIGPRINT.EXE A utility used to properly migrate printing
from NetWare 2.x or NetWare 3.x servers to
intraNetWare.

MIGRATE.EXE A utility used to migrate selected information from
NetWare 2.x or NetWare 3.x servers to
intraNetWare.

MIGxxx.RPT An ASCII text file containing a migration report
log file, which is created by the MIGRATE.EXE
utility.

MONITOR An NLM that allows you to lock the file server
console and to see how efficiently your network
is operating.

MPxxx.RPT An ASCII text file containing a print migration
report log file, which is created by the
MIGPRINT.EXE utility.

NDS See Novell Directory Services.

NETADMIN  utility A text based system configuration utility used in
intraNetWare that provides many system
administrations functions, including setting up
accounts for new users, modifying settings of
existing users, creating and managing groups of
users and their access rights, and managing the
system accounting.

Novell Directory
Services

A database that maintains information about
resources on the network.

NetWare Loadable
Module (NLM)

A program you can load and unload from file
server memory while the server is running. NLMs
link disk drives, LAN drivers, name spaces, and
other file server management and enhancement
utilities to the operating system.
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NetWire Public bulletin board system (BBS) from Novell,
which provides access to Novell product
information, Novell service information, and time-
sensitive technical information for NetWare users.
NetWire is accessed through the CompuServe
Information Service.

NEW.PWD An ASCII file that shows passwords sorted by
date. If users are migrated from more than one
server, the current password is the last one listed
on the report.

NLM See NetWare Loadable Module.

ODI See Open Data-Link Interface.

Open Data-Link
Interface (ODI)

An architecture that allows multiple LAN drivers
and protocols to coexist on network systems. ODI
supports media- and protocol-independent
communications by providing a standard interface
that allows transport protocols to share a single
network without conflict.

RMT Server The physical server that is running the
REXXWARE Migration Toolkit.

SAP See Service Advertising Protocol.

Service Advertising
Protocol (SAP)

A protocol that provides a way for servers to
advertise their services on a intraNetWare
internetwork.

Source server The server from which you migrate data files,
bindery files, and other information to an
intraNetWare
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STREAMS An NLM that provides a common interface
between NetWare and transport protocols that
need to deliver data and requests to NetWare for
processing. By making the transport protocol
transparent to the network operating system,
STREAMS allows services to be provided across
the network, regardless of the transport protocols
used.

SYSCON utility A system configuration utility used in
NetWare 3.12 that provides many system
administration functions, including setting up
accounts for new users, modifying settings of
existing users, creating and managing groups of
users and their access rights, and managing the
system accounting.

SYSDOCS.CFG A configuration file that references the location of
public collections.

Trustee A user or group that has been assigned rights to
work with a directory, file, or object.

View An DS Migrate file containing NDS information
about a particular tree.

Volume A physical amount of hard disk storage space,
fixed in size. A NetWare volume is the highest
level in the NetWare file system (on the same level
as a DOS root directory). In NDS, each volume is
also a Volume object in the Directory.

Volume Object A leaf object that represents a physical volume on
the network.
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